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INTRODUCTION
About the IPitomy IP PBX

The IPitomy IP PBX is a powerful business communications platform. It is a pure IP PBX designed to use IP
networks for voice calls. Engineered to support from 10 to 500 users, the system will work with analog lines and
T1 /PRI lines for traditional Public Switched Telephone Network (PSTN) connectivity. In addition to traditional
telephone lines, the IPitomy IP PBX can use VoIP SIP Trunks, replacing traditional PSTN lines with a broadband
telephone service.

Benefits of VolP Technology

The IPitomy IP PBX can support any or all of these connectivity methods simultaneously or in any combination.
Customers not quite ready to depend on VolP providers for all of their business communications can start at their
own pace and gain a comfort level, shifting to VolP broadband providers at their own pace.

Benefits of VolP technology include:

e One Wiring System — The system uses a single wiring system for telephones and data—all data and
voice are on Local Area Network (LAN) Category 5 wiring.

e Web-based Administration — System administration is performed on the network through a Web-
based administration program. The Web-Based Administration can be used locally or remotely from
anywhere.

o Remote Users — When calls are routed over the Internet, long distance charges can be avoided. In
businesses with remote workers, these employees can stay logged into the office through a
broadband connection at all times without incurring any additional charges. Remote users have all of
the features of the local users. Remote users can be included in any ring groups, ACD (Automatic
Call Distribution) Queues and other call routing schemes.

e Centralized System Features — Every extension that is logged into the system is capable of
receiving and originating calls. The use of system features such as voicemail, automated attendant
and email are all centralized simplifying all support and maintenance.

e Reduced Costs — VoIP system users can reduce cost in many areas of a business. VolP telephony
lowers the cost of support and maintenance costs, as well as, reducing telephony line costs by up to
50%.

o Simplifies Administration — Moves, additions and changes are simple. The IPitomy IP PBX
provides enhanced capabilities for users to make changes without incurring a service call.

¢ Investment Protection — VVolIP, and in particular, Session Initiation Protocol (SIP)-based VolP
products offer investment protection. The industry is rapidly moving toward Internet Protocol (IP)
communications technologies. Older digital and analog technologies are becoming obsolete and are
being replaced with IP-based products that will be around for a long time.

IPitomy IP PBX Features

Understanding the IPitomy IP PBX’s architecture and how it works will make installing the system simple.

The IPitomy IP PBX is an all-in-one business communications system. This powerful system includes a complete
suite of business communication applications in one appliance:

e Fully-featured Business Phone System

e Automated Attendant and Interactive Voice Response (IVR)

e Enhanced Call Distribution
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e Enhanced Voice Messaging System with Unified Messaging
o Meet-me Conference Application

e  Built-in Music on Hold

e Call Queuing for Inbound Calls

e Find Me/Follow Me

¢ Remote Extensions

e Browser-based Administration

e Branch Offices

e Automatic Call Distribution (ACD)

Figure 1 — IPitomy IP PBX System

The IPitomy IP PBX’s administration menus are a series of Web pages accessible from a Web browser. To the
left of the Menu is a navigation bar that allows users to click on and administer each section of the system.
Administration of the IPitomy IP PBX is simple and intuitive. The system is designed with six primary areas of
functionality:

e System — System setup consists of network configuration settings.

e Providers — Providers are sources of PSTN and VolIP connectivity. Providers are the lines that
handle all incoming and outgoing calls. All VolP and traditional telephone providers are setup
here. DID numbers are also entered here.

o Destinations — Destinations are places where calls are routed in the system: extensions, groups
of extensions, automated attendants, conferences, and voicemail.

e Call Routing — These settings route inbound calls to specific destinations within the system, and
send outbound calls over specific local, long distance, international, and emergency routes.

o PBX Setup — These settings globally configure PBX timers, voice messaging, and other system

features.
o Reporting — These reports display system usage, monitor activity, and provide diagnostic
information.
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Feature

Extensions

Groups

Menus
(Automated
Attendant)

DTMF Menu
Administration

Advanced
Routing
Functions

Voicemail and

Description

Extensions are telephones. A telephone can be an IP (SIP) telephone or a Softphone.
Calls are routed to an extension where people answer them. In the IPitomy IP PBX, an
extension can be located in an office or outside the office where a broadband connection
is used.

Groups are a set of extensions. Once a group is created, extensions can be designated
as members of the group. This is accomplished by selecting group members from a drop-
down list. Calls can be routed to groups via inbound routing.

To create an automated attendant use the system’s Menus feature. The Menus feature
allows you to route calls to a destination in the system like a group, extension or another
menu.

Call Destinations are selected from a drop-down list for each corresponding key-pad digit
a caller must select to get to their chosen destination. A Menu must have a Menu Prompt.
This is a recording that identifies for callers the destinations they may choose. For
example, a Menu Prompt might offer callers the option to press “1” for Sales, “2” for
Accounts Receivable or other digits for another department.

New in version: 3.4.1 is DTMF Menu Administration. This feature allows the user to
administer the Menu (Auto Attendant) remotely using just a telephone (with DTMF dial
capability).

When building an automated attendant (Menus) all routable destinations in the system will
appear in the drop-down list. In addition to the destinations that are created while
configuring the system, there are several advanced functions that can be used from the
drop-down list.

When an extension is created, a voicemail box for that extension is also created. A
voicemail box allows a caller to leave a message if a person is not available at the
extension. When dialing into a mailbox for the first time, a user should record their name
and a mailbox greeting. The name is used in the company’s dial-by-name directory when
selected from the auto attendant (Menus). The greeting is played when they are not

Unified available to take a call and a caller reaches their mailbox.
Messaging
If an email address is included in the Extension page, you can configure Unified
Messaging and a copy of the voicemail message will be emailed as a .Wav file to the
users email account. This message can then be listened to on a PC.
The system has a dial-by-name directory. This option may be part of the automated-
attendant. When this option is selected, a caller dials the first three letters of the last / first
name of the party they would like to reach. Names that match these three letters are
Directory played and the caller selects the extension to which they want to be transferred. Names
are stated in the directory as they have been recorded by users in their voicemail box, and
spelt out if they have not recorded their name.
Direct Inward A Direct Inward Dialed (DID) number is a telephone number assigned by a service
Dialing (DID) provider (i.e., T1 line, PRI or VoIP). DIDs allow direct routing of a call to a destination
Numbers within the system. You can route to any destination available on the PBX.
A Meet-me Conference is an extension on the system used for conference calls.
Conferencing Participants can access a conference by dialing the designated Meet-me Conference
(Meet Me) extension. Routing callers to a Meet-me Conference can be accomplished by using a DID,
a menu, or simply transferring callers to the conference extension.
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FollowMe

Forwarding
Gateway

Cascading
Message
Notification

Voicemail
Gateway

Branch Offices

This feature allows the PBX to try and find users who are not at their desk. It can be
configured to call their cell phones, house phones, or other extensions in the PBX. Once
answered, the user can accept the call, or refuse it. Unhandled calls return to the PBX to
leave a message at the original extension’s voicemail.

Mobility has become a part of everyday life for most people. System users need to be able

to take calls anywhere. The IPitomy IP PBX has the ability to forward calls. Users can turn
call forwarding “on” and “off” while in the office or away from the office by using a touch-
tone key pad. This is set up in the edit Extensions page, but can be modified from any
phone, including a cell phone. Modifying forward settings remotely requires the automated
attendant (Menus) option to be programmed.

This feature works using the same methods as FollowMe, but pertains to voicemail
messages. When configured, if an extension gets a new voicemail, you will be able to
send the voicemail message to a variety of numbers (Destinations), define the order in
which to send the message and can be set to make the system to notify you that a new
message was received. Additionally, you can add or remove extensions to the list of
recipients when a broadcast message is sent.

Using either a Menu or a DID, users can call in from any telephone and check messages.
The voicemail gateway allows users to dial a pre-defined digit from a touch- tone key pad
on any phone to retrieve their messages.

Branch offices can be created to allow multiple PBXs to route calls to each other. Branch
office extensions can be transferred to, placed in ring groups, or selected as menu
destinations.

Table 1 — IP PBX Features
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GETTING STARTED

Boot Up — Safe Power Down

Each IPitomy IP PBX is equipped with a Boot Up/Safe Power Down momentary switch at the front of the chassis.
This switch is a primary element of controlling not only the hardware but the Operating System (OS) and PBX
software. If it becomes necessary to use this switch — especially when powering down — it is imperative that you
read and understand the functionality of this switch.

IMPORTANT:

Use of this switch is very convenient and VERY specific.

Improper use can cause very undesirable results.

Use this switch by pressing the elevated side and releasing immediately.

1100 1200 2000/5000

[

@ IP1E00 |

Behind Drive Access Door

The switch has three functions:

(Use 1 & 2 only — unless directed to use the 3" function by a technical support
representative). Repeatedly turning off the power with a hard boot can damage
(corrupt) the data on the hard drive. In some instances, this can void the warranty.

Use Condition Operation

While the PBX is not operating... .
1 (power cord connected but not yet Press and release the switch to start PBX
powered up OR previously, properly operation

powered down)

. . . Press AND Release the switch to initiate the safe
Wil e PEI S epeEling.... power-down sequence. The PBX will shut-down
2. Shut down can take as long as 5 all applications running in the proper sequence —
minutes. Please be patient. ensuring that no damage occurs to the database
and applications during shut-down.

While the PBX is NON-Responsive Press AND Hold the switch to FORCE immediate
and all other methods to regain shut-down.

control of the OS and applications

h ) This is NOT recommended and should
ave failed.

be avoided.
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Connecting the System

Hardware Setup

The IPitomy IP PBX comes assembled and ready to install. The system requires some form of trunking, be it a
connection to the PSTN for analog or T1 lines or a SIP trunk. It requires telephones to be connected to the local
area network (LAN). Broadband access must be established for VolP connectivity (allowing remote extensions ,
branch offices, remote management, and SIP trunks).

Modem
Internet ‘—;

- (LAN) VolIP Phones

Router / Firewall
J Iz Faz
@) b &,
) C ]

E[' = ‘l""l' =5 ']) Ethernet Switch

=
2| cpre T
(=)

IPitomy PBX 1500

XN

Figure 2 — Hardware Setup Diagram

Connecting the Phone Lines

The IPitomy IP PBX is equipped to support analog, digital, gateway or SIP connections. Analog lines or a T1/PRI
are connected with internal hardware resources. A gateway connects analog telephone lines by registering itself
as a SIP provider over the LAN. SIP providers create a direct connection to the system.

INTERNAL ANALOG LINE CARDS
The IPitomy IP PBX uses three basic analog devices for PSTN connectivity.

Digium TDMO04B Analog Line Card (4 PSTN line connections) - This analog line card
supporting these connections is already installed and completely configured. Simply connect the phone
lines to the RJ11 jacks at the rear of the IPitomy IP PBX and start making calls.

Digium TDM808B Analog Line Card (8 PSTN line connections) — This analog line card
supporting these connections is already installed and completely configured. Simply connect the phone
lines to the RJ11 jacks at the rear of the IPitomy IP PBX and start making calls.

IMPORTANT: The 4 and 8 PSTN line connections are a single

pair, one line per jack. It may be necessary to echo tune the system.
Please contact an IPitomy Technical Support personnel if you
notice an echo on the line.

2011 Copyright © IPitomy Communication, LLC 6 v4.0.1
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Digium 2404B 16 and 2406B 24 Analog Line Cards (16 or 24 PSTN line connections) -
These lines are plugged into an Amphenol connector and need to be terminated in a cross connect,
break-out box or patch panel. The Amphenol connector uses a single pair connection to each phone line.

4

(Diagram 4)

INTERNAL DIGITAL T1 CARDS

The IPitomy IP PBX uses two devises for digital connectivity.

Digium TE122P T1 Card (a single T1/E1/J1 connection) — This card supports industry standard
telephony and data protocols, including both RBS and Primary Rate ISDN (PRI) protocol families for
voice traffic. The card has a default configuration for the system, but this configuration may be adjusted
based on preference. Plug the RJ45 connector into the T1 TDM source supplied by the T1 provider.

Digium TE205P T1 Card (a dual T1/E1/J1 connection) — This card supports industry standard
telephony and data protocols, including both RBS and Primary Rate ISDN (PRI) protocol families for
voice traffic. The card has a default configuration for the system, but this configuration may be adjusted
based on preference. Plug up to two RJ45 connectors into the T1 TDM sources supplied by the T1
provider.

(Diagram 5)

Connecting Using an External Gateway

Gateways connect legacy phone equipment (PBXs, ACDs, voicemail systems, etc.) to modern VolP systems and
services. |IPitomy supports many different communications protocols from both the modern world of VolP and
from the legacy PSTN. This makes it a powerful tool for building gateways and protocol converters.

PSTN lines can be connected to a Gateway device. The gateway device is connected to the LAN. The Gateway is
then registered as a SIP provider in the system.

2011 Copyright © IPitomy Communication, LLC 7 v4.0.1
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Figure 3 — External Gateway Connection Diagram

Connecting to a LAN

In order to be able to connect all of the devices (PCs, Phones, Gateways, etc) to their Local Area Network (LAN)
you will most likely need to install at least one Switch.

Connecting Using SIP Providers

Once connected to the LAN, the LAN's broadband connection provides a pathway for SIP VolP Providers. Use

the SIP Provider pages to setup a connection.
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Figure 4 — SIP Provider Connection Diagram
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Figure 5 — LAN Connection Diagram

Connecting Telephones
The following diagrams indicate the port locations on the IP120 and IP1500.

port

Figure 6 — IP120 and IP1500 Connector Ports
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DATA AND NETWORK CONFIGURATION

Planning before getting started will make the setup and installation of the IPitomy IP PBX simple. IPitomy has created
the IPitomy Setup Worksheet to assist in recording business and system information used in planning system setup
and installation. This Checklist can be downloaded from IPitomy.com in the Dealer Section of the Website.

‘:: IMPORTANT: Please contact your IPitomy Sales Representative
to obtain a login information for the Dealer site at (941) 306-2200.

Setup Worksheet

The Setup Worksheet is broken out into sections where required data can be entered. Once all the information in

the setup worksheet is populated, it can then be imported to the IPitomy system. This will save a great amount a
setup/configuration time.

IMPORTANT: To take full advantage of the functionality in the

setup worksheet, you will need to make sure that your Excel macro
security is set to Medium or lower (you will need to restart Excel
after changing these settings). |

By planning the application, gathering, and organizing the data in advance, installation is simple and can be completed rapidly. You may want to provide a copy of this document
to your customer for them to fill in certain items like names and email addresses. To fully take advantage of the functionality of this waorksheet, you will need to make sure that
your Excel macro security is set to Medium or lower (you will need to restart Excel after changing these settings). If set to Medium you will need to click 'Enable Macros' when

prompted upon opening the document, if set to Low macros will be autoratically enabled.

| Information required for the successful installation of an IPitomy [P PEX system: ]

[ Metwork Information Prorpts

You will need to know some basic information on the target network. The type of data Prompts for menus can be recorded using the sound recorder on your PC or through the
facilities you will be using for access to the Internet will dictate how much bandwidth is prompt recording feature in IPitomy. If you use a sound recorder, you will need to
available for phone calls if you are going to use [Pitomy EXchange or any other YolP upload the file to IPitormy. If you use the prompt recording feature in IPitomy, prompts

service provider. You will need to have a fixed IP address if calls are to be sent to remote |are recorded using your telephone extension. “oice mail greeting are recorded using
extensions via the Internet. The P address of the PEX on the local subnet will need to be |the mail box menu.

static.

User Data Telephone Lines
The reguired information for users will be extension number, name and email address. If you know the telephone numbers for your telephone lines, it is good to have then all
The email address is used to send voice mails to email. When an extension is created, a|listed ahead of time. You may want to route calls based on a particular number or
voice mail box is automatically created for that user. Woice mail only boxes may be specific DID.

created as well. You can print out a copy of this sheet and ask your customer to fill it in
or provide them the spreadsheet to fill out.

Groups Music On Hald
Once you have all the users entered, the users can be put into logical groups for call YWhen a caller is place on hold, park, oris in Queue for a group of extensions, music

routing. An example would be to put all of the sales people in the sales group. Calls from|may be played for them while they wait. The music on hold files can be uploaded to the
the automated attendant or from DID's can be routed directly to that group. Calls can be  |system from your browser. The music on hold files need to be in MP3 format for IP1200
distributed to the members in the group in several ways by using the ring strategies in the |and IP1500, and 8bit 8khz mona wav file for the IP1000.

group. Ring strategies are: ring all, round robin, fewest calls, least recent, fewest recent
calls, round robin with memory or randorm.

Menus Licensing
Menus are for creating automated attendanst and other audio menus. Once you have IPitarny comes with a license for 16 usersfextensions. To activate the initial license,
created groups and extension, calls can be routed to them from the automated attendant. |you must have a connection to the internet and a license key will be uploaded to the
Prompts can be recorded to provide instructions. systemn. This is a security feature that protects the user for warranty coverage as well
35 against unauthorized use.
Unified Messaging | Branch Office
Unified Messaging allows the PBX to send. your voicemail messages directly to your emaill  Branch Offices allow multiple sites with PBXs to interact as one large office. Unigue
inbox. extension numbers can be configured as branch extensions and dialed directly, while
non-unigue extension numbers can be dialed with the dial prefix + ext number; the
same is true for Ring Groups and Menus. You can also configure at each PEX whether
they will allow the other to use their trunks for calling.
Figure 7 — Sample Setup Worksheet
2011 Copyright © IPitomy Communication, LLC 10 v4.0.1
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Data Type Description/Recommended Settings

Network You will need to know some basic information on the target network. Use this page to store all

Information pertinent information regarding the sites LAN and WAN connection.

e The type of data facilities you will be using for access to the Internet will dictate how much
bandwidth is available for phone calls.

e If you are going to use remote phones, SIP providers, or Branch Offices, you will need to
have a fixed IP address.

User Data Use this page to gather and store information for the extensions and stand alone mailboxes on
the PBX. This page allows you to export the extension information to another worksheet. Save
this worksheet as a .csv file and you can import it directly into the PBX, saving you time.

e Extension Numbers - required
e Name - required
o Email Address - required if the end user desires to use Unified Messaging
o Device - setting this in the worksheet will make your installation much easier when using
autoprovisioning and IP550/IP120 phones
e MAC Address — for the most part this field can be left blank. If using Aastra phones, it
may be more useful.
Voice mail only boxes may be created as well. You can print out a copy of this sheet and ask
your customer to fill it in or provide them the spreadsheet to fill out.

Groups Use this page to gather and store information about ring groups. This will allow you to build the
groups in the PBX much quicker at the time of install because everything has already been
decided upon in advance.

Menus Building menus in the PBX will be much easier once you have completed the sections pertaining
to Menus. In addition to the setting in the PBX, you will be able to have the end user write out the
prompt scripts, ensuring that the key press destinations match the dialogue the callers will hear.

Unified Unified Messaging allows the PBX to send your voicemail messages directly to your email inbox.

Messaging Use this section to log the end users email server information.

Telephone If you know the telephone numbers for your telephone lines, it is good to have them all

Lines documented ahead of time. You may want to route calls based on a particular number or specific
DID.

Music On When a caller is place on hold, park, or is in Queue for a group of extensions, music may be

Hold played for them while they wait. The music on hold files can be uploaded to the system from your
browser. The music on hold files need to be in MP3 format for IP1100+ systems, and 8bit 8Khz
mono .wav file for the IP1000.

Licensing Most IPitomy systems come default with a license for 16 users/extensions. To activate the initial

Branch Office

=

license, you must have a connection to the internet and a license key will be uploaded to the
system. This is a security feature that protects the user for warranty coverage as well as against
unauthorized use. Filling out the User Data page will automatically tell you how many extensions
the system needs, at a minimum, to handle the desired users.

This page will allow you to more accurately plan out an install that will have multiple sites
connected via Branch Office. Using unique numbering for each PBX will allow for easier calling
between sites.

The lightning bolt, found on the User Data section of the Setup Worksheet, accesses a macro
that allows you to export the User Data information pertaining to extension to another worksheet.
Once exported, you can save that worksheet as a .csv file, and then load it directly into the PBX.

Table 2 — Setup Worksheet Descriptions
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Table 3 — Sample Exported .CSV Worksheet

CSV Upload

Once all the extension information has been exported to a .CSV file, you can import that file into the PBX.

P STEPS:
1 Navigate in the PBX to Destinations ¥ Extensions. The Extensions page appears.

2 Select the BROWSE button at the top of the page. The File Upload window appears. Locate
and select the file that you want to import then click the OPEN button.
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Figure 8 — View of Upload Location Window

3 The CSV File field is updated with the source directory information for the file to be imported.

4 Click the IMPORT button. The Create Extensions page appears displaying the information
that is going to be imported.

5 Review the information then select the CREATE button when you are done.
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Create Extensions
b System Extension Result
» Providers 114 SUCCESS

» Destinations

Extensions Return to Extensions
Groups

Menus
Conferences
Yoicemail
Schedules
Branch Offices

¢ Call Routing
» PEX Setup
» Reporting

Figure 9 — Create Extension Results Page

6 The Create Extensions page will display the results of your import for each extension. You
should see a “SUCCESS” message.

7 Click on the Return to Extensions link that appears on the page. This brings you back to
the Create Extensions page. Review the Extensions List and find the extension (s) you just
created.

8 Click on the Apply Changes link at the top of the page to make these changes live on the
PBX. A message “Settings Applied” will appear.

9 You are now ready to update the various settings for the new extension. (See the
Destination Extensions section of this user guide for more details on Extensions).

Network Requirements

Making preparations for the network in advance will assure there are no surprises. If you are going to have remote
extensions, you will need access to the router to setup a network address translation (NAT) and port forwarding.

A LAN with a broadband connection is required for operation of the system. It must be on a fast Ethernet (100baseT
or better). The system must also use Ethernet data switches. The router can use DHCP or not, depending on
preference. The IPitomy IP PBX requires a fixed IP on the router subnet. Several ports may need to be forwarded.
Make sure your router has TCP/IP port range forwarding by checking the box or product guide. The router should
have a fixed |IP address with a public IP.

Pre-existing TFTP servers or DHCP servers broadcasting TFTP servers may cause conflicts for phone configuration.
If you have a pre-existing TFTP server being broadcast by your DHCP server, please contact IPitomy support to
determine the best solution.

2011 Copyright © IPitomy Communication, LLC 13 v4.0.1
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Port Forwarding

The following table outlines the port forwarding information in the router that maps public IP addresses to internal IP
addresses. Port forwarding must be configured to utilize features such as remote phones, SIP Providers, remote
administration and branch office. IPitomy port forwarding requirements are specified below.

Single Port Forwarding

Application Name Port Protocol To IP Address
Femoate Management a0 TCH FBX Internal IF
==H Suppor 22 TCF FEX Internal IP

SIP 5060 LIDF FEX Internal IP

Branch Office 4564 LIDP FBX Internal IP

Port Range Forwarding
Application Name Port Range Protocol To IP Address
RTE 10000-20000 LIDF FEX Internal IP

Figure 10 — Port Forwarding Configuration Table

IMPORTANT: Please contact an IPitomy Technical Support
Representative for assistance or additional information
regarding how to configure port forwarding for the IP PBX

system.
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IP Addresses

To determine the IP address that can be used on the network, check the router or get this information from the
Network Administrator. In many cases, this default IP address will be acceptable without any router configuration

other than port forwarding (requi

red for remote administration and remote telephones).

IMPORTANT: The IP PBX is required to have a fixed (static) IP
address. The system comes with a default static IP address of
192.168.1.249/ippbx.

We recommend that you use this default IP address. Please contact
IPitomy’s Technical Support Group if you need further assistance
by email at support@ipitomyv.com or phone 941-306-2200 option2,
or visit our FAQ page at our website at www.ipifomy.com.

Changing the IP Address

If the default IP address does not match the network schema for your install, the PBX has a simple method for
changing this information. The Network Console allows you to view and change settings without requiring an
external web browser or any network connection.

P sTEPS:

1 Plug a keyboard and monitor into the IP PBX.
2 From this keyboard, press CTRL-ALT-F7

3 Follow the instructions displayed on the page to configure the IPs for the PBX. The options

used are as

4 Once all val

follows.

1: Network Type — Static or DHCP
2: |IP address

3: Subnet Mask

4: Default Gateway
5: Static DNS

6: Static DNS 2

7: Static DNS 3

R: Refresh View

D: Default Settings
S: Save & Update

ues have been configured to match the install network, choose S to save

and update.

Note: For further details on using the Net Console, please refer to Appendix 6.
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Figure 11 — Typical Network Configuration Diagram

Service Providers

In order to provision the IPitomy IP PBX it is necessary to know the type of Service Providers being used. Carrier and
SIP are the most common service providers. Carriers provide plain old telephone lines (POTS), T1s and PRI lines.
SIP Providers route voice calls over the internet. This is called voice over internet protocol or VolP. As part of the
installation it will be important to know the:

o Name of Providers

o Type of Service Provided (i.e., POTS, T1,or SIP)

e Phone Numbers Associated with the Service

e Password and Login Information for SIP Service

_/@\- You should always consider any previous historical data that you have from your existing
system. Any past reports or spreadsheets which relate to the components being designed,
should be considered as possible input when configuring your IP PBX system.

We recommended that you record this information on the IPitomy Setup Worksheet.
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SYSTEM ADMINISTRATION

Administration Menu

IPitomy IP PBX’s online administration makes it simple to meet the demands of a frequently changing business. It
is also designed to be quick to setup and install. The Administration Menu is located in the Navigation Bar to
the left of the page.

y——
IPITomvy

SMARTER BUSINESS COMMUNICATIONS

Destinations / Extensions

P Add / Import | View | Search | Auto-Discovery || Departments

» Providers
« Destinations

Extensions: 10 Add | CSVFile: | Choose File | N file chasen Import | | Export CSV

Extensions

Groups

Menus

Conferences

Voicemail

Schedules lE .

Branch Offices xtensions

¢ Call Routing

» PBX Setup 161 items Edit PBX Settings Delete All
nRepotine "] Hame Number Status =
i g S

Figure 12 — Administration Menu Options

IP PBX Administration Options

m This menu contains the administration pages used to configure the system. The Administration Menu
is divided into six sections. To navigate to an Administration Page click on the menu section and
b System page to be changed.
b Providers

b Destinations

b Call Routing > System - System setup consists of network configuration settings.
» PBEX Setup > Providers — Providers are sources of PSTN and VolP connectivity. Providers are the lines
» Reporting that handle all incoming and outgoing calls. All VolP providers will be setup here. DID

numbers are also entered here.

> Destinations — Destinations are extensions, groups of extensions, automated attendants (menus),
conferences and voicemail. Destinations are places where calls get routed to in the system.

> Call Routing — Routing sends callers to specific inbound destinations within the system, and routing
outbound callers over specific outbound routes like local, long distance, international and emergency.

> PBX Setup — System settings allow global configuration settings for system applications like PBX timers,
voice messaging settings and music-on-hold.

> Reporting — The system displays usage reports, diagnostic information and monitors system activity.
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Administration Page Layout

Each online Administration web page contains the standard layout. The following section describes the features
or links you will have access to on each page.
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Figure 13 — Standard Page Layout and Features
Link Description
Title Bar The Title Bar at the top of each page displays the name of the section of the Administration
Menu which is currently being edited.
Default When the system is installed it automatically registers default values in many of the
Values administration fields. This simplifies the implementation process.
Advanced In several of the online administration features there is an Advanced link where the most
Link sophisticated capabilities of the IPitomy IP PBX can be configured. If available (depending
on applicable functions), the Advanced link will be located on the lower left side of each page.
About Us The About Us link is located at the bottom left corner of each page This link provides additional
Link information about IPitomy.
Contact Us The Contact Us link is located at the bottom left corner of each page. This link will take you to
Link the Contact Us page that provides you with important contact information for IPitomy
Communications, LLC. The IPitomy team is never more than a call or email away. To contact
an IPitomy team member, click on Contact Us in the lower left corner of the page.
Apply To apply changes to the system you must click the Apply Changes button. Located in the
Changes top right corner of the page, this link globally applies changes to the system which is different
than the Save Changes button that only saves changes to the current page.
Logout The Logout link located at the top right corner of the page allows you to logout of the
Administration page and takes you back to the IP PBX Admin Login page.
Table 4 — Feature and Link Descriptions
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Navigational Tools

The following section describes the navigation tools (buttons) that will allow you to perform various functions such
as Add, Delete, Save or Update data within the Administration system. These buttons will appear where the
functions are applicable to the type of data being created or modified.

Note: Depending on the page that is being displayed, the buttons/icons may be referred to
(labeled) differently. This list describes the more commonly seen and used buttons/icons.

Button/Icons Description

¥ This button or icon allows you to expand or open the function to view more
options.

= This button or icon allows you to collapse or close the function.

v This button or icon allows you to view the items from a drop down list.

O This checkbox button or icon allows you to select or deselect the record for
viewing or modifying, as well as to define if certain features are enabled.

O® This radio button or icon allows you to select or deselect (toggle) between
options.

» This pencil icon allows you to edit the current settings for a specific record (i.e.
extensions or groups).

g This pencil with a phone icon allows you to edit an extension’s current phone
' settings.

This down arrow icon allows you to download a file off of the system.

This curved arrow icon allows you to restore a file to the system or in some
cases, clear out voice messages.

® This “X” icon allows you to delete the item selected
@

The Add button allows you to create a new destination, provider, route,
schedule, etc. For example, to add a new extension, click the Add button on
the Extension Administration page. In some cases, the Add button will change
(have a different label) depending on the function or page you are viewing or

Add Menu

Add

updating. For instance, the button may be displayed as
the Menus page.

, if you are on

Located in the bottom left corner of the screen, the Save Changes button
executes all the changes made to the current page. This button must be
pressed before leaving a page or changes will be lost.

Save Changes

Table 5 — Navigational Buttons and Links

-

/@; An easy way to get the information that is required for a specific parameter or field is to
mouse over it. A callout box with a description of the requirements or recommended
settings will appear.

Echa Training: Route Calls ta:

a00 Length in ms to play tone when call picked up in order to train out echo.

Figure 14 — View of Mouse Over Field Information
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Login Page

ApmiN Login User LoGIn

User Mame: || User Name:
Fassward: Fassward:

Login Login

Figure 15 — IP PBX ADMIN Login Page

Logging In
P STEPS:
1 From a web browser (ie. Firefox), enter the IP Address of the System Administration site.
2 Using the Admin Login (left side), enter the username and password of the PBX. The
default login information is:
Username = pbxadmin
Password = ipitomy
IMPORTANT: Please contact IPitomy’s Technical Support Group
if you need further assistance by email at support@ipitomy.com or
phone 941-306-2200 option 2. You can also visit our FAQ page at
faq.ipitomy.com.
3 The PBX Administration screen appears. Now you can navigate around the PBX,
configuring different features as needed.
Logging Out
P STEPS:
1  You can logout of the PBX Administration page at anytime by clicking on the Logout
link located on the top right corner of the screen.
2 The system logs out and returns you to the PBX Administration Login page.
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SYSTEM NETWORKING

The IPitomy System Menu is for configuring network attributes. For example the IP address of the system and
router information. The System Networking Setup Page allows you to define the Internet Setup for the system’s
hardware. The system must operate using a static IP address; DHCP should only be used on the IPitomy IP PBX
if the router is configured to assign a specific static DHCP address to the system.

TCP /IP Settings

otaticIF |+

P Address: 192 168 1 .| 249
subnet Mask: 285 .|255 .| 255 .0
Default Gateway: 192 163 1 1
static DN=: 2t .|238 |96 12
Static DS 2: 4 2 2 |1
Static DME 3

Save Changes

Figure 16 — Networking Setup Page

The following table describes the fields and recommended settings for Networking Setup for the IP PBX system:

Field
IP Address

Subnet Mask

Default Gateway

Static DNS

Static DNS2

Recommended Settings

Use the default address (192.168.1.249) of the IPitomy IP PBX or an address outside
the range of existing IP addresses assigned by DHCP in the router.

Leave the default setting for the Subnet Mask as (255.255.255.0). The subnet mask
defines what traffic the PBX will listen and communicate to. A value of 255 means the
octet in question needs to match exactly, while a value of 0 means the octet is not
restricted at all. When the PBX is set to the default IP address, a subnet mask of
255.255.255.0 tells the system to communicate with any devices in the 192.168.1.xxx
range.

The default gateway provided is 192.168.1.1. Though this default is a common router
IP, every network is different. Enter the IP address of the router handling their Internet
connection here.

Enter the DNS IP address being used on the network. If a default DNS IP address is
not provided by the router it can be obtained from the network’s Internet Service
Provider.

Enter the DNS IP address being used on the network. If a default DNS IP address is
not provided by the router it can be obtained from the network’s Internet Service
Provider.
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Static DNS3 Enter the DNS IP address being used on the network. If a default DNS IP address is
not provided by the router it can be obtained from the network’s Internet Service
Provider.

Table 6 — Network Setting Descriptions

TCP/IP Settings Section
Edit TCP/IP Default Settings

D STEPS:

1 Navigate to System ¢ Networking. The TCP/IP Settings page appears displaying the
default values for the following setting:

IP Address
Subnet Mask
Default Gateway
Static DNS

2 Click on the IP Address field. Enter the IP address for the Router. Use the default
address (192.168.1.249) of the IPitomy IP PBX or an address outside the range of
existing IP addresses assigned by DHCP in the router Enter the desired IP Address. See
Table above for recommended settings.

3 Click on the Subnet Mask field. Leave the default setting for the Subnet Mask as
(255.255.255.0). See Table above for recommended settings.

4 Click on the Default Gateway field. Change the default Gateway value to the desired
target network. See Table above for recommended settings.

5 Click on the Static DNS field. Change the default DNS value to the desired target
network. See Table above for recommended settings.

6 Repeat step 5 to set the remaining DNS values, if necessary.

) Save Changes
7 Click on the button

8 Click the Apply Changes link located on the right hand corner of the page, to commit the
changes to the database.

Access Control (PBX Access)

The Access Control page is comprised of 3 sub-pages; Host Access, Web Server, and Access Control List.
Each is accessible from the buttons at the top of the page and pertains a different method of controlling
access to the PBX.

Host Access

This feature allows you to limit access to special services on the PBX. An “allow from” entry is a list of one or
more host names, host addresses, patterns or wildcards that will be matched against the client host name or
address. List elements should be separated by blanks and/or commas.
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Note: The parameter for the IP PBX Host Access is pre-configured per the manufacturer’s
specifications. We recommend that you do not change this configuration value.

Host Access Web Server Access Control List

Host Access Configuration

Delete Selected Items Load Factory Defaults

[ ] Service Allow Access From Delete
O =shd 192168, )
[] =shd IPitarmy. com

Add a New ltem

Serice Al Add

Figure 17 — PBX Host Access Page

The following table describes the features and functions available on the Host Access page:

Fields/Buttons Description

Delete Selected This button allows you to delete multiple services at a time.

Items

Load Factory This button will set the PBX back to the default Host Access settings.
Defaults

Add a New Item This section is where you would add new rules for accessing special

services on the PBX
Table 7 — Network Features and Descriptions

IMPORTANT: Changes to the Host Access List are installed
immediately. They are database independent so custom changes do

not migrate from one box to another via a database backup file.

Please contact IPitomy’s Technical Support Group if you think you
need to modify these settings. Email via support@ipitomy.com or

phone at 941-306-2200 option 2. You can also visit our FAQ page at
faq.ipitomy.com.

Web Server Configuration

This feature allows you to define which IPs and/or domains can access the web server, as well as restart the Web
Server. In order for changes to this list to take effect, you must Restart the Web Server.
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_/@Q The parameter for the IP PBX Web Server is pre-configured per the manufacturer’s specifications.
We recommend that you do not change this configuration.

Host Access éWeI:r Ser\reré Access Control List

Web Server Configuration

Restart Web Server

Delete Selected ltems Load Factory Defaults

[ ] Allow Access From Delete

7 all ®

Add a New ltem

[tern Add

Figure 18 — Web Server Configuration Page

Feature Description
Restart Web This feature allows you to restart the web server so that changes made that
Server impact server components can be applied.

Note: Restarting the server will not interrupt phone service. A reboot
of the PBX system will also apply changes made to other attributes.

Allow Access Defines the networks and/or domains that are allowed to access the PBX.
From The “Allow” format may be:
e Domain name
e Full IP address
o Partial IP address
e Network / netmask pair
e Network / CIDR specification
Delete Selected This button allows you to delete multiple services at a time.
Items
Load Factory This button will set the PBX back to the default Web Server settings.
Defaults
Add a New Item This section is where you would add new rules for accessing the Web
Server
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Table 8 — Web Server Features and Descriptions

IMPORTANT: Changes to the Web Server Access List are
preconfigured. They are database independent so custom changes

do not migrate from one box to another via a database backup file.

Please contact IPitomy’s Technical Support Group if you think you

need to modify these settings. Email via support@ipitomy.com or
phone at 941-306-2200 option 2. You can also visit our FAQ page at

faq.ipitomy.com.

Add New Permission

D sTEPS:

1 Navigate to System=> Access Control

2 Click on the Web Server button located at the top of the page. The Web Server
Configuration page appears.

3 Inthe Add a New Item section, enter the network or domain you want to allow to access
the PBX web server

4 Click the ADD button.
5 The new permission rule will be displayed under Allow Access From window above

6 Click on the Restart Web Server button.
7 Click OK when prompted to confirm you wish to restart the Web Server

The page at http://72.64.129.43 says: X

9 Restart local PEX Web Server?

Eook | [ Cancel

8 A “Please Standby” message appears. Once the reboot process is completed you will
be returned to the Web Server Configuration page.

Load Factory Default

This feature allows you to restore the manufacturer’s factory default settings. It will restore the settings to the
factory recommended defaults.

D sTEPS:

1 From the Web Server page, click Load Factory Default button. This will return or
restores the Allow Access From list back to the manufacturer’s default setting.

2 Once the changes applied, you will need to restart the web server. Please refer to the
Restart Web Server topic of this user guide for steps on how to restart the server.

3 Click on the Restart Web Server button.
4 Click OK when prompted to confirm you wish to restart the Web Server
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The page at http:/f72.64.129.43 says: g|

9 Restart local PEY \Web Server?

[ ok | [ Cancel ]

5 A “Please Standby” message appears. Once the reboot process is completed you will
be returned to the Web Server Configuration page.
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Access Control List
The Access Control List defines what networks different PBX features are permitted to communicate with.
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Host Access Web Server éﬁu:cess Control Listé

Load Recommended Defaults

Senvice Port(s) Rules

® =P S060 DROP ALL EXCEPT

G 127.0.0.1

(0 192.168.2.0/255.255.255.0
®  call Manager 5048 DROP ALL EXCEPT

@ 127.0.0.1

(0 192.168.2.0/255.255.255.0
® TFTP B9 DROP ALL EXCEPT

@ 127.00.1

(0 192.163.2.0/255.255.255.0

Add New Rule

Service SIFE v

Host(=)
waney, B AP lE, com

WO

MUK RSy

Create Rule

Add New Service
Service Mame
service Transport Both

Service Ports

single (x)

Range (xy)

Service Policy Deny List »

Create Service

Figure 19 — Access Control List - Add New Rule Section

The following table outlines the parameters and descriptions for the Access Control List.
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Feature Description
Service Displays the name of configured services. Typical services on the PBX are:

SIP - Used for Calls
Call Manager - Used for Desktop Call Manager

TFTP — Used by phones to pull down config and firmware files

Ports Displays the ports that were defined for a particular service.
SIP - 5060
Call Manager — 5048
TFTP - 69

Rules Displays the rules that were configured for a particular service.

Deny List — Accepts all traffic, unless specifically defined
Allow List — Denies all traffic, unless specifically defined

Table 9 — Access Control List Definitions

Load Recommended Default
This is the recommended method to set the Access Control List to the typically used settings.

D sTEPS:

1 Navigate to PBX Setup=>SIP
2 Set the LocalNet to match the network the PBX is installed on, Save, and Apply Changes

3 Nauvigate to the Access Control List page, click Load Recommended Default button.
This will create default rules allowing the PBX to communicate to devices on the LocalNet
in regards to SIP, Call Manager, and TFTP

4 Click the Apply Changes link located on the right hand corner of the page, to commit the
changes to the database.

Add New Service

Add New Service

Senice Name Test Manager
Service Transport Both
Service Ports

Single (%)

Range (x:y)

Service Policy Deny List +

Create Service

Figure 20 — Access Control List Page - Add New Service Section
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The following table outlines the parameters and descriptions required for adding a new service.
Feature Description

Service Name This is the name of the new service and will populate the Service drop-down list in the
Add New Rule section.

Service Transport  This is the service type that will be used to transport the message. The options are
Both, TCP or UDP.

SIP and RTP traffic both occur on UDP, TFTP traffic is UDP, and Call Manager traffic is
TCP. Any other rules created would need to be configured for the protocol used by this
service.

Service Ports This is the port information that is associated with the host. You can enter a single or
range of ports that will be used for this service. SIP uses 5060, Call Manager uses
5048, and TFTP uses 69. Other services must be configured to use the appropriate
ports.

Service Policy This is the umbrella rule for the service, which will be further defined under Add New
Rules. The options are:

Deny List; ACCEPT ALL EXCEPT rule will apply. This will allow all traffic on the
defined port, allowing you to configure a list of Denied IP addresses.

Allow List: DROP ALL EXCEPT rule will apply. This will block all traffic on the defined
port, allowing you to configure a list of Allowed IP addresses.

Table 10 — Add New Service Settings and Descriptions

The following outlines the steps to add a new service in the PBX system.

D sTEPS:

1 Navigate to System=>»Access Control
2 Click on the Access Control List button, The Access Control List page appears.

3 From the Add New Service section, enter a Name, and select the appropriate Transport
Protocol, Ports, and Policy; then click the Create Service button.

4 The new service and its associated values will be displayed in the Service listing.

5 Click the Apply Changes link located on the right hand corner of the page, to commit the
changes to the database.

The following table outlines the parameters and descriptions required for adding a new rule.

Feature Description

Service This drop-down list is populated when a new services is added. This is done
in the Add New Service section.

Host(s) This is the IP Address, Domain Name or URL of the host.

Table 11 — Add New Rule Settings and Descriptions
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Add New Rule
The following outlines the steps to add a new rule for Services in the PBX system.

D sTEPS:

1 Navigate to System=>» Access Control, click on the Access Control List button, the
Access Control List appears.

2 From the Add New Rule section, select the Service type from the drop-down list.
3 Enter the Host/s to be allowed/denied by the service

4 Click the Create Rule button.

5 The new rule is added and will be displayed in the rules list.

6 Click the Apply Changes link located on the right hand corner of the page, to commit the
changes to the database. .

Delete Rules or Services
The following outlines the steps to delete existing rules or services.

D sTEPS:

1 From the Service section of the PBX Access — Access Control List page, find the
service or rule that you want to delete.

2 Clickon ® icon to the left of either the service or rule. The selected item is removed
from the list.

3 Click the Apply Changes link located on the right hand corner of the page, to commit the
changes to the database.

PROVIDERS

Providers are telephone lines, VolP providers and other telecommunication resources. This section of the
system’s online administration is where these provider resources are configured. The PBX system is equipped to
handle two types of provider setting’s Hardware Trunks and SIP Providers.

Hardware Trunks

Hardware trunks are associated with telephone lines that connect to the PSTN. These lines process inbound and
outbound communication traffic that flows over communication channels. For example, a T1 can be a trunk
resource that has multiple lines and multiple Direct Inward Dialed (DID) numbers. These individual numbers can
be routed to different destinations within the system.

Connection Types

The IP PBX is equipped to support an assortment of hardware cards as discussed earlier. Depending on which
card you have, the PBX can integrate with analog lines, T1, or PRI,
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Provisioning a New Hardware Trunk Group

Provisioning a hardware trunk defines how the system works with the provider equipment, tells the system what
phone numbers are associated with the trunk, and establishes rules for the system to follow when processing
incoming and outgoing calls through this physical network connection.

Configuration

Slot Channels Model
Card 1 Yas TUORTI20F Set Add Lines
Card 2 Mone b Set Add Lines

Channel Groups

Name Channels Card Action

T1 Trunks 1-23 1 2 ®

T-1 Span Configuration

Span Timing LBO Framing Coding PRIl

1 1 0 dE (CSU)/ 0-133 f (DSX-1) v est v| | biizs v Set

T-1 PRI Configuration

Span Switch Type Reset Interval Dialplan Indication D Channel

1 Mational IS0OMN 2w 3600 national * | inband w24 Set

USE Device Browser

Slot Status Device

Hardware Functions

Restart USB Devices & PBX Services Wiew Log

Figure 21 — Hardware Providers Trunk Setup Page

2011 Copyright © IPitomy Communication, LLC 32 v4.0.1
www.ipitomy.com



IPiTomy

IPitomy IP PBX Admin Guide SMARTER BUSINESS COMMUNICATIONS

The following table describes the fields and functions available on the Hardware Trunks Provider Configuration

page.
Section Description
Configuration Section

Slot Defines which physical PCI slot the card is connected to.

Channels This indicates whether the card has channels configured. Using the mouse
to hover over this field will provide you with the number of channels at are
set for this card.

Model This is the model or type of card.

Set This button changes the card set in the database for the adjacent slot. The
change is immediate and will delete trunks associated with another card in
the same slot.

Add Lines Selecting this button will take you to the Channel Group Parameters Card
Configuration page, where you can create a channel group.

Channel Groups Section

Name The name associated with this channel group.

Channels The number of channels that have been assigned.

Card The card number associated with the channel group.

Action - Clicking on the pencil icon allows you edit the settings for the selected
channel group.
® - Clicking on the “X” icon allows you to delete/remove the selected

channel group.
NOTE: You must delete channels from outbound routes in order to
delete them.
T-1 Span Configuration

Span Should automatically set to the appropriate span in regards to the cards that
are installed in the PBX.

Timing Set per your providers instructions, “0” (zero) would be the PBX provides
timing, “1” would be the timing is provided by the Provider.

LBO Line Build Out, set per your providers instructions.

Framing Set per your provider’s instructions.

Coding Set per your provider’s instructions.

PRI Check if the trunk is a PRI, leave blank if the trunk is a standard T-1.

T-1 PRI Configuration

Span Should automatically set to the appropriate span in regards to the cards that
are installed in the PBX.

Switch Type Defines what type of equipment the PBX is communicating with. Set per
your provider’s instructions.

Reset Interval Set per your provider’s instructions.

Dialplan Set per your provider’s instructions.
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Indication Set per your provider’s instructions.
D Channel Set to 24.

USB Device Browser

Slot Should automatically set to the appropriate slot that corresponds to the USB
slot the device is connected to.

Hardware Functions

Restart USB This button will restart USB devices and PBX Services.
Devices & PBX
Services

Table 12 — Hardware Trunk Provider Settings and Descriptions

The following section outlines how to setup the parameters for hardware trunks.

Configuring Hardware Trunks

D sTEPS:

1 Navigate to Providers=>Hardware Trunks. The Hardware Trunk (Providers) page
appears. The hardware trunks and their values that have already been provisioned will be
displayed.

2 The system will allow configuring of up to 2 cards that interface with analog or T-1
devices. Select the card models installed in your IP PBX individually and click Set button
for each card in order to tell the system which cards you have.

3 Once you have set the card, click the Add Lines button to the right of the corresponding
card to define line/channel/trunk groups associated with that card. The Edit Hardware
Provider page appears.
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Channel Group Parameters Card 1

Group Marme:

Start Channel:

End Channel:

Use Caller 10:
Mo

Inbound Caller 1D
asreceied

Dutbound Caller [D Marne:

Outhound Caller ID Murmber:

Phone Numbers

Signalling Type:
fus_ks v

FAx Detect:
L]

Dial Prefix:

Echo Cancellation:
Yes (128) v

Echo Cancellation Bridged:

Mo

Echa Training:
300

Relax OTMF (Detection):
Mo+

Generate Ringing on
outhound calls? [

Allow Caller to transfer an
autbound call? [

Allow Call
Recording? [

R Gain:
oo dh
Ta Gain:
n.o dh

Route Calls to:
Mone

OTMF Tane Duration:
300

This section contains phone numbers, (sometimes called DIDs) associated with this provider.

add

remove

Destination: | Mane

W Set

Answer Incoming?
Ves ¥

Anzwer After:
0 SEC

Ext CID
Owerride? [

Restrict CID
Override? [

Busy Detect:
ves ¥[8

Use Inbound CoZ
Off A

Figure 22 — Add/Edit Hardware Provider Configuration Page

4 Edit the necessary parameters. Required fields are: Group Name, Signalling Type, Start
Channel, and End Channel. The rest of the fields can be configured as needed, or left at
their defaults. (refer to the table below for descriptions and recommended settings)

5 Click on the

Save Changes

button.

6 Click the Apply Changes link located on the right hand corner of the page to commit the
changes to the database.

7 Once the changes are applied, navigate to the Hardware Providers page and click the
Restart USB and PBX Services button.
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The following table describes the fields and parameters available on the Add/Edit Hardware Provider
Configuration page:

Section/Field

Description

Channel Group Parameters Card 1

Group Name

Signaling Type

Generate Ringing on

Outbound Calls?

Answer Incoming?

Start & End Channel

Allow Caller to
transfer outbound
call?

Answer After

Dial Prefix

Allow Call

Recording?

Ext CID Override?

This is the name for the groups of channels you want to create. This Group Name will
be associated with the line/channel group.

This is the type of signaling used for these channels/lines. Recommendation and
default settings are listed below:

e Analog lines should be set to fxs_ks.

e T-1lines should be set to fxs_Is or em_w

e T-1 PRI lines should be set to pri_cpe.

This should only be checked if the telephone company is not providing ringing.
Default this is disabled.

This indicates whether the system should answer incoming calls on these
lines/channels. The default value is Yes.

Used to define the Start and End channel for this group on the associated card. If

you would like a 1 channel group set the start and end channel to the same value
(i.e. Start=1 and End=1).

IMPORTANT: If you wish to address analog lines
individually you must build multiple single channel groups.
T1 and PRI can be grouped with multiple channels and

routed via DID.

This indicates whether the system will allow user to transfer a call they origninated
that has been connected to the PSTN. Default this is disabled.

If the system is configured to answer incoming calls, this defines how many seconds
to wait before answering the call. At times this field needs to be tweaked to ensure
consistent CID. Default this is set to 0.

Digits defined here will be dialed out the trunk ahead of the digits dialed by the user.
This would be required if your provider needs a 9 or some other digit to dial
outbound. Analog trunks might need a one second pause which is denoted by a
lowercase w. Default this is blank.

This setting toggles the ability to record calls on this trunk. Default this is disabled.

This setting allows the users to set an alternate caller ID under their extension that
will override the outgoing caller ID. If this is enabled, then this allows extension caller
id override capabilities. Default this is disabled.

c IMPORTANT: Contact your provider to determine whether
CID override is allowed on your specific trunk

This setting is used to limit an extension’s ability to override Caller ID (CID). If

Restn_ct cib enabled, this allows extension CID Override only for the phone numbers defined for
Override? ; . o
this provider. Default this is disabled.
This setting indicates whether the system should attempt to detect caller id on the
Use Caller ID . o o
lines/channels in this group. Default this is set to Yes.
2011 Copyright © IPitomy Communication, LLC 36 v4.0.1

www.ipitomy.com



IPitomy IP PBX Admin Guide

IPiTomy

SMARTER BUSINESS COMMUNICATIONS

Echo Cancellation

RX Gain

TX Gain

Inbound Caller ID

Echo Cancellation
Bridged

Busy Detect

Outbound Caller ID
Name

Outbound Caller ID
Number

Echo Training

Route Calls to

Relax DTMF

This allows you to configure the Echo Cancel parameter. By default this is set to Yes
(128) which will work in most scenarios. Adjustments can be made as needed.

This allows you to set or adjust the gain on sound received from these
lines/channels. Typically these settings don’t need to be changed from default
settings, unless there are issues relating to the volume on the calls. (This setting is
in decibels so 3.0 = 100% increases in volume). Default this is set to 0.0.

This allows you to set or adjust the gain on sound transmitted to these
lines/channels. Typically these settings don’t need to be changed from default
settings, unless there are issues with the volume on the calls. (This setting is in
decibles so 3.0 = 100% increases in volume). Default this is set to 0.0.

This is the name of the Caller ID of the inbound calls on this trunk. If set to the
system default “asreceived’, the calls will capture the Caller ID information sent over
the incoming lines. Otherwise you can override the name and number that appears
to those receiving calls on the corresponding channels.

IMPORTANT: If you need to change this parameter, we
recommend that you contact IPitomy’s Technical Support
Group at (941) 306-2200 for the proper syntax or additional

information.

This allows you to enable or disable the Echo Cancellation Bridge parameter on
calls routed internally across the network. Set this parameter to”YES” (enable) if you
want echo cancellation on calls that are bridged from one port to another on the
network. Default this is set to No.

By default, this is set to YES and 8. This allows you to enable/disable and set the
number of busy signals the system will detect before disconnecting from the call
(hanging up). Set the parameter to “YES” if you want the PBX to hang up after it
detects a busy signal.

The number field is the number of busy tones the system must detect before it
disconnects from the call (hangs up).

Any values entered here will display as the Outbound CID Name when making calls
out this trunk. If this is left blank, the name displayed on outbound calls will match
what is registered with the provider. Blank by default.

c IMPORTANT: Contact your provider to determine whether
CID override is allowed on your specific trunk

Any numbers entered here will display as the Outbound CID number when making
calls out this trunk. If this is left blank, the number displayed on outbound calls will
match what is registered with the provider. Blank by default.

c IMPORTANT: Contact your provider to determine whether
CID override is allowed on your specific trunk
This parameter is used to adjust the time spent training the echo cancellation

algorithm before a call is picked up. The length of time is set in milliseconds (ms),
and is set to 800 by default.

This is the default destination for the trunk. A destination is where calls from this
provider will be routed to, unless a specific Direct Inward Dial (DID) is indicated. A
typical destination is defined as a Menu, Extension, Schedule, Voicemail, or a Ring
Group. This can also be set under the Incoming Routing page.

This allows you to turn On/Off the Relax DTMF detection. Enabling this setting

2011 Copyright © IPitomy Communication, LLC 37 v4.0.1

www.ipitomy.com



IPiTomy

IPitomy IP PBX Admin Guide SMARTER BUSINESS COMMUNICATIONS

(Detection) allows the line/channels to be more permissive of tone lengths and result in over
detecting. By default this is set to No.

IMPORTANT: We recommend that this parameter is set to
NO unless you are having issues. Please contact IPitomy’s

Technical Support Group for assistance or more
information.

This allows you to set the DTMF tone duration in milliseconds (ms) for generated

DTMF Tone Duration tones generated by calls bridged to SIP devices. Default value of 300.

This allows you to enable/disable inbound routing and provides the dial plan that
corresponds to the outbound routes in this Class of Service (CoS). This is Off by

default.
IMPORTANT: Use this only if you intend to provide PSTN
connectivity to 3™ party equipment. Please contact
IPitomy’s Technical Support Group for assistance or more
information.

Use Inbound CoS

On a T1 or PRI, this is where you would configure any DID information. Only
numbers or a + should be entered for a DID. Once configured, you can define a

Phone Numbers different inbound destination for each number, allowing you to route calls to separate
places. Contact your provider to find out if they are sending 4, 7, or 10 digits inbound
for the DID.

Table 13 — Hardware Provider Configuration Settings and Descriptions

Add Phone Numbers to Hardware Provider
Once all the destinations are created, they will appear in a drop-down list and can be selected for updating.

P STEPS:
-z@‘: If a DID destination is set to NONE, it will route to the default location for the trunk
itself.
1 From Channel Groups section of the Hardware Provider page, click the ' icon to the

right of the name you want to modify. The Edit Hardware Providers page appears.

2 The hardware trunks and their values that have already been provisioned will be
displayed. Scroll down the page to the Phone Numbers section. Enter the phone
number that you want to add then click the ADD button. You can also copy and paste a
listin. The list should be separated by newline characters.

3 The phone number entered will appear in the drop-down list to the right of the ADD
button. The numbers will be listed in sequential order.

) Save Changes
4 Click on the button to save the changes to the system.

5 Click the Apply Changes link located on the right hand corner of the page, to commit the
changes to the database.
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Remove Phone Numbers from Hardware Provider

D SsTEPS:

1

»

From Channel Groups section of the Hardware Provider page, click the icon to the
right of the name you want to modify. The Edit Hardware Providers page appears.

Scroll down the page and click on the field to the left of the REMOVE button. Scroll
through the drop-down list to find the phone number that you want to remove.

Click on the desired phone number. Click on the REMOVE button to the right of the list.
The phone number is deleted and will not appear in the drop-down list.

-

z@\- Use the CTRL or SHIF'T button to select multiple or a range of extensions from
the list.

) Save Changes
Click on the button to save the changes to the system.

Click the Apply Changes link located on the right hand corner of the page, to commit the
changes to the database.

Provisioning SIP Providers

SIP Providers are VolIP service provider accounts or other SIP-based devices that provide PSTN connectivity. SIP
provider accounts can have multiple phone numbers or Direct Inward Dialing numbers (DIDs). The individual
numbers can be routed to different destinations within the system as DIDs.

IMPORTANT: SIP Providers settings vary widely. To simplify the
provisioning process, we recommend that you ask the provider for
a sample Asterisk configuration. Please contact IPitomy’s Technical

Support Group for assistance.

Add Provider
Hame Action
SIP Trurk A ®

Figure 23 — SIP Providers Configuration Main Page
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SIP Provider

Mame:

User Type: W

DTMF Mode: auto v

RFC2833 Compensate: F

Host:

Port: 0 Default 0 Custom
Register: 0 ves ) Mo O Custom

Authentication:

0 ves ) Mo O Custom

Auth User:

) Default ) Custom

From User:

) Default ) Custom

From Domain:

) Default ) Custom

Realm: ) Default ©) Custom
Cutbound Proxy: ) Disabled © Enabled
Username:

Secret:

Inbound Caller 1D

Cutbound Caller ID Mame:

Cutbound Caller ID Mumber:

Call Limit: 1
Clualify: 30000
Default Destination: Mone
Dial Prefix

Area Code:

Generate Ringing on outbound calls:
Allow Qutbound Caller to transfer:
Allow Call Recording:

Figure 24 — Add/Edit SIP Provider Configuration Page 1
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Ext CID Override: [

Restrict CID Override; [F]
Can Reinvite: & Yes & No © N
Send Remote Party ID D Yes @ No © nia
Trust Remote Party 1D D ves © No © N
Insecure: ."..."ery -
Allow Codecs:
Disabled Enabled
|G7231 »||G711 (ulaw) - |
G.726 |=] G.711 (alaw) Up
iLEC LA GSM :
Speex Down
[LFC10 - |
Add Delete

Phone Numbers

This section contains phone numbers, (sometimes called DIDs) associated with this provider.

|| Remove

Add

Destination: Mone | 5t

Save Changes .
Figure 25 — Add/Edit SIP Provider Configuration Page 2
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Sections/Fields

Name

User Type
DTMF Mode

RFC2833
Compensate

Host

Port

Register

Authentication

Authorized User

From User

From Domain

Realm

Outbound Proxy

Username

Secret

2011 Copyright © IPitomy Communication, LLC

The following table describes the fields and functions available on the SIP Provider Configuration page:

Description
SIP Provider Section

Name assigned to the SIP Provider. If given a username, this needs to match
that field.

User type of the associated SIP Provider. This can be User, Friend, or Peer.
DTMF tone for the trunk. This can be Inband, rfc2833, info, or auto.

This advanced feature is sometimes necessary when using RFC2833 is
problematic or if the SIP provider has indicated that it is required.

The domain or IP address associated with the SIP host.

If your SIP provider requires registration on a port other than the default
5060, set this field to Custom and enter that port value; otherwise set to
Default.

NOTE: Be sure to forward this alternate port in your router or the traffic will not
be passed through.

Registration option for the SIP Provider.
e YES = Automatically generates based upon provided settings
e NO = Doesn’t require authentication from the SIP Provider

e CUSTOM =Allows for any special authentication rules required from the
SIP Provider

Authentication (previously “Authorization”) requirements for the SIP Provider.
e YES = Automatically generates based upon provided settings
e NO = Doesn’t require authentication from the SIP Provider

e CUSTOM =Allows for any special authentication rules required from the
SIP Provider

Some providers require a different Authorization User Name than the
Username provided. The sample asterisk configuration from your provider
will let you know if this field needs to be set to Custom; otherwise set to
Defaulit.

The sample asterisk configuration from your provider will let you know if this
field needs to be set to Custom; otherwise set as Default.

This parameter is rarely used and if needed, the SIP Domain information can
be obtained from your SIP Provider

If your provider requires you to set the Realm to something other than
asterisk, set to Custom and enter the realm given; otherwise this can be set
to Default.

Enable if the SIP Provider requires you to provide a different outbound IP
address, otherwise leave as Default.

Username used for Registration and Authentication.

The password used for SIP Registration and Authentication.
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Inbound Caller ID

Outbound Caller ID
Name

Outbound Caller ID
Number

Call Limit

Qualify

Default Destination

Dial Prefix
Area Code

Generate Ringing
On Outbound Calls

Allow Outbound
Caller to transfer

Allow Call
Recording

Ext CID Override

This parameter should be left blank to display incoming caller ID as received.
Otherwise you can override the name and number that appears to those
receiving calls on the corresponding channels.

IMPORTANT: If you need to configure the system in a
different way, please contact IPitomy’s Technical Support
Group for assistance and the proper syntax needed.

Contact us via phone at 941-306-2200 option 2 or via email

at support@ipitomy.com. Additional information can be

found at faq.ipitomy.com.

Enter an outbound Caller ID name that will override the Caller ID name that is
displayed on outgoing calls through this provider.

Enter the Caller ID number that will override on outgoing calls through this
provider..

Set to match the number of concurrent calls allowed by the SIP trunk.
(Usually consistent with SIP provider subscription limit.)

IMPORTANT: Contact your provider to determine whether
CID override is allowed on your specific trunk

IMPORTANT: Contact your provider to determine whether
CID override is allowed on your specific trunk

This is the number of milliseconds (ms) the system should wait before
checking to see if the SIP provider is available. Check with your provider to
see what value this should be set to. Typically this can be left at the default
value of 30000.

This is where all inbound calls will be routed to, unless a different specific
destination is designated for DIDs on an individual basis.

Set this parameter only if the SIP Provider requires it.
This parameter is obsolete and will be removed in future releases.

This parameter should only be enabled (checked) if ringing is not provided by
the SIP Provider.

Enabling this parameter allows a user to transfer a call that they originated
on this trunk. Default is disabled.

If enabled (checked), this parameter allows calls to be recorded.
If enabled (checked), this parameter allow the users to set an alternate caller

ID under their extension that will override the outgoing Caller ID. Default is
disabled.

This setting is used to limit an extension’s ability to override Caller ID (CID). If

IMPORTANT: Contact your provider to determine whether
CID override is allowed on your specific trunk

gsztrrrliztegm enabled, this allows extension CID Override only for the phone numbers
) defined for this provider. Default this is disabled.
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Can Reinvite

Send Remote Party
ID

Trust Remote Party
ID

Insecure

Allow Codecs

Phone Numbers

This parameter allows a mechanism to reconnecting calls midstream.
e YES = if the phone type allows the re-invite feature
e NO = if the phone type does not allow the re-invite feature

e N/A = accepts the system wide default defined under PBX
Setup=>SIP=>»Advanced. If the default setting is acceptable and works
within your business, we recommend leaving the parameter set to N/A.

Usually not required. Leave on “N/A” unless advised differently by tech
support.

Usually not required. Leave on “N/A” unless advised differently by tech
support.

This parameter allows you to specify how to handle connections with peers.
Explanation of the different options available on the drop-down list are:

e PORT = Ignore the port number where authentication came from.
¢ INVITE = Do not require the initial invite to authenticate.

e PORT+INVITE = Do not require initial invite to authenticate and ignore
the port where the request came from.

e YES — To match a peer based by IP Address only and not the port.
e VERY - To allow registered hosts to call without re-authenticating.

Encodes a stream or signal for transmission. Select which codecs will be
enabled for this provider. Can typically be left to defaults.

Phone Numbers Section

This is where you would configure any DID information. Only numbers or a +
should be entered for a DID. Once configured, you can define a different
inbound destination for each number, allowing you to route calls to separate
places. Contact your provider to find out if they are sending 4, 7, or 10 digits
inbound for the DID.

Table 14 — SIP Provider Configuration Settings and Descriptions

Add New SIP Provider

The following section outlines the steps to add a new SIP Provider in the PBX system.

D SsTEPS:

1 Click Providers=>SIP Providers. The SIP Providers page appears.

Add Provider

2 Click on the button. The Edit SIP Provider page is displayed.

3 Configure the pertinent fields per your SIP Providers instructions. See the table above
for descriptions.

Save Changes

4 Click on the button.

5 Click the Apply Changes link located on the right hand corner of the page, to commit the
changes to the database.
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Add Phone Numbers
The following section outlines the steps to Add phone numbers to the SIP Provider.

P STEPS:
1 Click Providers=>SIP Providers. The SIP Providers page appears.

2 From the SIP Providers page, select the SIP provider link (under the Name field) or the

' icon to the left of the provider you want to modify. The Edit SIP Providers page
appears.

3 Scroll down to the Phone Numbers section of the page. Enter the phone number in the
box above the ADD button then click ADD. The number enter will appear in the list to the
right of the box.

4 To add multiple phone numbers at one time, press the ENTER key to move to the next
space on the list then enter the number. Click on the ADD button and all the numbers will
appear in the list box (on the right). You can also copy and paste a listin. The list should
be separated by newline characters.

Save Changes
5 Click on the button, once all the numbers have been added, to save the

changes.

6 Click the Apply Changes link located on the right hand corner of the page, to commit the
changes to the database.

Remove Phone Numbers
The following section outlines the steps to remove phone numbers from the SIP Provider.

P sTEPS:
1 Click Providers=>SIP Providers. The SIP Providers page appears.

2 From the SIP Providers page, select the SIP provider link (under the Name field) or the

icon to the left of the provider you want to modify. The Edit SIP Providers page
appears.

3 Scroll down to the Phone Numbers section of the page. Select the number that you want
to remove from the list then click the REMOVE button. The number enter will be deleted
from the list.

4 To remove multiple phone numbers, hold down the SHIFT key to select the numbers in
sequence or the CTRL key to select in random order. Click the REMOVE button to delete
the numbers selected.

) Save Changes
5 Click on the button, to save the changes.

6 Click the Apply Changes link located on the right hand corner of the page, to commit the
changes to the database.
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Set Destination
The following section outlines the steps to set a Destination for DID phone numbers.

P STEPS:
1 Click Providers=>SIP Providers. The SIP Providers page appears.

2 From the SIP Providers page, select the SIP provider link (under the Name field) or the

' icon to the left of the provider you want to modify. The Edit SIP Providers page
appears.

3 Scroll down to the Phone Numbers section of the page. Select the number that you want
to assign a destination. Select the desired Destination from the drop-down list then click
the SET button.

4 To assign the same destination to multiple phone numbers, hold down the SHIFT key to
select the numbers in sequence or the CTRL key to select in random order. Click the
desired Destination from the drop-down list the click SET button. You can also set the
destinations under Call Routing=»Outgoing.

) Save Changes
5 Click on the button, to save the changes.

6 Click the Apply Changes link located on the right hand corner of the page, to commit the
changes to the database.

Delete SIP Provider
The following section outlines the steps to DELETE a SIP Provider in the PBX system.

IMPORTANT: You must remove all instances of the
SIP provider from any outbound dialing routes

before you can delete it.

P sTEPS:
1 Click Providers=>SIP Providers. The SIP Providers page appears.

2 From the SIP Providers page, ® icon to the left of the provider you want to delete. The
SIP provider will be removed and will no longer appear on the list.

) Save Changes
3 Click on the button, to save the changes.

4 Click the Apply Changes link located on the right hand corner of the page, to commit the
changes to the database.
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DESTINATIONS

Destinations are the various places that a call can be routed to within the system. The destinations drop-down list
is populated as destinations are added to the system. During system implementation, if destinations are
populated first it is easier to provision the hardware trunks because all of the destinations will be available in the
drop down menu. These system destinations should be obtained in advance to simplify the setup process. In
most cases, there will be a menu to setup for an automated attendant. There will also be business hours to setup.
We recommend that you use the IPitomy Setup Worksheet to help you gather and organize the necessary
provisioning information prior to installation (see the figure below). The Setup Worksheet can be found on
IPitomy’s website.

(Please refer to the “Installation Worksheet” section of this user guide for details on how to use the Setup

Worksheet).

Figure 26 — IP PBX Data Components

Extensions: are individual extensions assigned to a telephone. When an extension is created, a
voicemail box is also created. This voicemail box is automatically the destination for an extension
call which exceeds its ring time.

Groups: are groups of extensions that can have different ringing strategies and can be routed
from any trunk, another destination or dialed from an extension.

Menus: are used for creating automated attendant menus to route callers to different destinations
within the system. The voice prompt can also be used to play information like driving directions.

Conference Rooms: allow multiple users to participate in the same call. Callers can be routed to
a Conference via; direct dialing, through a DID, using an automated attendant or transferred by a
person.

Voicemail Boxes: are where callers leave a message when someone is not available at an
extension. Voicemail boxes that are created separate from extensions can be used to route
callers after hours or as an overflow destination. Note that in the current implementation
Voicemail Boxes without an extension cannot be dialed with only the voicemail box number. You
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can enter as one leaving a message by dialing *+ box number or you can check the messages by
going through the voicemail gateway or dialing 924.

o Schedules: route callers to different destinations in the organization during specified times and
dates.

¢ Branch Office: connections provide broadband access to other branch locations by dialing a
short access code followed by the extension number. Branch Extensions can also be defined as
part of a branch office. These are remote extensions that can be dialed directly as though they
were local extensions on your PBX. Branch Extensions also appear in drop down boxes for
routing calls to specific destinations.

Extensions

Extensions define where specific people or departments can be reached in an organization. They should be setup
first in the system. The following is a list of the various settings/parameters that will can be updated for each
extension. The parameters you configure for the extensions will vary based on the customer’s general business
practices.

General Settings

Forwarding Settings

Advanced Network Settings
Advanced Voicemail Settings
Advanced Allow Codecs Settings
Advanced Calling Permissions
Advanced Follow-Me

Add/Import Tab
The Add/Import tab allows you to create new extensions or edit existing extensions.

-z@‘: Use the Setup Worksheet to upload the CSV file and automatically create the Extension
information. Please refer to the Setup Worksheet section of this guide for details.
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Add f lmport | View || Search | Auto-DMscovery || Departments

Extensions: Add | CEY File: |[ Browse... Import Export CSV

Extensions
12 items Edit PBX Settings Delete ALL
OName Number Status
Cldudy Garland 111 Igarlandig@anl. com active 4 ®
O Tiger Woods 113 twoodi@yahoo. com active i ®
Ol Donna Adams 186 adamsi@ipitomy.com active A ®
Ceheavers 201 cheavers@ PITOMY COM active A N ®
ClRoger Townsend 204 who@ipitarmy . cam active s N ®
Cldohn Wayne 230 jwayne@ipitomy. com active A ®
OEJ 2207 eji@ipitamy. com active s X ®
Claz11 4211 active & ®
[ Jeff Ulrich - Dermo 1 E200 julfich@cscphones. com active A N ®
Ol Barbara Walker 6270 bwalken@iperfaction.com active A ®
ClDon Merrill G280 dmerrill@iperfection. cam active A ®
Clvinifred Applegate G250 wapplegate@iperfection. com active &~ .‘," ®
Figure 27 — Extensions Add/Import Page

Destinations / Extensions / Create Extensions Logout | Apply Changes

» System

DUOTes AutoMumber [ start At

w Destinations

Extensions
Groups

Menus Extension Name Email Address Ext# Device Type MAC
Conferences

Voicemail Generic
Schedules |Z|
Branch Offices

» Call Routing Create

» PBX Setup

» Reporting

Figure 28 — Create Extensions Page
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Sections/Fields Description
Extension Name This is the name of the person that the extension will be assigned to (using
this device).
Email Address This is the user’s email address (optional)
Ext. # The extension number that is assigned to this device.
Device Type This is the type of device that will be using this extension (i.e. IP550).
MAC This is the MAC ID of the device (optional).
AutoNumber/Start  Selecting this option allows you to automatically number the extensions that
At you need to add. To use this feature, simply enter the extension number you

want to start with then select (place a checkmark) the AutoNumber option.

Table 15 — Create Extension Fields and Descriptions

Add/Create Extensions
This section describes in detail how to create a new extension.

D sTEPS:

1 From any page of the PBX Admin system, click on the * button next to the Destinations
link to expand the menu. The Destination menu opens and displays the options
available.

2 Click on the Extensions link. The Extensions page opens and displays a listing of
extensions (if ones already exists).

3 Click on the box to the left of the Extensions field. This value defaults to “10”. Enter the
number of extensions you want to add and then click the ADD button.

4 The Create Extensions page appears displaying the number of rows that was specified.
Enter information for the extension in these fields. See table above for details.

-

z@‘: You can have the system automatically number the extensions you want to create by
clicking the AutoNumber checkbox located on the top left hand corner of the Create
Extensions page.

5 Click on the CREATE button when all the extension information you want to create is
entered. The system responds with a message indicating the results of adding the new
extension(s). You should see a “SUCCESS” message.

6 If there is an error, you will see an “ERROR” indicated under the Results field. An error is
typically due to an extension number that is being duplicated (already existing in the
system). Make the necessary adjustments to correct the error then click the CREATE
button.

) Save Changes
7 Click on the button, to save the changes.

8 Select the Apply Changes link located on the right hand corner of the page, to commit
the changes to the database.
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Search Tab

This tab allows the user to search the extensions for keywords in the fields: Class of Service, Departments,
Name, Numbers, CID Names, CID Numbers, Email, or Status .This section describes in detail how to search for

existing extensions.

Add / lmport | View [ Search @ Auto-[Mscovery | Departments

Class of Service ¥

Search Clear

Match O exact @ partial

Figure 29 — Search Extension Page

The following table describes the types of search parameters the system will perform.

Sections/Fields
Class of Service
Departments
Names
Numbers

CID Names

CID Numbers

Emails
Status

Match Search Filter

Description
This is the class of service that is assigned to the extension(s).
This is the department that is assigned to the extension(s).
This is the name of the user assigned to the extension(s).
This is the extension number.
The caller ID name that is associated with the extension(s).

This is the caller ID number that is associated with the
extension(s).

Email address that is associated with the extension(s).
This is the status of the extension(s).

Exact — indicates that you want the search to match exactly as
the search criteria that is entered.

Partial — indicates that you want to partially match the search
criteria entered.

Table 16 — Search Extension Parameters and Description

Search Extension

This section describes how to search for extensions.

D SsTEPS:

1 From the Extensions page, click the Search Tab. The list of extensions that are in the
system appears with search options at the top section of the page.

2 Click the ¥ drop-down arrow icon next to the Class of Service list.

Select the desired search criteria then enter the parameters in the box to the right of the
list then click the Search button. If the system finds any extensions matching your search
parameter, it will display the information in the extensions window.
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-

/@; If the field is left blank, the system will bring all the extensions.

View Tab (Extensions)

This tab allows the user to sort the display of extensions by Phone Model. Once sorted, phone key settings can
be mass edited for phones of the same model. This section describes in detail how to view existing extensions.

Add [ lmport | View | Search || Auto-DMscovery | Departments

Phone Models & Settings [

Figure 30 — Extensions View Page

Edit or View Extension
This section describes in detail how to view or edit extension details.

P STEPS:
1 Navigate to the Destinations=» Extensions page.

»

oy
2 Select the or the ## icon to the right of the extension name you want to view or edit.
The pencil edits the PBX settings and the pencil with the handset behind it edits the
Phone settings.

3 The Edit Extensions page displays with setting details for the extension.

4 Make the necessary changes to the extension.

Save Ch
5 Click onthe "= “"™BEF | ) tton to save the changes.

6 Click the Apply Changes link located at the right hand corner of the top of the page, to
commit the changes to the database.

_/@\- You can edit multiple extensions by selecting (placing a checkmark in the box
next to extension name). Only the fields being changed (that is common for all
extensions selected) will be modified — i.e. Status or call group, etc.).

Another shortcut that the system provides you is the Previous and Next button
located on the top left corner of the Edit Extension page. Use these buttons to
navigate backward or forward to find the extensions you want to view or modify.

Mass Edit PBX Extension Settings
This section describes in detail how to view or edit extension details.

D sTEPS:

1 From the Destinations=»Extensions page, click on the View tab. A list of extensions
appears.

-

/@; You can sort the list by phone model by selecting (placing a checkmark) the
Phone Model & Settings option located in the top left hand corner of the screen.
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If you are using this method, you can also Mass Edit Phone Key settings. See the
section below for steps.

2 Select (place a checkmark) in the box next to the extension name(s) you want to view or
edit.

3 Click on the Edit PBX Settings button. The extension details page appears. On the top
left corner of the screen, you will see the extension numbers that you are viewing or
editing.

4 Make the necessary changes to the extension settings then click on the « >*¢ thanees

button to save the changes.

5 Click the Apply Changes link located at the right hand corner of the top of the page, to
commit the changes to the database.

Mass Edit Phone Key Settings

This section of the Administration Guide describes how to mass edit the key settings for extensions using the
same phone model.

Add / Import || View || Search | Auto-DMscovery || Departments
Phane Models & Settings

Extensions / Grouped by Phone Model
Generic 59 Delete All
Rastra 67551 2 Edit Phone Settings Delete All
Aastra 67571 1 Edit Phone Settings Delete Al
Aastra 67531 1 Edit Phone Settings Delete All
IPitomy 550 27 Edit Phone Settings Delete All
O orew Horne 2224 active & \,J. ® (=
O Drew Harrell 2225 aharrell@ipitorny. com active S ®
[ dustin Bogli 2226 hogligipitormy. corm active S ®

Figure 31 - Extensions View Tab (Mass Edit Feature)

P STEPS:
1 From the Destinations=>»Extensions page, click on the View tab.
2 Select the Phone Models and Settings option at the top left hand corner of the list.
3 The system will display a list of the extensions in a grouping of phone types. Select the
group of phones you want to edit. A listing of all the extensions in the phone group will

appear.

4 Select the box next to the name of the extensions you want to update or click on box next
to the Name field at the top of the column to select all the extensions.
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5 Click the Edit Phone Settings button. The system will take you to the Key Settings
page for the phones. At the top of the page you will see a list of all the extensions that
you are updating.

6 By default, the Only Save Changed Fields option Is selected, de-select if needed.

7 Once all the changes are made, select the Save and Restart Phone button to save
changes and reboot the phones so they can pull down their updated configuration file.

Delete Extension
This section describes in detail how to delete existing extensions.

D sTEPS:

1 Navigate to the Destinations=>Extensions page

2 Selectthe ® icon to the right of the extension name you want to Delete

3 The extension is deleted and a confirmation message will appear. Click OK on the
message window.

4 The system returns you to the Extensions page. The extension that was just deleted will
no longer appear on the list of extensions.

5 Click the Apply Changes link located at the top right hand corner of the page, to commit
the changes to the database.

Delete Multiple Extension
This section describes in detail how to delete multiple extensions.

P STEPS:
1 Navigate to the Destinations=>Extensions page
2 Select (place a checkmark) in the boxes next to the extension name(s) you want to
delete.

3 Click on the Delete All button. The selected extension will be removed from the list and
deleted from the database.

4 Click the Apply Changes link located at the top right hand corner of the page, to commit
the changes to the database.
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Extensions - General Settings Section

Once the extensions have been added to the database, you can edit the settings for each of the extensions.

Sections/Fields

General Seftings I

Mame: 4211

Mumber: 4211

Email:

Status: active w

Class of Service: All b
Pl 4211

Ring Time: 32

Call Group: 1

Fickup Group: 3

Apply Schedule: ]

CID Override: Enabled O Disabled ®
1D Marne:
CID Mumber:
Detect FAX: F
Mone w || [

Route Fax To;

Figure 32 — Extensions General Settings Section

Description

Name Name of the user associated with the extensions being created
Number Extension number for this person or department. This must be 3 to 4 digits
in length
. Email address for the person assigned to the extension. This will allow
Email the system to forward email messages to the address of the person at
the extension when properly configured.
Status Active = currently in use
Disabled = currently not in use
Class of This is the service type for the extension. When initially created, the
Service PBX will set this to the COS you have definined as the system default
class of service on the PBX Setup=» General Page
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PIN

Ring Time

Call Group

Pickup Group

Apply Schedule

CID Override

CID Name

CID Number

Detect Fax

Route Fax To

This is the number used to access the extensions voicemail and can be
between 1 and 6 digits long. The default setting is for the PIN to be the
extension number. Be sure to instruct users to change the PIN to avoid
unauthorized use.

This is the time in seconds that a call will ring before it is considered
unanswered. Ring time must be between 1 and 100 seconds in length.

This number assigns this extension to a group with a similar purpose
(e.g., Sales or Customer Service). Multiple call groups can be assigned
to each extension by putting a comma between the group numbers.
The call groups also define which Pickup Groups can answer calls to
this extension.

This number should match any Call Group number entered on an
extension. It defines the Call Group Numbers this extension can pickup
remotely by pressing 99.

When an extension is created, a schedule destination is created
automatically. This schedule is not activated until the Apply Schedule
box is selected. When it is selected, all calls sent directly to this
extension must first pass through the extension’s schedule and will be
routed accordingly. Extension schedules will appear with the name of
the extension (e.g., Extension 123 would appear as “ext_123"). (See
the Schedules section of this guide for more information.)

If enabled, the user will be able to override the Caller ID settings. When
the user places a call, the original assigned CID will be bypassed and
the name and number will that is entered in the CID Name and Number
fields will be sent instead. Always check with your provider that CID
override is allowed before configuring.

If the CID Override parameter is enabled, this is the Caller ID name
that will be seen by the recipient when an outbound call is placed.
Always check with your provider that CID override is allowed before
configuring.

If the CID Override parameter is enabled, this is the Caller ID number
that will be seen by the recipient when an outbound call is placed.
Always check with your provider that CID override is allowed before
configuring.

If checked, calls from an Analog or T1/PRI card that route direct to this
extension will spend a period of time (Defined under PBX
Setup=>»General) checking if the call is a fax. During this time, the PBX
holds the call; if fax tone is detected, the call will be passed along to
the destination defined for Route Fax To, otherwise it will pass the call
to the extension after the detection time has expired.

Define where calls will be routed if fax tone is detected.

Table 17 — General Extension Settings and Descriptions
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Extensions - Forward Settings Section

The extensions forwarding settings are made to be very user friendly. The settings may be modified from the
Smart Personal Console, changed from your telephone extension, or changed remotely from any telephone
(including cell phones), using the touch-tone key pad.

Forwarding Settings

Unconditional | Enabled

@ Phone Mumber O Destination
12345687
Busy Enabled
O Phone Mumber ® Destination
Extenszions A

Extension: 127

Mo Answer Disahled

Lnavailable Disahled

Figure 33 — Extensions Forward Settings Section

Forward settings routes calls to a different destination. These settings can be:

Sections/Fields

Unconditional

Description
Always route calls to a specific destination.

Route calls to a specific destination when the extension is in use or do not

Busy disturb is enabled.
No Answer Rogte cal[s to a specific destination when a call is not answered in the

defined Ring Time

Route calls to a specific destination when a phone is turned off, is not
Unavailable registered with the system, or has reached its call limit (as set in the IPitomy

IP PBX).

Table 18 — Extension Forward Settings and Descriptions
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Enable/Disable Forward Settings
The following outlines steps to enable or disable forward settings:

D STEPS:

1
2

Pick the setting to be modified — Unconditional, Busy, No Answer or Unavailable.

Select Enabled or Disabled. Disabled turns the forward setting off. Enabled turns the

forward setting on.

Select either Phone Number or Destination. Phone Number allows you to enter the digits
you want dialed, like a PSTN number. Destination will bring up the standard dropdown

list of destinations in the system; Extensions, Groups, etc.

Enter the Phone Number or select the Destination you would like the PBX to route to

when meeting the forwarding requirements.

5 Ch
Click | M€ =MMEES | ton to save the changes. The system returns you to the Edit

Extensions page.

Click the Apply Changes link located on the right hand corner of the page, to commit the

changes to the database.

Change Unconditional Forwarding via Keypad

D SsTEPS:

Only unconditional forwarding can be changed from a touch-tone keypad. Enter the following code to
set the unconditional forwarding setting.

1 Dial *90 to disable forwarding.
2 Dial *91 to enable forwarding.
3 Dial *92 to set the forwarding number.
2011 Copyright © IPitomy Communication, LLC 58 v4.0.1

www.ipitomy.com



IPiTomy

IPitomy IP PBX Admin Guide SMARTER BUSINESS COMMUNICATIONS

Change Unconditional Forwarding via PC

The following outlines the steps for the end user to change the extension forwarding setting from a PC using the
Smart Personal Console. The administrator will need to have enabled Allow User to control Forwarding under the
extensions calling permissions.

P STEPS:
1 Browse the internet to the Smart Personal Console page.
2 Login.
S
V)
3 Click the link to access the forwarding page.

4 Enable/Disable the desired forwarding setting.
5 Select either Phone Number or Destination. Phone Number allows you to enter the digits

you want dialed, like a PSTN number. Destination will bring up the standard dropdown
list of destinations in the system; Extensions, Groups, etc.

6 Enter the Phone Number or select the Destination you would like the PBX to route to
when meeting the forwarding requirements.

5 Ch
7 Click | ™= =MMEES [ tion to save the changes

Change Forwarding Number While Away from an Extension
Only unconditional forwarding can be changed from a touch-tone keypad.

P STEPS:
1 Call into the Automated Attendant (menu).

2 Select the touch-tone digit that routes to the Forwarding Gateway.

3 The system will prompt for an Extension Number and Password.

4 The system will indicate if extension forwarding is Enabled or Disabled.
5 Pressing “1” toggles between Enabled and Disabled.

6 Pressing “2” allows the forwarding destination to be modified.
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Extensions - Advanced Settings

Extensions - Network Settings Section

Network settings automatically register in the extension through the system. These settings represent registration
and identification information. The system (extension) defaults should not be changed without advanced
knowledge of the behaviors of the particular settings.

Network Settings

SIP Password: WisEnOR Generate
Strongest
|
Laocation: LAMN (Local)

NAT:

Host: dynamic

FPhone Type: [Fitarny 550 % | Settings
Fhone WMALC: O0CO02207 CAS

Clualify: a0a0

OTHF fade: info e

User Type:

Call Limit: 4 7]

Can Reinvite: O ves O Mo @ nia
Insecure: Yery W
MusicOnHold: Use Systermn Default +

Figure 34 — Extensions Advanced Network Settings Page

2011 Copyright © IPitomy Communication, LLC 60 v4.0.1
www.ipitomy.com



IPitomy IP PBX Admin Guide

IPiTomy

SMARTER BUSINESS COMMUNICATIONS

Sections/Fields

SIP Password

Generate

Password
Strength

Location

NAT

HOST

Phone Type

Phone MAC

Qualify

Description

Password for the user to access IP PBX web-based administration system. Use a
combination of uppercase letters, lowercase letters, and numbers.

If clicked, the system will automatically generate a password for the extension.

This color code bar indicates the strength of the password being assigned for the
extension. The strengths are represented with the following colors:

Wery Wisak

Weak
[ ]

Better

hdediurm

strongest

This allows the user to tell the PBX whether to expect this extension to register as a
local extension (LAN) or as a remote extension (WAN).

IMPORTANT: This setting should be ENABLED (checked)
unless otherwise instructed. Please contact an IPitomy’s
Technical Support Group for assistance or more

information.

IMPORTANT: This should be set to DYNAMIC unless
otherwise instructed. Please contact IPitomy’s Technical

Support Group for assistance.

The phone type is a drop down list for selecting which IP phone hardware is being
used on the extension. IPitomy supports Aastra® phones as well as our own IP550
and IP120 phones, and will be adding additional phone types in the future. When the
phone type is selected, another configuration option is available to program the
button mapping of each telephone model. The IPitomy IP PBX supports a variety of
pre-programmed buttons like BLF, park, voicemail, as well as custom configurable
speed dial buttons. Each phone can be configured for its own unique set of buttons.

All of the IP phones have a MAC Address. The MAC ID identifies the piece of
equipment for configuration. The auto configuration features of IPitomy rely on the
MAC address to load the proper configuration files into the telephone when changes
are made in the Web-based interface. The configuration files are stored on the
IPitomy IP PBX and used when the phone powers back on after a power down cycle.
If the configuration files have been updated when the phone powers back on, a new
configuration is loaded into the phone. When the new configuration file is loaded,
manual settings on the phone take priority and will be kept intact during the upgrade.
Note that at this time only Aastra® phones require and utilize the MAC address in the
phone settings.

This is the interval of time between checking registration for the phone. Default is
set to 8000 and should not be changed unless instructed by an IPitomy
representative.
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DTMF Mode

User Type

Call Limit

Can Reinvite

Insecure

Music On Hold

This is where you set what kind of DTMF signaling the extension will use. The
dropdown lists options are:

rfc2833
auto
info
inband

Typically you would want the DTMF type to be info on both the PBX and in the phone
itself.

This is defaulted to Friend and should not be changed unless instructed to do so by
an |IPitomy representative.

This is the number of concurrent calls allowable at an extension. The
Call Limit selected must be between 1 and 99. Default is set to 4. It
needs to be above 0 for BLF keys to function.

This parameter allows a device to reconnect calls midstream.

YES = if the phone type allows the re-invite feature
NO = if the phone type does not allow the re-invite feature

N/A = accepts the system wide default defined in the System Setup section of the
Administration System. If the default setting is acceptable and works within your
business, we recommend leaving the parameter set to N/A.

This parameter allows you to specify how to handle connections with peers.
Explanation of the different options available on the drop-down list are:

PORT = Ignore the port number where authentication came from.
INVITE = Do not require the initial invite to authenticate.

PORT.INVITE = Do not require initial invite to authenticate and ignore the port
where the request came from.

YES — To match a peer based by IP Address only and not the port.

VERY - To allow registered hosts to call without re-authenticating. This is the
default setting.

This setting allows the user to select a different Music On Hold playlist for their

extension then the system default playlist.

Table 19 — Extensions Advanced Networking Settings and Descriptions

Edit Extensions - Network Settings

D SsTEPS:

1

From the Edit Extensions page, locate the extension that you want to update. Click the

(edit extensions) icon to the right of the name.

~ »
/@\

You can also edit multiple extensions by selecting (placing a checkmark) in the
boxes to the left of the extensions you want to update. Click the Edit PBX Settings
button located at the top right hand corner of the list.
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You will see the extensions that are currently being updated. Make sure that the
“Only save the changed fields” box is selected.

Advanced

2 The Extension Details page appears. Select the
Settings page.

link to open the Advanced

3 Make the necessary changes in the Network Settings section of the page.

Save Changes

4 Click
Extensions page.

button to save the changes. The system returns you to the Edit

5 Click the Apply Changes link located on the right hand corner of the page, to commit the
changes to the database.

Extensions - Voicemail Settings Section

These settings manage voicemail messaging and routing. Mailboxes created when the extension is built can
either be edited on the Advanded section of the extension or on the Voicemail section under Destinations.

Voicemail Settings
Mlailbos:
Attach to Email.  Yes @ Mo O nia O
Delete After

- ves O Mo @ wia O
Ermnailing:
Turn Cld After

i, s O No @
Ermnailing:
Say Caller ID: ves @ Mo O nin O
Allowy Revienw: ves O No @ s O
Allow Operator; ves @ Mo O nin O
Play Envelope

y # Yes @ Mo O nia O
Wessage:
Auto Delete & i
YWoicemail in: ays
Allow Dial Out

no ¥

Access:
Exclude fram
. ho ¥
Directory:
Mailbox Operator | Waicemail v
Destination: wWaoicemall: 2208 v
Wlailbox Exit

o MNone |
Destination:

Figure 35 — Extensions Voicemail Settings Section

2011 Copyright © IPitomy Communication, LLC

63

www.ipitomy.com

v4.0.1



IPiTomy

IPitomy IP PBX Admin Guide SMARTER BUSINESS COMMUNICATIONS

This table describes the voicemail setting options for each extension.

Sections/Fields
Mailbox

Attach to Email

Delete After
Emailing

Turn Old After

Description
This is the number associated with the extension.

Select to enclose the message received in a notification e-mail as an attachment to the
email address entered for the extension. An audio file (.Wav) will be the attachment.
This requires for Unified Messaging to be configured on the PBX.

YES = attach message to email.
NO =do not attach message to email.

N/A = accepts the system wide default defined under PBX Setup=>Voicemail. If the
default setting is acceptable and works within your business, we recommend leaving
the parameter set to N/A.

Delete the voicemail after it has been emailed to the email address provided for the
extension in General Settings.

YES = delete message after emailing.
NO = do not delete message after emailing.

N/A = accepts the system wide default defined under PBX Setup=>»Voicemail. If the
default setting is acceptable and works within your business, we recommend leaving
the parameter set to N/A.

Note: This option should not be enabled with turn old after emailing. If you
enable both, the message will not be emailed but it will be deleted.

After emailing, the system moves the voicemail message to the Old folder.

YES = will move message to Old messages folder after emailing.

Emailing NO = messages will not be moved after emailing.
Note: This option should not be enabled with delete after emailing. If you enable
both, the message will not be emailed but it will be deleted.
State Caller ID prior to playback of the message.
YES = play caller id prior to message content.

Say Caller ID NO = do not play caller id prior to message content.
N/A = accepts the system wide default defined under PBX Setup=>»Voicemail. If the
default setting is acceptable and works within your business, we recommend leaving
the parameter set to N/A.
Allow callers to review a message after they have recorded it.
YES = give callers leaving messages the option to review and rerecord the message
they are leaving.

Allow Review NO = do not give callers the option to rerecord.
N/A = accepts the system wide default defined under PBX Setup=>»Voicemail. If the
default setting is acceptable and works within your business, we recommend leaving
the parameter set to N/A.
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Allow Operator

Play Envelope
Message

Auto Delete
Voicemail In

Allow Dial Out
Access

Exclude from
Directory

Mailbox
Operator

Mailbox Exit
Destination

Allow pressing “0” during the voicemail greeting to reach the system-wide operator.
YES = allow dialing 0 from mailbox.
NO = disallow dialing 0 from mailbox.

N/A = accepts the system wide default defined under PBX Setup=>Voicemail. If the
default setting is acceptable and works within your business, we recommend leaving
the parameter set to N/A.

Play the time of call prior to the message.
YES = enabled.
NO = disabled.

N/A = accepts the system wide default defined under PBX Setup=>»Voicemail. If the
default setting is acceptable and works within your business, we recommend leaving
the parameter set to N/A.

Define the number of days in which voicemail messages are to be automatically deleted
from a mailbox. If this is set to “0” (zero) the voicemail message will never expire.

This allows the ‘Dial Out’ feature when a user is listening to their voicemail.

This indicates whether to exclude this extension from the directory.

If a caller presses “0” (zero) while listening to your mailbox greeting, the caller will be
routed to this destination. Also, this is where a user will be sent if he dials "0” from this
extension. Set this to None to use the system default which is set under PBX
Setup=>General.

The Mailbox Exit Destination is where the system will route a caller who presses #
when they finish leaving a voicemail message. Setting this to None will use the
system default, which is set under PBX Setup=»General.

Table 20 — Voice Mail Settings and Descriptions

Edit Voicemail Settings

The following outlines the steps to set voicemail parameters.

D sTEPS:

1

From the Edit Extensions page, locate the extension that you want to update. Click the

(edit extensions) icon to the right of the name.

_/@\- You can also edit multiple extensions by selecting (placing a checkmark) in the
boxes to the left of the extensions you want to update. Click the Edit PBX Settings
button located at the top right hand corner of the list.

You will see the extensions that are currently being updated. Make sure that the
“Only save the changed fields” box is selected.

A d
The Extension Detail page appears. Select the link to open the Advanced

2
Settings page.
3 Make the necessary changes in the Voicemail Settings section of the page.
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4 Click | *aethanees [ 410 to save the changes. The system returns you to the Edit

Extensions page.

5 Click the Apply Changes link located on the right hand corner of the page, to commit the
changes to the database.

Extensions - Allow CODECs Section
These transmission speeds are configured by the service provider and designed to automatically register in the
extension through the system.

Allow Codecs

G.723.1 #|[G.711 ulaw)

G726 G711 (alaw) Up
iLBC GShd
Speex | |H.264 oo
LFCI0

Add Remove

Figure 36 — Extensions CODECS Settings Page

Sections/Fields Description

Allows the administrator to define which codec the extension should

use, and specify a priority from top down.
CODEC Permissions pectyap y P

(Allow CODECSs) i:t IMPORTANT: Please contact IPitomy’s Technical

Support Group for assistance if you feel you need to
change these settings.

Table 21 — Extensions CODECS Settings and Recommendations

Edit CODEC Settings

The following outlines the steps to set CODECs parameters.

D SsTEPS:

1 From the Edit Extensions page, locate the extension that you want to update. Click the

(edit extensions) icon to the right of the name.

-z@‘: You can also edit multiple extensions by selecting (placing a checkmark) in the
boxes to the left of the extensions you want to update. Click the Edit PBX Settings
button located at the top right hand corner of the list.

You will see the extensions that are currently being updated. Make sure that the
“Only save the changed fields” box is selected.

Advanced

2 The Extension Detail page appears. Select the link to open the Advanced
Settings page.
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3 Make the necessary changes in the Allow CODECs Settings section of the page.
Clicking Up or Down when highlighting a codec will allow you to raise or lower its usage
priority.

5 Ch
4 Click - ~™&=MMEES [ tton to save the changes. The system returns you to the Edit

Extensions page.

5 Click the Apply Changes link located on the right hand corner of the page, to commit the
changes to the database.

Extensions Calling Permissions Section

Calling permissions define the types of calls that can be sent and received from an extension and the call actions
this extension can take. For example, you may want to limit who has the ability to monitor another extension.

Calling Permissions

&

Allow User to control Forearding

&

Allow User to control Follow-Me

=

Allowe User to change Phone Key Settings

Internal Calls

B E

Allow Incorming Intercom Paging

&

Allowe Outgoing Intercom Paging

&

Allowe User to Forward Calls

=

Allow User to Record Calls

Allowe Uszer to Listen to Others' Calls

B E

Allow User to Whisper

&

Allowe Others to YWhisper

&

Allowe Others to Listen

Allowe Others to Record this User's Calls

3]

Allowe Call Park

O =

ls Operatar

Figure 37 — Extensions Calling Permissions Section

The following table describes the settings for an extension’s calling permissions.

Sections/Fields Description

Allow User to If Enabled (checked), this allows the user to modify their forwarding and
Control schedule settings when they log into the Smart Personal Console user
Forwarding interface.

Allow User to If Enabled (checked), this allows the user to modify their Follow-Me settings

Control Follow-Me when they log into the Smart Personal Console user interface.

Allow User to If Enabled (checked), this allows the user to modify their Phone Key settings

Control I-:’hone when they log into the Smart Personal Console user interface.
Key Settings
Internal Calls If Enabled (checked), this permits calls made from internal extensions.
2011 Copyright © IPitomy Communication, LLC 67 v4.0.1

www.ipitomy.com



IPitomy IP PBX Admin Guide

IPiTomy

SMARTER BUSINESS COMMUNICATIONS

Allow Incoming
Intercom Paging

Allow Outgoing
Intercom Paging

Allow User to
Forward Calls

Allow User to
Record Calls

Allow user to
Listen to Others’
Calls

Allow User to
Whisper

Allow Others to
Whisper

Allow Others to
Listen

Allow Others to

Record this User’s

Calls
Allow Call Park

Is Operator

If Enabled (checked), this permits a page to be heard through this extension.

If Enabled (checked), this permits a page to be made through this extension.

If Enabled (checked), this permits an extension to forward a call or voicemail
message to another destination on the system.

If Enabled (checked), this permits the extension to record phone
conversations.

If Enabled (checked), this allows the user to listen to other user’s phone
conversations.

If Enabled (checked), this allows the user to whisper to another user during a
phone conversation. Whisper is similar to Listen but you can coach and only
the person at the extension can hear.

If Enabled (checked), other extensions can Whisper to your extensions calls

If Enabled (checked), other extensions can Listen to your extensions calls

If Enabled (checked), other extensions can Record calls at your extension

If Enabled (checked), this permits extension to park a call.

If Enabled (checked), the extension is designated as an operator. Being an
operator allows the extension to control Day/Night mode overrides.

Table 22 - Calling Permission Settings and Descriptions

Add/Edit Calling Permissions

The following outlines the steps to set calling permissions for extensions.

D sTEPS:

1 From the Edit Extensions page, locate the extension that you want to update. Click the

(edit extensions) icon to the right of the name.

- -
z@\

2 The Extension Detail page appears. Select the

You can also edit multiple extensions by selecting (placing a checkmark) in the
boxes to the left of the extensions you want to update. Click the Edit PBX Settings
button located at the top right hand corner of the list.

You will see the extensions that are currently being updated. Make sure that the
“Only save the changed fields” box is selected.

Advanced

link to open the Advanced

Settings page.

3 Make the necessary changes in the Calling Permissions section of the page.
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Save Changes

4 Click
Extensions page.

button to save the changes. The system returns you to the Edit

5 Click the Apply Changes link located on the right hand corner of the page, to commit the
changes to the database.

Extensions - Follow-Me Section

The Follow Me feature allows the PBX to try and find a user by calling pre-configured numbers, simultaneously or
in sequence of priority. Once answered, the called party is given the option to accept or reject the call. If the call
is rejected, or not answered at all, the call will return to the PBX allowing the caller to leave a Voice Mail message.

Administrator View - Follow-Me Settings I Extension 186

Play the Incoming message to Caller before starting search.

Record the Caller's name and play it to You.

Play the Unreachable message if You could not be found.

Add |1 2 |3econ(ls to total search time so Caller has time to listen & record.

Call From Prompt: | Systern Default v |

Ho Recording Prompt: | System Default v |

Options Prom|)t:| System Default V|

Please Hold Prom|)t:| System Default V|

Status Prom|)‘l:| Systern Default V|

Sorry Prom|lt:| Swstern Default V|

Music On Hol(l| Use System Default V|

Use Priority Rimgs Tyvpe Name Number
[20 »| (2 ~|[Mobile +|
[20 ] [2 ][ Mohile ]
[20 ] [2 +|[Makile v

[20 »| (2 ~|[Mobile +|

[20 »| (2 ~|[Mobile +|
[20 ] [2 »][Mokile ]
[20 v] [2 +|[Makile v
[20 »| (2 ~|[Mobile +|

[20 »| (2 ~|[Mobile +|

oiojoo|o|o|oo|og|o

[20 ] [2 »][Mohile ]

Figure 38 — Extensions Advanced Settings Follow Me Setup Page

From this window it is easy to configure numbers to be dialed by the system in order to find the user. You can
adjust the Name, Number (Number to be dialed), Type of Device that is being called, Rings to wait for an answer,
and you can weight the priority from 1-20 (20 being lowest 1 being highest) to define search order.

The Use radio box allows you to easily turn on and off numbers to be dialed. Since the SPC can be accessed via
remote management, this allows the users to modify and create these lists from remote locations easily. The
following table details the parameters and descriptions necessary to configure the Follow-Me feature.

The system also allows you to record your own Prompts (recordings) under PBX Setup=>»Prompts, and then use
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Sections/Fields

Play the Incoming
Message to Caller
before Starting Search

Record the Caller’s
Name and Play it to
You

Play the Unreachable
Message if You Could
Not Be Found

Number of Seconds to
Total Search Time so
Caller Has Time to
Listen & Record

Call From Prompt

No Recording Prompt

Options Prompt

Please Hold Prompt

Status Prompt

Sorry Prompt

Music On Hold

Numbers

those prompts as custom messages for FollowMe feature.

Description

When Enabled (checked), the system plays the Status Prompt to the
caller.

When Enabled (checked), the caller will be asked to record their
name, and will announce that recorded name prior to prompting the
called party to accept or reject the call.

When Enabled (checked), this will play the Sorry Prompt if the call is
not answered, otherwise it goes right to the voicemail greeting.

This allows you to configure how many seconds the system will spend
searching for the called party. Default is 12 seconds.

This plays when Record the Caller’'s Name and Play it to You is
enabled (checked). The system default message is “Incoming Call
From” followed by the recording the caller made of their name.

This plays when Record the Caller’'s Name and Play it to You is
disabled (not checked). The system default message of “You have
an incoming call” followed by the Options Prompt.

This plays after you have answered the call and prompts you to press
either “1” to accept the call or “2” to reject the call. The system
default message can be changed, but the options remain the same.

This plays to the caller alerting them that the system is going to find
the user they are trying to reach. The system default message of
“Please hold while I try to locate the person you are calling” will
play during the search process.

This plays the system default message of “The person you are
calling is not at their desk, I will try to locate them for you”.

This plays if the person could not be reached or they reject the call.
The system default message of “I’m sorry, but | was unable to
locate the person you were calling”.

This allows you to specify a particular Music On Hold playlist to play to
the caller during the search process. The system default Music on
Hold (set at PBX Setup=»Music on Hold) will play when this parameter
is set to system default.

If selected (checked), the Follow Me feature will try to either
simultaneously or in sequence of priority to try and locate you by using
this call list.

Table 23 — Extensions Follow Me Settings and Descriptions

Add/Edit Follow Me Settings

The following outlines the steps to set calling permissions for extensions.
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D STEPS:

1 From the Edit Extensions page, locate the extension that you want to update. Click the

(edit extensions) icon to the right of the name.

vanced
2 The Extension Detail page appears. Select the link to open the Advanced

Settings page.

3 Click on the Numbers and Settings button under the Follow-Me section of the
Advanced page.

4 The Administrator View — Follow-Me Settings/Extensions window appears.
5 Make the necessary changes in the Follow-Me parameters. Click on the SAVE button to
save the changes to the Follow-Me settings. A message confirming the changes will

appear.

6 Click the EXIT button to close the window.

Save Changes

7 Click
Extensions page.

button to save the changes. The system returns you to the Edit

8 Click the Apply Changes link located at the right hand corner of the top of the page, to
commit the changes to the database.

Provisioning - Auto-Discovery Tab

This network discovery tool will automatically detect new devices that have been added to the network. This
feature helps identify phones and other devices connected to the network and allow you to configure networked
phones. The IP PBX system provides you with the option to either scan the network, or if a scan has been done
recently, you could select No Scan to save time.

Add f Import Views || Search | Auto-Discovery || Departments

@ @

Auto-Discovery Auto-Discovery

{scan network} {don't scan network)

Figure 39 — Extensions Auto-Discovery Tab

Start Auto-Discovery Scan
This section describes how to start the Auto-Discovery scan for active devices on the network.

D sTEPS:

1 From the Destination=»Extensions page, click the Auto-Discovery Tab.

2 Select to either Scan or Not Scan the network and an Alert message indicating that the
system is scanning the network for active devices appears.

3 Once the scanning process is complete, the system will display a list of active devices
and assigned values such as IP Address, Device Type, Status, etc. Devices that appear
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on this list may be selected for editing. By default, the PBX will only display IPitomy and
Aastra devices. Filter options can be modified to change display other devices.

-z@‘: If you click the refresh-view more than once within a short time period, the network is
not rescanning. The minimum time period allowed between scans is indicated under
the Advanced Settings (Min Refresh Interval).

The network is only scanned for new information when you click REFRESH. Both
REFRESH and FILTER ONLY apply whatever filters you have chosen to the
displayed list.

List of Devices & Extensions

The list of discovered network devices comes from two sources:
e Network
e PBX Database

‘ [ Assigned Device Status MAC Address IP

O IPitormy Onling
O IPitomy IPR20 Online
|| Extension: 2203 v

0OCOOZ0FF3ICE 152.168.2.104

O0CO0Z2BAAZC 1592168278

| | Extension: 2208 v

u

u

O IPitomy 550

O IPitomy 550 Online
u

EAECAEAE] © | ©

00CO02207 CFF

00CO02207038 152.168.2.160

| Extension: 2228+
| | Extension: 2218
[ | Extension: 3007 | IPitomy 550

SIS © | ©

00CO0Z2E1321

®

Color Legend

Using Local PEX Mat Using Local PEX
Asgsighed -
Mot Assigned -=

Figure 40 — Auto-Discovery Device Color Legend
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The following table describes the status of devices that will appear once an Auto-Discovery scan is completed.

Sections/ Fields Description

This field indicates that extension that is assigned to the device (phones). Clicking
Assigned on the box to the left of this field allows you to select it for editing.

The Device column lists info about the device. Database info is preferred, so if a
device is set to a certain phone type in the database, this is listed instead of the

Device actual device type.
This is the status of the device. If the status field is blank, this indicates that the
device was not found on the network.
Status NOTE: Phones that are in the process of restarting, turned-off, or operating on a different
network during a network scan will not be in an “Online” status.
Hovering the mouse over this icon will provide device information. See Figure 43 for
@ an example of the data that can be viewed.
This is the MAC Address assigned to the device.
MAC Address
This is the IP Address assigned to the device.
IP Address

Table 24 — Auto-Discovery Scan Details

Device Information

B
To view detail information for a specific device, hover your cursor over the information ** icon to obtain details
about the network device or phone. This can be an important source of information about which phones are
available for live configuration.

Aastra 551 at 192.168.2.113

Name Value
Firmware 221325
TFTP Server 192.168.2.5
Alternate TFTFP Server 192.168.2.5
Lze Alternate TFTP [ves]

Servers Allowed to Push XML 192 168.2.5

** Mot assigned in PBX database
** Mot configured for this PBX

Figure 41 — Auto- Discovery Device Values
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Edit Selected Tab

The IP PBX system offers many ways to configure devices. This section describes an optional method using the
Auto-Discovery feature.

R T T Begibng [T T

CHeuins Bizigm Wi gy Wi i & Deefaiil

| Amaignied [ewaie Lasl B Saals HAC Belshegs  Las! Bmaoss P
Exturcbon: 2204 = il B bd

] | Mo w o ra 57 i 7

] | Mo w % i i S5 i 7

Figure 42 — Auto-Discovery Edit Selected Functions

The following table describes the fields and functions available on the Edit Selected Tab of the Auto-Discovery
page:

Fields Description Commands
Phone?
Create new extensions for selected phones. You can upload NO
Create extension details in a file or manually enter information.
) Assign existing extensions to selected phones. NO
Assign
Removes the configuration file for the phone and all association NO
Unassign between the extension and the phone.
, Same as Unassign but also sends a Factory Default instruction to YES
Unassign & the phone.
Default
Table 25 — Auto-Discovery Edit Selected Tab Functions and Descriptions
Create, Assign and Configure Phone
The following outlines steps to create, assign and configure a device.
IMPORTANT: This assumes that the phones are in a FACTORY
DEFAULTED state.
IPitomy recommends using the CSV upload file and the IP550
phone type which will help to simplify the setup and auto
configuration process.
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>STEPS:
1 From the Extensions=>»Destinations=>» Auto-Discovery page, click the Edit Selected
tab.

2 Place a check mark next to the phones you wish to use when creating the extensions

3 Click the Create button.

4 Enter the new extension information. The MAC addresses of the selected phones will be
populated so you have a reference as to what phones you are creating the extensions
for.

5 Click the “Create” button. If successful, Click “Return to Extensions”

6 Click the Apply Changes link located at the right hand corner of the top of the page, to
commit the changes to the database.

7 Click the “Auto-Discovery” button and you will note the newly created extensions are
now assigned to the phones that were checked.

8 Check the boxes next to the phones that you just created extensions for.

9 Click the Commands Tab.

10 Click on the Configure & Restart button to provision the phones.

View Settings Tab

Filtering does not change how the network scanning is performed. It only limits the list of items displayed. This
means that if you only want to change filters it is not necessary to re-scan the network. All of the network
information from the last network scan is retained and used by filters.

Edit Selected | View Settings Commands

Select: Auto - Discovery:

All Mone Invert Refresh Filter Only

Advanced Filter Settings
Advanced Scan Settings

Figure 43 — Auto-Discovery View Settings Page
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Sections/Fields Description Commands
Phone
Check or uncheck multiple checkboxes with the click of a NO
Select All,
button.
None, Invert
Scan the network for devices. Scanning is done using the NO
settings in Advanced Scan Settings. The scan results
Refresh displayed depend on the active filters,controlled via
Advanced Filter Settings.
Displays results of the last network scan after applying the NO
Filter Only filters set in Advanced Filter Settings.

Table 26 — Auto-Discovery Functions and Descriptions

Advanced Filter Settings

Advanced Filter Settings
Sart Order |MAC @

Hide: © Mone O Assigned O Unassigned O Online
Filter Patterns

IP:

WAL

Show These Types Only:
Mone i

Afcom w

Figure 44 — Auto-Discovery Advanced Filter Settings

Sections/Fields Description
This allows you to set what order items are listed. Hover your cursor over
Sort Order the help icon next to the Sort Order fields for options.
. Allows you to hide different status types from view.
Hide

Allows you to either enter a partial MAC or IP here. The only system
criterion is that the pattern must match from the first character onward. i.e.
“000D” would match “000DE” but not “AO00DE”.

Full Regular Expression Matching is supported when you enclose your
search pattern in double quotes. Some Examples are:

e Pattern 1.2.3 =*M\.2\.3

e Pattern “1\.2\.3.*” = 1\.2\.3.*
You can select multiple device types to filter by. Auto-Discovery is aware of
MAC address ranges used by many popular networked devices. Although
this is not the only way Auto-Discovery identifies devices, this allows the

tool to identify and filter devices by type.
Filter by Type .

Filter Patterns

/@; Only IPitomy devices and Aastra phones are shown by default
because they are set in the Filter by Type.
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Table 27 — Advanced Filter Settings and Descriptions

Advanced Scan Settings

Changes to Scan Settings are kept when you click the GUI ‘Refresh’ button. Clicking on your browser’s
refresh button will discard changes. For the most part these settings can remain unchanged and all will

function as needed.

Advanced Scan Settings:

Win Hefrash Interal |5
Waximurn Wait |3
Packet Count |1

T Interval (0.8

Batch Size |255

Metwork |192.168.1.x Range

Frorm |1 To |255

Send Wakeup Ping before survey Ping if last ping was more than [180 seconds ago.

Phone Web Interface:
Port 80 Ping Wait (2
Cormrand Wait |5

Uszer
Password

Factory Default Wait |50

Reset

Figure 45 — Auto-Discovery Advanced Scan Settings Page

Sections/Fields

Min Refresh Interval

Maximum wait

Description

Minimum number of seconds required between fresh network scans. If
you attempt to scan the network more often than this you only get
results stored from a previous scan.

Maximum number of seconds to wait for all packets to return.

Number of packets to send

Packet Count

Transmission interval between packets. Only meaningful when Packet
TX Interval Count is greater than 1. Minimum allowed value is 0.2

Divide scanning range into batch jobs. Jobs are run sequentially. Each

) job will have at most <Batch Size> pings running in parallel at a time.

Batch Size The special value 255 means run all pings as one big job.

Network address with last octet reserved for From and To range.
Network Example: 192.168.1.x

Start number for last octet of network address.
From
To End number for last octet of network address.
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Send Wakeup ping Some devices are slow to respond to the first ping they receive but
before Survey Ping have faster response times afterwards.
if...

Maximum seconds to wait for basic phone web interface to signal that
Port 80 Ping Wait it is alive. Rarely used.

. Maximum seconds to wait for most commands.
Command Wait

Phone’s Web User Name & Password may have to be specified if the
phone is not using factory default settings for these items. When these

User and Password  {ig|4g are blank Auto-Discovery uses default settings.

Maximum seconds to wait for the phone to signal completion of a
Factory Default Wait ~Factory Default.

The ‘Reset’ button will return all Scan Settings to original default
Reset values.

Table 28 — Auto-Discovery Advanced Scan Settings and Descriptions

Commands Tab

The IP PBX system offers many ways to configure devices. This section describes an optional method using the
use Auto-Discovery feature.

Edit Selected || View Settings | Commands

Factory Default Restart Configure & Restart Assign, Configure & Restart

Advanced Settings

Figure 46 — Auto-Discovery Command Functions Page

Sections/ Fields Description Commands
Phone?
Sends a Factory Default and restarts the phone. YES
Factory Default
Sends a Restart instruction to the phone. YES
Restart
Instructs phone to set TFTP server to the Server IP specified YES
Configure & Restart under Advanced Settings. Then the phone is commanded to
restart, which will result in pulling down configuration files and
firmware files if there are updated ones present.
. . Combines the functions of the Assign button with the Configure & YES
Assign, Configure & Regiart putton.
Restart
Table 29 — Auto-Discovery Command Settings and Descriptions
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Factory Default Phone

D STEPS:

1 From the Extensions=>»Destinations page, click the Auto-Discovery Tab.
2 Click the “Auto-Discovery” button, choosing to scan or not scan the network as needed.
3 Click (placing a checkmark) on the boxes next to phones you wish to default.

4 From the Auto-Discovery page, click on the Command tab. Click the “Factory Default”
button. Wait long enough for the phones to default and restart. This could be anywhere
from 30 seconds to 2 minutes for each phone, depending on the model. The phones will
set themselves back to factory default and reboot during this period.

Troubleshooting Network Scanning Problems

Scan settings have been configured to work in a standard one subnet network environment. More
complicated environments may require further tuning. The most useful setting is ‘Maximum wait’.
However noisy environments will require increasing the packet Count and TX interval.

>STEPS:
To tune scanning for your network:

1 From the Extensions=>»Destination=> Auto-Discovery page, click on Advanced Scan
Settings link.

2 Increase the ‘Maximum Wait’ setting by a few seconds.

3 Click the GUI ‘Refresh’ button.

-z@‘: More specific tuning will require knowledge of your network and diagnostic tools like
Ping.

Phones that are in the process of restarting, turned-off, or operating on a different
network during a network scan will not be in an “Online” status.

2011 Copyright © IPitomy Communication, LLC 79 v4.0.1
www.ipitomy.com



IPiTomy

IPitomy IP PBX Admin Guide SMARTER BUSINESS COMMUNICATIONS

Auto Provisioning Phone Settings from Actual Device

The remainder of the configuration is done via the Phone interface, and will only work with IPitomy
phones.

D sTEPS:

1 Create an extension, setting the Device to either IP550 or IP120, depending on what
IPitomy phone you intend to register to the extension.

IMPORTANT: To configure the phone using the auto provisioning,
A make sure that the “Auto-Provisioning” parameter is RUNNING. This

can be done in PBX Setup=>»General option of the system.

2 From your phone, select the Menu button to start Auto-Provisioning then select Option 7:
SIP Settings (you can do this without using the scroll keys by just pressing Menu then 7).

3 It will prompt you for the Admin password. Enter the default password “1234” then press
the Enter softkey (IP550) or the OK button (IP120)

4 Select Option 8: Auto Prov.
5 Select “YES” when the Autosearch PBX prompt appears.
6 Enter either the extension number of the extension that has been created.

7 Press the Done softkey (IP550) or the OK button (IP120) and the phone will run through
the process of downloading its configuration file, updated firmware file, etc.

Edit Phone Settings

The settings for each individual device (phone) can be configured in the IP PBX system. The following outlines
the steps to modify the phone settings from the IP PBX system.

View Phone Settings
Esnaimiaing
14 Rains Edit PEX Lattmp iatata &I
] My Byt Sislg g
i
i
@
@
@
Figure 47 — Extension Listing
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Edit Phone Settings
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Figure 48 — Edit Phone Settings Page

Sections/ Fields Description

Many phone models have multiple areas where you can set keys. The TOP

Settings for Top Section g tion typically refers to the keys around the LCD screen, or Soft keys.
of the Phone Setting

Many phone models have multiple areas where you can set keys. The

Settings for Bottom BOTTOM section typically refers to the Programmable keys. See Appendix
Section of the Phone 1 for details on key types.

Setting
Key type determines what function a key performs. A dropdown list shows
Type which key types are available to the phone model you are working with.
This is the label associated with this key. If configured for a key around the
Label LCD screen, this is what will display.

The value completes a key’s function. It may contain a number to dial
special codes or allow you to select an extension from a dropdown list. Most
key types do not require you to enter a value. For example, the Voicemail

Value key does not require a value because the System Administrator determines
it for the end user.
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Only necessary when configuring Soft Keys around the LCD screen. When
checked, the key in question will display when the phone is in the states
defined:

Key State Idle — No current call activity
Connected — A call is connected
Outgoing — A call is being placed from the extension
Incoming — A call is ringing the extension
Table 30 — Edit Phone Settings and Descriptions

D sTEPS:

1 From the Extensions=>»Destination page, find the extension you want to edit.

L T
2 Click onthe “¥ icon to the right of the extensions name. The Edit Phone Settings
page appears.

3 Make the necessary changes to the settings for the phone the click the Save & Restart
Phone button.

4 The PBX will update the configuration file and reboot the phone so that it can download
the updated information for the keys.
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Edit Advance Phone Settings

The advanced settings page varies by the type of phone you are configuring. The following outlines the advance
parameters for IPitomy phones, as well as Aastra phones.

Edit Advance Phone Settings — IPitomy Phones

Advanced Settings

Custom Sip Settings

Metwark

Server
Time Settings
Metwark

Time Server:

Time Zone:
Volume Controls

Microphone Mute

Auto-Answer Incoming Intercom
Warn on Incoming Intercom
Call Waiting Tone

Stutter Tone

Handset Gain Level

Headset Gain Level
Other Options

Digit Timeout

Backlight

Backlight Time

Display Call Waiting
Display Missed Calls
Disable Phone Forwarding
Display Softkey Dots

Table 31 — Edit Advanced Phone Settings — IPitomy Phones

WAN (remote) -

72.64129.45

Custom -~
us.ntp.org

LUS/Eastern

O &&= O

I Y
[ I o]

10
=]
=]
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Sections/ Fields

Network

Server

Network

Time Server

Time Zone

Microphone Mute

Auto-Answer
Incoming Intercom

Warn on Incoming
Intercom

Call Waiting Tone

Stutter Tone

Handset Gain Level

Headset Gain Level

Description
Custom SIP Settings

This defines whether the phone is communicating to the PBX over the
LAN, WAN, or a Custom server address.

LAN — Tells the phone to communicate to the local IP of the PBX

WAN - Tell the phone to communicate to the public IP of the PBX, as
entered under PBX Setup=>SIP

Custom — Tells the phone to communicate to the PBX via an IP you enter
manually

Displays the IP of the PBX as configured from the previous setting. If
Network is set to Custom, this is where you would manually set the IP.

Time Settings
Defines where the phone will get its time settings from.
PBX — Sets the PBX local IP as the time server for the phone
Custom - Allows you to manually enter a time server for the phone.

Displays the address the phone is using for its time server. When set to
Custom this field allows you to manually enter the time server address.

Allows you to set the time zone the phone will use.
System — the phone follows the PBX time zone settings

Custom - Select from the dropdown of a number of time zone settings,
allowing the phone to display a different time then the PBX would

Volume Controls

Default N; The IP550 phone will answer a page call and automatically
engage Mute when this option is selected.

Default Y; If enabled, this will automatically answer incoming pages via
speakerphone. If the user is on a call, the page will ring the extension
instead.

Default Y; If enabled the phone will play a tone alerting the user that their
phone has answered a page with the speakerphone.

Default Y; If enabled the phone will play a tone while the extension is busy
on a call alerting the user that another call is waiting.

Default N; Stutter Dial Tone is provided to alert a user that messages are
waiting. It is presented to the user at the time the handset is taken off-hook
or speakerphone button pressed from an idle state.

Default 10; Gain can be loosely defined as volume. This setting allows the
programmer to adjust the gain to the user’s handset. DREW what is the
range?

Default 10; Gain can be loosely defined as volume. This setting allows the
programmer to adjust the gain to the user’s headset. DREW what is the
range?
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Digit Timeout

Backlight

Backlight Time

Display Call Waiting

Display Missed Calls

Disable Phone
Forwarding

Display Softkey Dots

Other Options

Default 4; This is a counter that determines how long the telephone will
wait between digits dialed before sending digits dialed by the user to the
PBX. The shorter the time the faster the call will be placed, BUT short
times mean that a user has to enter all digits without delaying more than
this time period or the call will be routed with fewer than required digits and
may not route properly.

Default N; This is the backlight of the LCD display. Setting this option to
yes will force the LCD backlight to remain ON at all times.

Default 10; When the Backlight option above is set to “N” (default) this
timer determines how long the backlight will remain ON following the last
activity.

Default Y; The IP550 has the ability to display cal waiting information on
the display of a busy extension. If this is desired set this to Yes.

Default Y; The IP550 telephone has the ability to display the number of
calls that rang but were not answered. If desired, select Yes.

Default N; This option is provided to disable telephone (phone-based) Call
Forward. This is often desired since the user may invoke a mode of Call
Forwarding not desired and conflicting with call forward conditions
implemented in PBX programming.

This is also beneficial in hospitality applications when a telephone is
installed in a location where the user should not be given the ability to use
cal forward.

Default N; The IP550 has been enhanced to provide an alignment “Dot” at
the edge of the display for each of the Softkey function prompts. For users
that find it difficult to associate Softkey prompts to Softkeys, enable this
option.

Table 32 — Edit Advanced Phone Settings for IPitomy Phones

D sTEPS:

1 From the Extensions=>»Destination page, find the extension you want to edit.

T

2 Click onthe “¥ icon to the right of the extensions name. The Edit Phone Settings
page appears.

3 Click the Advanced Settings link at the bottom of the page.

4 Make the necessary changes to the settings for the phone the click the Save & Restart
Phone button. This will update the configuration file and when the phone reboots, it will
download the new information.
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Edit Advance Phone Settings — Aastra Phones

Display

Caller's List

Custom Sip Settings
Metwork

Servar

Time Settings

Metwork

Time Server:

Time Zone:

Volume Controls
Headzet Transmit Gain
Headset Side Tone Gain
Handset Transmit Gain
Handset Side Tone Gain
Handsiree Transmit Gain
Microphone Mute

Allow Intercom Barge In
Switch Ul Focus to Ringing Line

Aastra Expansion Modules

Module Type

Enabled

LAM (Local) v
192.168.1.249

=
192.168.1.249
LS-Eastern v

5w
-10
5w
-0

EE
g
g
O

Wiarning: Changing Module Type will delete existing module key seftings

MNone

Figure 49 — Aastra Advanced Phone Settings Page

Sections/ Fields

Description

Display Section

If Enabled, the Missed/Dialed/Answered calls on Aastra phones will

Caller's List

display.

Custom Sip Settings

This defines whether the phone is communicating to the PBX over the
LAN, WAN, or a Custom server address.

LAN - Tells the phone to communicate to the local IP of the PBX

Network

entered under PBX Setup=>SIP

Custom — Tells the phone to communicate to the PBX via an IP you enter
manually

WAN - Tell the phone to communicate to the public IP of the PBX, as

Displays the IP of the PBX as configured from the previous setting. If

Server

Defines where the phone will get its time settings from.

Time Settings

Network is set to Custom, this is where you would manually set the IP.

PBX — Sets the PBX local IP as the time server for the phone

Network

Custom - Allows you to manually enter a time server for the phone.

Displays the address the phone is using for its time server. When set to

Time Server
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Time Zone

Headset Transmit
Gain

Headset Side Tone
Gain

Handset Transmit
Gain

Handset Side Tone
Gain

Microphone Mute

Allow Intercom
Barge In

Switch Ul Focus to
Ringing Line

Module Type

Allows you to set the time zone the phone will use.
System — the phone follows the PBX time zone settings

Custom - Select from the dropdown of a number of time zone settings,
allowing the phone to display a different time then the PBX would

Volume Controls

Applies to Aastra Only - This allows you to set the gain on the
transmission of calls made using a headset.

Applies to Aastra Only - This allows you to set the gain on for the headset
side tone.

Applies to Aastra Only - This allows you to set the gain on the
transmission of calls made using the handset.

Applies to Aastra Only - This allows you to set the gain on the handset
side tone.

This defines if the phone will answer a page in a muted state.

Applies to Aastra Only - If enabled, this allows a page to place your
current active call on hold, and answers the page with the speaker phone.

Applies to Aastra Only - Aastra phones switch the Ul Focus to the line
ringing in.

Aastra Expansion Modules

This allows you to change the type of module for the phone.

‘:: IMPORTANT: Changing this parameter will delete the
existing module key settings.

Table 33 — Aastra Advanced Phone Settings and Descriptions

D sTEPS:

1 From the Extensions=>»Destination page, find the extension you want to edit.

T

2 Click onthe “¥ icon to the right of the extensions name. The Edit Phone Settings
page appears.

3 Click on the Advanced Settings link. The Advanced Settings page for the phone

appears.

4 Make the necessary changes to the settings for the phone the click the Save & Restart
Phone button. This will update the configuration file and when the phone reboots, it will
download the new information.
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Groups

A Group is a logical grouping of extensions and their privileges. Each Group is associated with a set of PBX
features and call routing strategies. It is advised to build the extensions in the PBX first, allowing the groups to be
populated at the time of creation.

These Groups allow incoming calls to be distributed to a group of extensions rather than just one extension.
Within the Groups, different distribution strategies may be selected based on the call coverage required by the
application. Groups also provide off-hook paging functionality. By dialing the intercom button or code followed by
the group number, extensions in the group will receive the page over the intercom. Groups are a set of extensions
that are related either because they:

e Serve a similar business function.
e  Work within the same department.
e Are located in proximity to each other.

For example, a business might create a few user Groups in an IP telephony network, e.g. Sales, Marketing,
Administration, Accounting, Engineering, etc. Groups may also be created for people in similar locations like a
plant floor, the north section of a building or the front office. The goal of a group is to ring telephones based on the
incoming routing logic (e.g. DIDs, Auto Attendant selected by the incoming caller, or time of day). Note that calls
routing to an extension from a ring group will ignore that phones PBX forwarding settings. Some phones have
forwarding settings which are independent of the PBX (not set through the PBX Web GUI). These settings will still
be applied.

Add Group Live Queue Data

Name Number Ring Strateqy Actions

Ring All 1000 leastrecent T ®
Sales 1010 rrmemary T ®
Live Answer 5005 tingyall T ®
Support 4433 rrmemary T ®
Test 7979 ringall T ®
testss £456 tingall T ®

Multicast Paging Groups

Add Group
Name Number Multicast Address Port Actions
Sales Paging 411 22555 1234 ~ ®
Figure 50 — Ring Groups Page
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Ring Group Examples

Ring groups define a set of extensions (people) that answer calls. Ring groups can be created for departments
(e.g. Sales, Engineering) or buisiness regions (e.g. north, south, etc), or areas of a business (e.g. a warehouse or
plant floor). These ring groups can appear on an Automated Attendant (menu). When the group is selected from
a Menu, the call is routed to the group. These calls will be distributed to the member extensions based upon the
ring strategy for the group. The ring strategy for the group can be set from the drop-down list. Available call
distribution options are:

Ring All — Ring all extensions in the group simultaneously

Round Robin — Take turns ringing each extension, starts at the first extension for each new call
Round Robin (with memory) — Take turns ringing each extension, starts where the last call left off
Least Recent — Ring extensions in order of which was least recently called by the queue

Fewest Calls — Ring extension in order of which has the fewest completed calls from the queue
Random — Randomly ring one extension at a time

Example Ring Group 1 - Departmental Grouping

Ring group definitions can be found in the Add a New Ring Group section of this guide. If a business has the
following departments and people: This business can setup the following ring groups supporting business

operations.

Cathy Caldwell 123 Gretchen Goodall 134
David Dawson 124 Peter Polk 135
Susan Smith 125
Robert Reed 126

Using this ring group scenario the Menu would look like:

e Sales (Destination - Group 1).
e Customer Service (Destination - Group 2).
o Office Manager (Destination - Ext. 113).
The menu prompt (message) for this menu and group arrangement would read as follows:

“Thank you for calling CompanyA, a leading manufacturer of cable assemblies and wiring harnesses. If
you know the extension of the party you would like to reach you may dial it at any time.”

e For Sales, press 1.
e For Customer Service, press 2.
e For Accounting, press 3.

Once a call is sent to Sales, member extension will be rang according to the ring group strategy.

Example Ring Group 2 — Regional Sales Grouping
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Cathy Caldwell 123

Susan Smith

125

Gretchen Goodall

134

David Dawson 124

Robert Reed

126

Peter Polk

135

Using this ring group scenario the Menu would look like:

East Coast Sales (Destination - Group 1).
West Coast Sales (Destination - Group 2).
Customer Service (Destination - Group 3).
Office Manager (Destination - Ext. 113).

The menu prompt for this menu and group arrangement would read as follows:

“Thank you for calling CompanyA, a leading manufacturer of cable assemblies and wiring harnesses. If

you know the extension of the party you would like to reach you may dial it at any time. For”

East Coast Sales, press 1.

Accounting, press 4.

Calls sent to these groups might use different ring strategies. The East Coast Sales group might answer calls

West Coast Sales, press 2.
Customer Service, press 3.

Round Robin, distributing the calls to each Sale Representative consecutively. If a sales person is missing from

the West Coast team this group might set phones to Ring All in the group so that calls don’t get missed. The

Customer Service team may get high volumes of calls during a specified period of time, so this group may be set

to ring Least Recent.

Add/Edit New Ring Group
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Destinations / Groups / Edit Ring Group Logout | Apply Changes
Edit Ring Group
» System
T Edit Ring Group
 Destinations Mame:
Extensions - .
Groups Group Mumber (to dial group):
M : !
CDEI'II-'IFLBI?'EI'ICES Allow Paging with **+ Group Mumber:
Woicemail
Schedules Ring Strategy: ringall E
Branch Offices
Failover Destination: Schedules E Schedule: SuppnrtFaiIuverE
» Call Routing
» PEX Setup Timeout: 1200
» Reporting Allow Recording yes =]
Agent Ring Time 120
Autofill yes =]
Ringin use yes |Z|

Figure 51 — Edit Ring Group Page

The following table describes the parameters (fields) on the Edit Ring Group page and their descriptions and
recommended settings.

Sections/Fields Description
The name associated with this ring group.
Name
Group Number (to dial The number dialed to access this ring group. Must be 3 or 4 digits.
group)
Allow Paging with If enabled (checked), this will allow **+ group number to page this ring group

*+Group Number
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Ring Strategy

Failover Destination

Timeout

Allow Recording

Agent Ring Time

Autofill

Ring In use

This defines how calls are distributed to member extensions. Options are:
Ring All — Ring all extensions in the group simultaneously

Round Robin — Ring extensions consecutively. Delivers a new call to the
first person in the group only after the last person in the group has taken a
call. If an extension is busy the call will automatically be routed to the next
extension in the group.

Round Robin (with memory) — Ring extensions consecutively. Delivers a
new call to the first person in the group only after the last person in the group
has taken a call. Remembers where the last call was taken and distributes
new calls to the next extension in the rotation.

Least Recent — Ring extensions in order of which was least recently called
by the queue.

Fewest Calls — Ring extension in order of which has the fewest completed
calls from the queue

Random — Distributes calls randomly to the group.

This defines where a call will be sent when it goes unanswered for a duration
that matches the Timeout for the group.

Defines, in seconds, the total time a call will spend in the ring group before
being sent to the Failover Destination

Determines if feature code recording is allowed for calls in this queue.
If YES = enables the recording feature.
If NO = disables the recording feature.

Defines, in seconds, how long the queue will ring a particular agent. If using
the Ring All strategy, this value should match the Timeout. For other
strategies, this should be set to how long an extension should ring before
moving on to the next.

This deals with how the queue handles multiple concurrent calls. If set to
NO the queue will wait until the first call is answered before ringing phones
with the second call. If set to YES the queue will ring phones for all calls as
they come in.

If YES = Distribute calls to group members if they are already on a call

If NO = Do NOT distribute calls to group members if they are already on a
call

Table 34 — Edit Ring Group Settings and Descriptions

The following outlines the steps to add/edit ring group settings.

D sTEPS:

1 From the Destinations=>»Group page, click the ADD Group button. The Edit Ring
Group page appears.

2 In the Name field, enter a name for the group.

3 Inthe Group Number field, enter a number for the group. This number must be three or
four digits in length.

4 Check the Allow Paging with **+ the Group Number to enable the setting.
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5

6

10

11

12

13

14

15

16

17

18

Select the desired Ring Strategy from the drop-down list.

Select the desired Failover Destination from the list of available options.

Enter the time for the Timeout parameter.

Select “Yes” if you want to enable the Allow Recording setting. Otherwise, set it to “No”.
Enter the time for the Agent Ring Time parameter.

Select “Yes” if you want to enable the Autofill setting. Otherwise, set it to “No”

Select “Yes” if you want to enable the Ring in use setting. Otherwise, set it to “No”

Click the Save Changes

button.
From the Members section of the Edit Ring Group page, select the extension number
from the list of extensions that you want to add to the ring group. Click the ADD button.

A second list appears next to the Members list displaying the selected extension. Repeat
step 13 until all extensions that you want to add are on the list. Additionally, Shift or
Control click functionality works for adding multiple extensions at once.

To remove an item from the list of additions, select the extension number then click the
REMOVE button.

Define Priorities for the extensions, if needed. The scale ranges 0 thru 9 (0 is the highest
priority).

. 5 Ch
Click | M€ =B | ton to save the changes.

Click the Apply Changes link located at the top right hand corner of the page, to commit
the changes to the database.
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Ring Group Advanced Settings

Advanced Ring Group Settings
Caller Ring Settings Beethoven |Z|

Ring Tone System Default |Z|

Custom Caller ID

Use System Default |Z|
Mame Prepend
Mumber Prepend

Figure 52 — Advanced Ring Group and Custom Caller ID Settings Section

The following table describes the parameters (fields) on the Advanced Settings for Ring Groups page and their
descriptions and recommended settings.

Sections/Fields Description
Advanced Ring Group Settings

Defines what a caller will hear while they are waiting for someone to pick up a call from
the call group. Callers can either hear:

Ringing — The phone continues to ring while the caller is waiting.

Caller Ring
Settings Music on Hold — The caller hears music while waiting for a group member to pick up
the call. The dropdown list displays the MOH playlists that are on the PBX. Select a
playlist and it will play the sound files found in the playlist.
. . OBSOLETE - and will be removed in a future release.
Queue Dial String
. When Caller Ring Settings are set to Ringing, use this to define the ring cadence.
Ring Tone
Custom Caller ID Settings
Defines what method, if any, you wish to use to override Inbound CID. The options are:
Use System Default, Name, Number, Name and Number
Name This is the name of the caller that will be displayed when a call is received.
This is the number of the caller that will be displayed when a call is received.
Number
Selecting Prepend will enter the text you put in the field, followed by the original CID. If
Prepend not prepending, the override eliminates the original information.

Table 35 — Advanced Ring Group and Custom Caller ID Settings and Descriptions
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Edit Advanced Ring Group Settings

P STEPS:
1 Select Destinations=»Groups. The Ring Groups page appears.

2 Select the Ring Group you want to edit by either select the icon to the right of the
group name or click on the blue Group Name link.

3 The Edit Ring Group page appears. Scroll down the page and click on the Advanced
link. The Advanced Ring Group Settings section is displayed.

Save Ch
4 Make the necessary changes to the settings then click ave ShANESE | putton to save

the changes.

5 Click the Apply Changes link located at the top right hand corner of the page, to commit
the changes to the database.

Edit Custom Caller ID Settings

P STEPS:
1 Select Destinations=»Groups. The Ring Groups page appears.

2 Select the Ring Group you want to edit by either select the icon to the right of the
group name or click on the blue Group Name link.

3 The Edit Ring Group page appears. Scroll down the page and click on the Advanced
link. The Custom Caller ID section is displayed.

5 Ch
4 Make the necessary changes to the settings then click ave TAEEE | button to save

the changes.

5 Click the Apply Changes link located at the top right hand corner of the page, to commit
the changes to the database.
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Edit Members/Agents

bembers: |Extension: 1006 # || Extension: 2227
Extension: 1010 Extension: 2221
Extension: 106 Extension: 2228
Extension: 107
Eﬁgg:gg :II'IDE Priarity: Add Remove
Extension: 119
Extension: 122
Extension: 1234
Extension: 125«

Agents: | Agent Drews Agent -
Agent. Joes Agent
Agent: Mike Roaming
Agent Wolfey Roaming
Agent: Dans Agent o
Agent: John Walfes Agent Priority: Add || Remove
Agent: Testagent
Agent: Chris Beawvers
Agent. EJ Donawan
Agent: Elaine Blodgett v

Figure 53 — Edit Members/Agents Section

Sections/Fields Description
This is the list of available extensions that are in the database.
Members
This is the list of available agents that are in the database.
Agents
This field allows you to set the priority level for the members or agents. The lower
Priority the number, the higher the priority.
This button will add the select item on the list to the right of the available members
or agents. Shift and Control click functionality works for adding more than one at a
ADD time.
This button will remove the item(s) that have been selected from the list of
available members or agents. Shift and Control click functionality works for adding
REMOVE more than one at a time.
Table 36 — Edit Members/Agents Settings and Descriptions
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Add Agents/Members to the Group

D sTEPS:
1

2

Navigate to the Destinations=»Groups=»Edit Group page.
Select from the left hand column which agents/members to add to the group.

Click the Add button.

. 5 Ch
Click | ™€ =B [ ton to save the changes.

Click the Apply Changes link located at the top right hand corner of the page, to
commit the changes to the database

Delete Agents/Members from the Group

P sTEPS:
1 Navigate to the Destinations=» Groups=>Edit Group page.
2 Select from the right hand column which agents/members to remove from the group.
3 Click the Add button.
4 Click Save Changes button to save the changes.
5 Click the Apply Changes link located at the top right hand corner of the page, to
commit the changes to the database
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Automatic Call Distribution (ACD)

Systems licensed to use ACD will have access to additional functionality pertaining to Ring Groups. ACD allows
for more flexibility and control over the queuing in a Ring Group, as well as allowing the creation of Agents who

can be added to the Ring Group.

ACD Settings - Agents
Agent Retry Timer

Weight

Wrap-up Time

Autopause

Maximum # of people in gqueue
Announce Frequency
Periodic Announce Frequency
Announce Holdtime

Join Empty Queue

Leave Empty Queue

Report Hold Time

Member Delay before connect

Timeout Restart

Semvice Level

Exit Status: FULL Ring Groups
Exit Status: JOINEMPTY Voicemail
Exit Status: LEAVEEMPTY Voicemail
Exit Status: JOINUMAVAIL WVoicemail

Exit Status: LEAVEUNAWVAIL Extensions

no

yes

no

no -

yes -

10

Intro Announcement ‘None
Agent Announcement None
Periodic Announcement None
Exit Menu none
Advanced

Ring Group: Sales -

Voicemail: 5001 -
Voicemail: 5001 ~
Voicemail: 5001 -

Extension: 5001 -

Table 37 — Automatic Call Distribution (Agents) Page
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Sections/Fields

Agent Retry Timer

Weight

Wrap-up Time

Autopause

Maximum # of people
in queue

Announce Frequency

Periodic Announce
Frequency

Announce Holdtime

Join Empty Queue

Leave Empty Queue

Report Hold Time

Description

This defines, in seconds, how long the queue will wait before attempting
to ring an agent again.

The priority of the queue in relation to other queues in the system.

This defines, in seconds, how long the queue will wait after an agent has
ended a call before flagging then as an active agent ready to accept
more calls.

This will place an agent in a pause state in relation to this queue when
they ignore or answer a call. To become an active member of the queue
again unpause using the 1* feature code a phone or 1*+agent# for an
agent.

Defines how many callers can join the queue before it is considered full.

Must be set for Announce Holdtime to function. This pertains to how
often the caller will hear the hold time announcement, in seconds

This defines how much time passes between playing the recording that
was set for this queue under Periodic Announcement.

If set to YES this will announce a caller’s status in the queue with
regards to their expected hold time, pending the hold time is estimated
to be over 1 minute. If the hold time is less than one minute, this will
announce the caller’s position in the queue. A period of time is needed
for the algorithm to ‘learn’ and estimate hold times accurately. This
message will not play for the first caller in the queue. Caller Ring
Settings must be set to a MOH file in order for this message to play.

Controls if a caller can join a queue.

YES = Callers can join the queue with no members or whose members
are busy.

NO = Ignores agent and member status, they can be logged out as long
as they exist in the configuration callers can join a queue.

STRICT = Callers cannot join the queue if there are no members or if
the members are all busy, paused, or logged off.

Controls if a caller will leave an empty queue.

YES = Callers will leave the queue if there are no active members, or all
members are busy. If all agents are logged out, the caller will not leave
the queue.

NO = Callers will not leave the queue even if there are no active
members, or all members are busy.

STRICT = Callers will leave the queue if there are no active members,
but will remain in the queue if all members are busy. If agents are
pause or logged off, the caller will leave the queue.

Set to YES if you want the person answering the queue call to hear a
message indicating how long the call they just answered was in the
queue
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Member Delay before Delay, in seconds, before a member is connected to the queue.
connect
If set to YES the ring group timeout will reset after attempting to ring an
agent/member. When set to NO, time taken to ring an agent/member
Timeout Restart will be subtracted from the ring group time, and when the timer ends the

Service Level

EXxit Status: FULL

group will send the caller to the Failover Destination

Set this to the time, in seconds, that defines the acceptable level of
service for the queue. The Live Queue Data page will track the
percentage of calls answered within the allotted time.

Exit Status:
JOINEMPTY
These are the destinations where calls will go based on the exit strategy
Exit Status: defined. If no one in the group accepts the call this is the destination to
LEAVEEMPTY which the call will be sent. Destinations can be extensions, other ring
groups, a menu or a voicemail box.
Exit Status:
JOINUNAVAIL
Exit Status:
LEAVEUNAVAIL

Intro Announcement

Define what prompt to play to the caller just before they enter the queue.
(Previously “Announce Filename”)

Defines what prompt to play to the agent/member who answers the
queue call. This setting is set per Queue and therefore can be used to

Agent Announcement identify what Queue is being answered (for agents handling calls from
multiple Queues.
Defines what prompt to play to the caller at the Periodic Announce
L frequency interval. This will not play for the caller in the first position of
Periodic the queue. Caller Ring Settings must be set to a MOH file in order for
Announcement this message to play.
Set this to a menu. Key presses while in this group will send people the
Exit Menu corresponding destination from that menu.

Table 38 — Edit Ring Group ACD Agents Settings and Descriptions

Edit Automatic Call Distribution (ACD) Settings

D SsTEPS:

1 From the Destinations=>» Groups=>Edit Group page, scroll to the ACD Settings
section.

2 Make the necessary updates to the ACD settings.

Save Changes

3 Click button to save the changes.
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4 Click the Apply Changes link located at the top right hand corner of the page, to commit
the changes to the database.

Add Automatic Call Distribution (ACD) Agents

P System
¥ Providers

» Destinations

Extensions
Groups

Menus
Conferences
Voicemail
Schedules
Branch Offices

¥ Call Routing
» PEX Setup

» Reporting

|

IPITovy

SMARTER BUSINESS COMMUNICATIONS

Destinations / Groups / Agents Logout | Apply Changes

Name 1] PIN

[C] Paul Agent 12 2233

Save Changes Add Delete Selected

Sections/Fields

Figure 54 — ACD Edit Agents Page

Description

Enter a name that will identify this agent.

Name
Enter a unique 3-4 digit number to identify this agent. This number is used to log
ID infout.
Enter a minimum of 4 digits for the PIN. This is the password used to log in/out
PIN with the agent.
Table 39 — Add/Edit Agent Features and Descriptions
P STEPS:
1 From the Destinations=>» Groups=»Edit Group page, scroll to the ACD Settings
section.
2 Click on the blue Agents link to the right of the words ACD Settings. The Agents page
appears.
3 Click on the ADD button to add a new agent. A box with the name, ID and PIN field
appears. Enter the information for the new agent.
4 Clic Save Changes button to save the changes.
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5 Click the Apply Changes link located at the top right hand corner of the page, to commit
the changes to the database.

Edit Automatic Call Distribution (ACD) Agent

D STEPS:

1 From the Destinations=>» Groups=»Edit Group page, scroll to the ACD Settings
section.

2 Click on the blue Agents link to the right of the words ACD Settings. The Agents page
appears.

3 Update the necessary information for agent(s) then click the SAVE CHANGES button.
The changes that you made will appear in the updated list.

4 Click the Apply Changes link located at the top right hand corner of the page, to commit
the changes to the database

Delete Automatic Call Distribution (ACD) Agent

D SsTEPS:

1 From the Destinations=>» Groups=»Edit Group page, scroll to the ACD Settings
section.

2 Click on the blue Agents link to the right of the words ACD Settings. The Agents page
appears.

3 From the list of existing agents, click on the box (placing a checkmark) to the left of the
Agent(s) that you want to delete. Click the DELETE SELECTED button.

4 The agent selected is removed from the list.

Save Ch
5 Click | 2= "MMEEE [ b tton to save the changes.

6 Click the Apply Changes link located at the top right hand corner of the page, to commit
the changes to the database.
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Multicast Paging Group
A Multicast Paging Group provides a way to page a large number of phones, while keeping the burden on the
network and PBX to a minimum.

NOTE: IPitomy recommends using multicast paging for groups of 10 or more phones that are paged
frequently.

Multicast Paging Groups
Add Group
Name Number Multicast Address Port Actions

MikeTest 4300 22554585 1234 &2 ®
MiketestZ 4301 22554585 1235 & ®

Figure 55 — Multicast Paging Groups Page

Exhl Paaja i (v
Exampie
2300
25656
4545

BTl 11 o] Poengion 1777

Exmraion: 1117 Eienizinn 155

Eoetii e b 1977
E'vigirion- FEED Eskisinn BB

Eetiiea o 155
Evtareion: 2219 hid  Hamsva
E'vta i 555

Etmirea boii: 3B
Exturcibon: 208

Caate

Figure 56 — Edit Page Group Window
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The following table describes the fields (parameters) on the Multicast Edit Paging Group window and the
recommended settings.

Sections/Fields Description

Name

Local Number

Multicast
Address

Multicast Port

Time to Live

Members

Add/Remove

Create/Update

Close Window

This is a name of the multicast paging group.

This is the number that will be dialed to launch the multicast paging to the defined
group. This is the unique 3-4 digit number.

This should be a valid multicast IP for a Multicast Address. We recommend
225.5.5.5. You can use the same IP for each group, so long as you assign them
different ports.

This must be a valid, unused port Multicast Port.
NOTE: This must be a port below 6535.

Time to Live is a counter that decreases by 1 each time a packet passes through a
router. When the counter reaches 0, the packet is considered dead and will not
pass to any other networks. This can be left blank or configured as needed for
your particular install.

NOTE: Leaving it blank the packet will not pass to another network.

The Members section allows you to add the extensions to be paged within the
group when a page is sent.

The Add and Remove button allows you to add or remove members (extensions)
from the paging group.

Depending on the process that is being performed, this button will appear (be
labeled) as either Create or Update. This will create a new member or process the
changes made.

This link will close the Edit Page Group window and return you to the Ring Groups
page.

Table 40 — Multicast Paging Settings and Descriptions

The following section outlines the steps to add a new Multicast Paging Group.

Add Multicast Paging Group

P STEPS:

1 Navigate to the Destinations=>»Group page

2 Locate to the Multicast Paging Groups section (at the bottom of the page).

3 Click on the Add Groups button. The Edit Page Group page appears.

4 Enter the necessary information for the new paging group.

5 From the Members section of the Edit Page Group window, select the members
(extensions) that you want to include in the paging group.
;@‘: Use the CTRL or SHIFT button to select multiple or a range of extensions from

the list.
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6 Click on the ADD button to add the selected members to the group.
7 Click the CREATE button to save the changes. The “Group Created” message appears.
Close the window (click on the “X”). The system returns you to the Ring Groups page.
8 Click the Apply Changes link located at the top right hand corner of the page, to commit
the changes to the database
9 Re-boot the phones that correspond to extensions that were added to the Multicast

Paging Group. Once all the phones have been re-booted, you will be able to utilize this
feature by simply dialing the Local Number that was just created.

Edit Multicast Paging Group

D sTEPS:

1

2

Navigate to the Destinations=>» Group page

Locate the Multicast Paging Groups section (at the bottom of the page).

~

Click on icon to the right of the Name of the paging group you want to update. The
Edit Page Group page appears.

Enter the necessary information for the paging group.

Click the UPDATE button to save the changes. Close the window (click on the “X”). The
system returns you to the Ring Groups page.

Click the Apply Changes link located at the top right hand corner of the page, to commit
the changes to the database

Re-boot the phones for all the extensions that were involved in the Multicast Paging
Group.

Delete Multicast Paging Group

P STEPS:

1 Navigate to the Destinations=>»Group page

2 Locate the Multicast Paging Groups section (at the bottom of the page).

3 Clickon @ icon to the right of the Name of the paging group you want to delete. The
group is removed from the Multicast Paging Group page.

4 Click the Apply Changes link located at the top right hand corner of the page, to commit
the changes to the database

5 Re-boot the phones for all the extensions that were involved in the Multicast Paging
Group which was deleted.
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Live Queue Data

The Live Queue Data page displays current call statistics for ACD queues. The page will refresh every 10
seconds, allowing a manager to monitor the activity in the queue as it happens.

Ring All
Sales
Ring John

Current Queue Stats (updated every 10 seconds):

Support

0

Time in Q | Answered

0 sec
Calls in Q [aleElls[e]il=e!

IEI [ mlinlE] % in Target

600 sec 0.0%

0212211

0

VictorHassa 0 0 [IPitomy Ship 0 0

John'Wolfe 0 0 [PDrews Agent0 0
Mike CellEx0 0 |*Paul Agent 0 0

0

Sections/Fields

<queue selection box>

<queue statistics box>

Figure 57 — Ring Group Live Queue Data

Description

In the queue selection box the Queue or Queues to be displayed can be
selected. Use the Control key (Command on Mac) to select multiple queues
for display.

The Queue Statistics box has been reformatted in SW release 3.4.1 to
allow its use on call center wall boards (large PC displays).

Each queue is encapsulated with a thin-line box. Queue statistics are color-
coded for quick orientation on wall boards. Since this data is presented in
GUI format it can be easily resized to accommodate large displays.

The top line of the queue display presents the Queue Name and the date.

Statistics are a running total and will reset to zero whenever Apply Changes
is clicked (as is the case of the screen capture above).

This is the average time that callers have waited in queue before being

Time in Q answered by a queue member/agent.
. This is the number of calls that are waiting in the queue.
Calls in Q
This is the number of calls answered by members/agent of this queue.
Answered
Abandoned This is the number of calls that have not been answered and the caller
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abandoned the queue.

Displays the service level set for this ACD queue. The Service Level is the
arbitrary time allocated by the queue administrator which is set as a gauge

Target Time by which all calls should be answered.

This is the percentage of answered calls measured against the service
% in Target level. (The percentage of calls being answered within the set Target Time.)

At the right side of the Queue Statistics box the agents and queue
members are listed. There are two maximum columns and the window will
resize to accommodate all members and agents registered to this queue.

Member/Agent status is available at a glance with color-codes as follows:

Red = InUse
= Idle (Logged In)
<Member/Agent field> Yellow = Ringing

Unavailable (Not Logged In)

= Paused

Also in the Member/Agent data are two numeral fields. The first number
represents the Priority of this Member/Agent in this queue. The second
number is the total calls taken by this Member/Agent.

Table 41 — Live Queue Fields and Descriptions

Live Queue Data — Wallboard

Software version 3.4.1 and above allows the use of call center wall boards with Live Call Queue. This
function is facilitated using a special user name and password via Smart Personal Console.

Activate Live Call Queue Wallboard

P sTEPS:
1 Navigate to the PBX Setup=> General page

2 Locate to the General Settings section (second section from the top).

3 Locate the SPC Reports User Password field (bottom of section)
SPC Reports User Password display

4 It may be helpful to change this to a user-friendly password. If you change the password
Save Ch Applv,Chanpes
besureto | o T TEE | gng SRR
5 Make a note of this password.

6 On the PC that will be used for the wallboard display, open a web browser and navigate
to the IPitomy PBX login screen
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7 Using the right side — Smart Personal Console (User Login) input the word “reports” as
the user name and the password saved in step 3.

User Name: | | User Name: |reports |
Password: | | Password: | e i
Login | Login

""a\hk

Login

8 Click on

9 The CDR-Report page is opened. On this page is a button to select Live Queue.

Live Queue

10 Click on

11 The same display presented in PBX Administration is displayed. Simply select the group
or groups that you wish to display on the wallboard.

12 Size this web page data output for the monitor in use by pressing and holding the Cntrl
key (PC, Command key on Mac) and press “+” or “-* until the data is sized as you wish.
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Menus

Menus direct callers to destinations within a business. A menu can route a caller to a destination once a
number on a key-pad has been pressed. The menu prompt tells a caller what number to press to get to a
desired destination. Menus can also be used to provide information to callers like driving directions, etc.

ERMARTEN BUSIHESE CORMBUHICATIONS
* SRl
F Provipers bl
L Fhanmis Mok Saalith Retiaii
Exharmizne b Arird et \ooi I
Genaps Ol AL i oo 1]
e m il b= e I X
Conferences 5 2 i
Vaicemnal
Sehedutes
Eranch Offices
» Call Raiting
¥ 1K Setug
¢ Reporting
Figure 58 — Menus Page
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Edit Menu

Eilil'llenu

Mame: Paul-Test

Menu Mumber (dial to go to menu; 1901

[ . =

Default Menu Promgt: | main-greeting El

Active Menu Prompt: |_Default :l Control Menu Prompts
Copy Christmas EI ® 1o 4 EI @ | submit

Fail aver: | Senices E” Congestion El j

Assign Menu Destinations

Select a destination for a dialed digit:

1: None E”:EI

E:INnne | E”:

E:ENune I:El

4:!Nnne El

5: None E”:B

6 Ring Groups EI|Ring Group: Siesta El\:l
7: Menus E”Menu: FresidentsDay E”I\
8: Conferences E”Ennference: a1 EI

9: Branch Office Extensions El | Extension: 2115 El

0: !Nnne |:E|
*:|Mone EI[E”:

#:!Menus E“Menu: Paul-Test

FAX: Exitensinns E”Extensiﬂn: EDWEl

Figure 59 — Edit Menus Page (with Control Menu Prompts open)
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Sections/Fields Description

Name

Menu Number (dial to go to menu)

Default Menu Prompt

Active Menu Prompt

Control Menu Prompt:
Copy ... To...

Fail Over
Assign Menu Destinations

Menu Destinations

Enter a name for the menu.

This is the number of the menu. This number is used to
access the menu from extensions — if necessary. The number
must be a unique 3 or 4 digit number.

This is the recording that is active for callers who reach this
menu when the Menu Prompt is set to default.

This function is enhanced in version 3.4.1. (Previously “Menu
Prompt”.) As it indicates, this selection determines what
prompt recording is heard by callers who reach this menu.

Record this first under PBX Setup=»Prompts.

The Copy... To... function allows you to place pre-recorded
(and previously uploaded, see: PBX Setup=»Prompts)
prompts into the available Prompts to be associated to this
menu. Available “slots” are 1-5 where the user may then
select 0-5, 0 being the default and 1-5 being those that are
loaded. The user also has the ability to rerecord the prompts
1-5 via DTMF Administration access.

Note: uploaded prompts are “copied” to the menu; therefore
rerecorded prompts do not overwrite the original uploaded
file.

This is the destination that the menu will fail over to if the user
does not press a digit in the allotted Response Time.

This list represents the destinations callers are routed to when
pressing 0-9,*, #, and FAX. If a destination is set for FAX,
the PBX will detect if a call inbound over an Analog or T1/PRI
card is a fax while the prompt is playing, and will route calls to
this destination if fax tone is detected.

Table 42 — Add/Edit Settings and Descriptions

Add Menu Settings

D sTEPS:

1. From the Destinations=»Menus page, click the ADD menu button. The Edit Menu page

appears.

2. Enter the information for the new Menu item and make necessary destination

assignments.

Save Changes

3. Click

button to save the changes.

4. Click the Apply Changes link located at the top right hand corner of the page, to commit
the changes to the database
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Edit Menu Settings
>STEPS:
1 From the Destinations=»Menus page, locate the name of the Menu item you want to

edit.

-

2 Clickon @ icon to the right of the Name of the menu you want to update. The Edit
Menu page appears.
. . Save Changes
3 Make the necessary updates to the menu setting then click button.
4 Click the Apply Changes link located at the top right hand corner of the page, to commit
the changes to the database
Delete Menu Settings
P STEPS:
1 From the Destinations=>»Menus page, locate the name of the Menu item you want to
edit.
2 Click on @ icon to the right of the Name of the menu you want to delete. The Menu
name is removed from the Menu listing.
3 Click | @ Chanees | ion.
4 Click the Apply Changes link located at the top right hand corner of the page, to commit
the changes to the database.
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Advanced Menu Settings

Advanced

Advanced Menu Settings

Response Timeout 4

Digit Timeout 2

Play the greeting 1 times before time out.
Local extension dialing: Yes -

Prompt Padding 2

Enable Admin PIN Yes

Admin PIN 899989

Figure 60 — Advanced Menu Settings Page

Sections/Fields Description

This is the number of seconds (0-60) the PBX will wait for digits to be
dialed. If nothing is dialed in the allotted time, the menu will route the

Response Timeout call to the Failover Destination. The minimum and default value is 4.

While entering digits, the PBX will wait this many seconds (1-20) after
the last digit was entered to take any actions. Single decimal digits are

Digit Timeout permitted. The default value is 2.

This is the number of times the greeting will be played before the call is
Play the Greeting sent to the fail over destination. Default and minimum value is 1.

This indicates whether you are able to dial local extensions from the
menu. Default value is YES.

Note: It is not necessary to designate leading digits for extensions. This
setting alone indicates when digits collected should be compared to the
available list of extensions.

Local extension dialing

This is the time in seconds that the PBX will wait when entering the
Prompt Padding menu before playing the prompt. The default is set to 2 seconds.

This enables the use of DTMF Menu Prompt Administration. When
enabled the user may access the menu from a DTMF-enabled device

Enable Admin PIN and input the PIN to enter into Menu Prompt Administration Default
value is No.

This is the PIN used to access DTMF Menu Prompt Administration.
Admin PIN Default value is: <empty>.

Table 43 — Advanced Settings and Description
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Start

Access Menu -
enu prompt heard

Input Menu Administration PIN

v

Choices:
# Listen to current Announcement
- 1 Manage Announcement 1 -

2 Manage Announcement £
3 Manage Announcement 3
4 Manage Announcement 4
5 Manage Announcement 5

Flay Announcement

Fress 1

L
Choices (in selection ) :
1 Play Announcement

2 Record Announcement
3 Set for use

# Back to previous

Hang up any

time to exit

Y

Figure 61 — Remote Menu Announcement DTMF Admin Flow
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Conferences

The Conference Bridge allows groups of callers (large and small) to participate in the same call. An internal
extension can dial the number direct to a conference; and outside callers can be routed to a conference by: being
transferred from an existing call, being routed direct via a DID, or selecting an option from a menu. Each
conference can be configured to require a PIN for entrance, or not.

Licensed Conferences: 2

Conferences Created: 2

Add Conference

Name Humber Action
Conference 1 S0 P @
Conference 2 = yd @

Figure 62 — Conferences Page
Eiit Conference

Marne:

Conference Mumber (dial to go to

conference):

Intra Prornpt: MNone v
Admin PIN: 445

General PIM: Bd5

Announce on Enter:

Enter Muted:

Cptimize Talker Detection:

Save Changes

Figure 63 - Edit Conference
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Sections/Fields Description
Enter a name to distinguish this conference from others.
Name
Conference Enter a unique 3-4 digits number for the conference.
Number

If desired, a Prompt file can be played when entering the conference.
Intro Prompt

This is the Administrator personal identification number (PIN). This is a 3-4
Admin PIN character numeric field.

This is the User personal identification number (PIN). This is a 3-4 character
General PIN numeric field.

If Enabled (checked), this prompts the user to record their name before entering

Announce on the conference.

Enter

If Enabled (checked), users enter the conference in muted mode. The user can dial
Enter Muted *1 to un-mute the themselves.

If the DCM speech detection is triggering when no one is talking you can check this

Optimize Talker . 15 |essen the effect of background noise.

Detection
Table 44 — Conference Settings and Descriptions

Add/Edit Conference
D sTEPS:

1 Navigate to Destinations= Conferences.

2 Click the Add button to create a new Conference, or the button to edit an existing
entry.

3 Build the conference room to match your end users desires.

Save Changes

4 Click button.

5 Click the Apply Changes link located at the top right hand corner of the page, to commit
the changes to the database.
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Conference Feature Codes

The Feature Code section of the Conference page displays the key or key combinations that need to be pressed
to activate or deactivate (toggling function) features for conferencing.

Feature Coidle

*

Feature List:

Wlute / Unmute: 1
Lock / Unlock: 2
Eject Last User *3
Decrease Conference “olume: =4
Increase Conference %olume: jia]
Decrease User %olume: ¥
Increase User “olume: g2
Exit Menu: =
Figure 64 — Features Code Page
Sections/Fields Description

. Pressing * will list all the features available while in the conference.
Feature List

Pressing *1 will allow you to toggle (switch) the mute state for yourself.

Mute/Unmute

Pressing *2 as the administrator will allow you to toggle (switch) whether new
Lock/Unlock callers can join the conference.

Pressing *3 as the administrator will allow you to eject the last caller who
Eject Last User entered the conference.

Pressing *4 will allow you to decrease the overall volume of the conference
Decrease Conference

call.
Volume
Increase Conference Pressing *6 will allow you to increase the overall volume of the conference call.
Volume

Pressing *7 will decrease your call volume during the conference call.
Decrease User Volume

Pressing *9 will increase your call volume during the conference call.
Increase User Volume

. Pressing *8 will exit the features menu and return you to the conference call.
Exit Menu

Table 45 - Features Code Settings and Descriptions
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Voicemail

When an extension is created, a Voicemail box tied to that extension is automatically created. Voicemail boxes
that do not have an extension associated with them are created and administered exclusively through
Destinations=»Voicemail. There are three locations in the IP PBX that allow management of a voicemail box:

¢ Destinations=»Extensons — Under the Advanced Settings section, the basic settings for the mailbox can
be configured.

o Destinations=»Voicemail — This area allows for total configuration of the voicemail box, including
features like Broadcast and Cascading Message Notification.

¢ Smart Personal Console — Gives end users the ability to configure some mailbox settings.

Edit Voicemail Box Settings

Mailbosx 597

Name Test

Password: 597

User E-mail:

Attach to E-mail Yes © Mo O A ©

Delete after email: Yes © Mo © MA@

Turn Old After Emailing: Yes © No @

Say Caller ID: Yes © Mo NiA @

Allow Review: Yes ) No MA@

Allow Operatar: Yes ' Mo MA@

Play Envelope Message: Yes © No © NA @

Auto Delete Voicemail in a0 Days

Allow dialing cut from voicemail: no -

Exclude from Directory no -

Mailbox Operator None w| i+
Mailbox Exit Destination None = =

Broadcast Messages to:

100 =~ |[|2227 -
114 2228
127 2224
128 2226 Add Remove
129
| 207
202
1204
210
212 -] 3
Cascading Message Motification: Enabled ~ | Contact Numbers
Figure 65 — Edit Voicemail Box Settings Page
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Sections/Fields
Mailbox

Name
Password

User E-mail

Attach to Email

Delete After
Emailing

Turn Old After
Emailing

Say Caller ID

Allow Review

Description
This is the mailbox number, which must be a unique 3 or 4 digit number.
This is the name of the voicemail box.

This is the password to access the voicemail messages. Only numbers are
allowed.

This is the email address associated with this mailbox.

Defines whether the PBX will send an email to the user informing them they have a
new message. An audio file (.\Wav) of the message will be attached.

YES = send email with attachment.
NO = do not send an email.
N/A = use the system wide default defined under PBX Setup=»Voicemail.

Defines if the voicemail message will be deleted from the PBX after the email has
been sent.

YES = delete message after it has been emailed.
NO = do NOT delete message after emailing.
N/A = use the system wide default defined under PBX Setup=>»Voicemail.

Note: This feature should not be enable at the same time as Turn Old After
Emailing.

Defines if the voicemail message will be sent from the NEW folder to the OLD
folder after emailing.

YES = move message to Old messages folder after emailing.
NO = leave the message in the NEW messages folder after emailing.

Note: This feature should not be enable at the same time as Delete After
Emailing.

Defines if the Caller ID will be played prior to playback of the message.
YES = state caller id prior to message content playback.

NO = do NOT state caller id prior to message content playback.

N/A = use the system wide default defined under PBX Setup=»Voicemail.

Defines if the caller is permitted to review and take action on the message they
leave.

YES = allow callers to review and re-record the message they left.
NO = do not allow callers to re-record their message.
N/A = use the system wide default defined under PBX Setup=>»Voicemail.

Defines if the caller is permitted to press “0” to reach the mailbox operator while
leaving a voicemail message.

Allow Operator YES = allow dial 0 while listening to mailbox greeting.
NO = disallow dialing 0 while listening to mailbox greeting
N/A = use the system wide default defined under PBX Setup=»Voicemail.
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Play Envelope
Message

Auto Delete
Voicemail In

Allow Dial Out
Access

Exclude from
Directory

Mailbox Operator

Mailbox Exit
Destination

Broadcast Messages

Cascading Message

Defines if the system will play caller ID and time of call prior to playback of the
message.

YES = play message details prior to playback of message contents
NO = do not play message details prior to playback of contents.
N/A = use the system wide default defined under PBX Setup=»Voicemail.

Define the number of days in which voicemail messages are to be automatically
deleted from a mailbox. If this is set to “0” (zero) the voicemail message will never
expire.

This permits the user to dial out from voicemail.

This indicates whether to exclude the extension paired with this mailbox from the
directory.

Defines where to route a calller if they press “0” (zero) while listening to your
mailbox greeting. Set this to None to use System Default from value defined at
PBXSetup=>General.

If a caller remains on the line or presses # after leaving a message in this voice
mailbox, this is where they will be routed. Set this to None to use System Default
from PBXSetup=>»General.

If this setting is configured, messages that are directly left in this box are
broadcasted to the boxes that are added to the list. Note that messages forwarded
to this box are not broadcast.

If enabled, the Cascading Message Notification feature will be activated, allowing
you to configure the system to call a single or group of phone numbers when a new

Notification . X .
voicemail message has been received.
Table 46 - Voice Mailbox Settings and Descriptions
Add Voicemail Settings

The following outlines the steps to create a stand alone voicemail box.

D SsTEPS:

1 From the Destination=»Voicemail page, click the Add Mailbox button located at the top
left corner of the page.

2 The Edit Voicemail Box Settings page is displayed. Using the table of parameters and
descriptions above, configure the voicemail box to meet your business requirements.

3 Click

Save Ch
ave TRANEEE | button to save the changes. The system returns you to the Edit

Voicemail Box page.

4 Click the Apply Changes link located at the top right hand corner of the page, to commit
the changes to the database.
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Edit Voicemail Settings

The following outlines the steps to modify voicemail parameters.

D SsTEPS:

1

From the Voicemail Box Setup page, locate the mailbox that you want to update.

Click the ' icon to the right of the Mailbox Name.

The Edit Voicemail Box Settings page is displayed. Make the necessary changes to the
extension information.

Save Changes

Click
Voicemail Box page.

button to save the changes. The system returns you to the Edit

Clear Voicemail Messages

The following outlines the steps to clear a voicemail box of all messages and greetings.

D SsTEPS:

1

From the Voicemail Box Setup page, locate the mailbox that you want to clear

messages from. Click the @ icon to the right of the Mailbox Name.

The messages from that mailbox will be deleted.

Save Changes

Click
Voicemail Box page.

button to save the changes. The system returns you to the Edit

Click the Apply Changes link located on the right hand corner of the page, to commit the
changes to the database.

Delete Voicemail Box

P STEPS:

1 From the Voicemail Box Setup page, locate the mailbox that you want delete.

2 Click on @ icon to the right of the Mailbox Name of the menu you want to delete.

3 The mailbox is removed from the Mailbox listing.

) Save Changes .

4 Click button to save the changes. The system returns you to the Edit
Voicemail Box page.

5 Click the Apply Changes link located on the right hand corner of the page, to commit the
changes to the database.
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Broadcast Message — Add

D SsTEPS:

1 From the Edit Voicemail Box Settings page is displayed. Scroll to the Broadcast
Messages section.

2 Select the mailbox from the left list box then click the Add button. The item selected will
populate the list on the right.

-

z@‘: CTRL and Shift clicking is supported to select multiple mailboxes at once.

5 Ch
3 Click - ™= =M% [ tton to save the changes. The system returns you to the Edit

Voicemail Box page.

4 Click the Apply Changes link located at the top right hand corner of the page, to commit
the changes to the database.

Broadcast Message — Remove

D sTEPS:

1 From the Edit Voicemail Box Settings page is displayed. Scroll to the Broadcast
Messages section.

2 Select the mailbox from the right list box then click the Remove button. The item selected
will be removed from the list.

-

z@‘: CTRL and Shift clicking is supported to select multiple mailboxes at once.

5 Ch
3 Click - ~™= =185 [ tton to save the changes. The system returns you to the Edit

Voicemail Box page.

4 Click the Apply Changes link located at the top right hand corner of the page, to commit
the changes to the database.

5 Click the Apply Changes link located on the right hand corner of the page, to commit the
changes to the database.

Cascading Message Notification

Cascading Message Notification works along the same principle as FollowMe, but pertains to voicemail
messages. When configured, if an extension gets a new VM, the PBX can call a variety of numbers, in the order
defined, to inform the user of the message.

Note: Once the call is answered, the user will have the ability to listen to their message from their
phone, or to refuse the call. Until the voicemail box has its new messages cleared, the system will
continue to call out when the Notification Interval is met.
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Set Cascading Messages

P STEPS:
1 Navigate to the Edit Voicemail Box Settings page.

2 Scroll to the Cascading Message Notification section.

Cascading Message Motification: Enabled * || Contact Mumbers

Save Changes

3 Select Disable to turn the notification feature OFF. Select Enabled to turn the notification
feature ON.

Save Changes

4 Click
Voicemail Box page.

button to save the changes. The system returns you to the Edit

5 Click the Apply Changes link located at the top right hand corner of the page, to commit
the changes to the database.

Setting Cascading Interval

P STEPS:
1 Navigate to PBX Setup=>»General.

2 Locate the Cascading Voicemail Notification Interval, set the value to the desired
number of minutes, the PBX will check for new emails and make calls to notify when the
interval passes. Default is 5 minutes.

Save Changes

3 Click the button to save the changes.

4 Cick the Apply Changes link located at the top right hand corner of the page, to commit
the changes to the database.
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Configure Contact Numbers for Cascading Message Notification

Administrator View - Notification Settings | Voicemail Box *501

‘Options
Add IT' seconds to total search time so Callee has time to listen. m
Introduction Prompt: | oystem Default v
Options Prompt: Sym
Outhound Context: | 501 |
Use Prionty Rimgs Type Name Number
1 ~| [4 ¥][Mobile ¥]|cell | 12345678900 ®
2 ~| |4 | Home V||MyHDuae | 3876543 |
O [20¥] [z ¥][Mobile ¥]| | |
O [29] [z v [Mobie ]| | |
O [20 %] [2 %][Mobile ¥]| | |
0 [20 %] [2 »][Mobie ¥]| | |
O [20¥] [z %] [Mobile ]| | |
O [20 %] [2 %][Mobile ]| | |
0 [20%] [2 ][ Mobile ¥ | |
0 [e0 ¥ [2 #][Mobile ]| | |
"Save | “Exit |
Figure 66 — Notification Settings / Voicemail Box Page
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Sections/Fields

Add X seconds to
total search time

Introduction Prompt

Options Prompt

Outbound Context

Numbers

Description

This allows you to configure how many seconds the system will spend
searching for the called party. Default is 12 seconds.

Introduction Prompt plays “You have new messages” after you answer the
call. This can be set to any custom prompt you have recorded on the
system.

Options Prompt plays “Please enter your voicemail password, or 2 to
reject this call” after you answer the call. This can be set to any custom
prompt you have recorded on the system.

Outbound Context gets set to an extension number, and will use that
extension’s Class of Service when making outbound calls.

Configure the numbers you wish to be called when a VM message is
received. The calls will be made in order, with 1 being the highest priority
and 20 the lowest. You must check the Use column for each number to be
considered active.

If you wish to delete a number, click the @ button then save and exit.

Table 47 — Notification and Voicemail Box Settings and Descriptions

D SsTEPS:

-

1 From the Destinations=»Voicemail page, click the pencil # of the mailbox you wish to

edit.

2 Scroll to the Cascading Message Notification section and click the Contact Numbers
button (Cascading Message Notification needs to be enabled)

3 The Notification Settings / Voicemail Box window will appear. Set the parameters
based on the description of the values provided in the table above.

4 Click the

5 Ch
ave JANEES | hutton to save the changes.

5 Click the Apply Changes link located at the top right hand corner of the page, to commit
the changes to the database.
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Schedules
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Figure 67 — Edit Schedule and Holidays Page
Sections/Fields Description
N This is the name that is associated with the schedule.
ame

Define the start and end time for the hours that will be considered

Hours of Operation

Operational hours

This is the assigned Destination where the calls will go during the
schedule’s hours of operation.

In Hours Destination

If “Apply Forwarding Settings” is enabled (checked), the destination’s

call forward settings. The items in the drop-down listing are the

configured Destinations in your PBX system
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This is the assigned Destination where the calls will go when it is
received outside the schedule’s hours of operation.

Outside of Hours If “Apply Forwarding Settings” is enabled (checked), to use the
Destination destination’s call forward settings. The items in the drop-down listing
are the configured Destinations in your PBX system.

Define the hours allocated for lunch for a schedule. Calls received
Lunch Hours during this time will be sent to the Lunch Hours Destination.

This is the assigned Destination where the calls will go when it is
received during the allocated Lunch Hours.

If “Apply Forwarding Settings” is enabled (checked), to use the
destination’s call forward settings. The items in the drop-down listing
are the configured Destinations in your PBX system.

Lunch Hours Destination

Holiday Name — This is the name associated with this holiday
schedule.

Start — This is the start date and time for this holiday schedule. (The
year is defaulted to the current year.)

Holidays End - This is the end date and time (expiration) for this holiday
schedule. (The year is defaulted to the current year.)

Destination — This is the assigned Destination where calls will be
routed when it is received during the holiday schedule.

Table 48 — Edit Schedule Settings and Descriptions
Add Schedule

P STEPS:
1 From the Destinations=»Schedules page, click on the ADD Schedule button.

2 The Edit Schedule Switch page appears.

3 Enter the settings for the new schedule.

5 Ch
4 Click the | ~™® =185 [ ) tton to save the changes.

5 Click the Apply Changes link located at the top right hand corner of the page, to commit
the changes to the database

Add Holiday to Schedule

D sTEPS:

1 From the Destinations=»Schedules=»Edit Schedule Switch page, scroll down to the
Holidays section of the page.

2 Enter the dates and times for the new holiday schedule. Click the Add button to add the
new holiday schedule.

3 Click on the newly added holiday, select a destination from the Destination dropdown and
click Set
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Save Changes

4 Click the button to save the changes.

5 Click the Apply Changes link located at the top right hand corner of the page, to commit
the changes to the database

Remove Holiday from Schedule

D sTEPS:

1 From the Destinations=»Schedules=»Edit Schedule Switch page, scroll down to the
Holidays section of the page.

2 Select the holiday (appearing in the list) that you want to remove. Click the Remove
button to delete the holiday schedule. The item in the Holiday list is removed.

Save Changes

3 Click the button to save the changes.

4 Click the Apply Changes link located at the top right hand corner of the page, to commit
the changes to the database

Edit Schedule
D sTEPS:

1 From the Destinations=»Schedules page, locate the schedule name that you want to
edit.

~

2 Clickon icon to the right of the Name of the schedule you want to update. The Edit
Schedule Switch window appears.

3 Edit the necessary parameters to configure the schedule.

Save Changes

4 Click the button to save the changes.

5 Click the Apply Changes link located at the top right hand corner of the page, to commit
the changes to the database

Delete Schedule
D sTEPS:

1 From the Destinations=>»Schedule page, locate to the Schedule Name from the listing
that you want to delete.

2 Click on @ icon to the right of the Name of the schedule you want to delete. The
schedule is removed from the listing page.

Save Changes

3 Click the button to save the changes.

4 Click the Apply Changes link located at the top right hand corner of the page, to commit

the changes to the database.
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Branch Offices

Branch Offices provide a powerful tool for interconnecting PBX Systems. Through Branch Offices you can create
a network of systems where dialing phones on remote systems is as easy as dialing local extensions. You can
route calls inbound to a destination on any branched PBX, and outbound through the trunks of other systems
networked in this way. Branch office extensions can even participate in ring groups.

Branch 1 Branch 2

P P

intemel

P NN

Main Office

Figure 68 — Sample Branch Office Networking

IMPORTANT: Branch Offices communicate using I1AX2
protocol over Port 4569. Refer to the Port Forwarding
Configuration Table earlier in this manual for more

information.
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Edit Branch Office

Mame: [one ward only)

Host: (dynamic or ip address)
Dial Prefix:

Fassword:

Register: Yes ¥

Enable Trunking: Yeg ¥

Enable Multisite Manager
) Mo (w
Cannection:

Clualify: 30000
Enable 14X Trunking: Yeg ¥

Allow Codecs:
G72371 & G717 (ulaw)

&5.726 G717 (alaw) Up
iLBC e
Speex Down
LFCIO =
Add Remove
Class of Service: Maone (use defaulf) +

Save Changes

Figure 69 — Edit Branch Office Page

2011 Copyright © IPitomy Communication, LLC 130 v4.0.1
www.ipitomy.com



IPitomy IP PBX Admin Guide

IPiTomy

SMARTER BUSINESS COMMUNICATIONS

Sections/Fields

Name

Host

Dial Prefix

Password

Register

Enable Trunking

Enable Multisite
Manager
Connection:

Qualify

Enable IAX2
Trunking

Allow Codecs:

Class of Service:

2011 Copyright © IPitomy Communication, LLC 131

Description

The name that is associated with the branch office. Both sites involved in the
Branch Office connection must use the same Name.

NOTE: This field will not allow spaces in the name. It must be all one word. Symbols
can be used (i.e. underscore “_" dashes “-”, etc.) can be used in place of spaces.

Enter the static IP of the system your PBX is connecting to. If they do not have a
static IP address, enter the word dynamic.

The dial prefix must be an asterisk, plus two numbers (ie. *22). This prefix must be
dialed to reach any destination on another PBX that has not been entered as a
Branch Extension.

This is the password that will allow access to the PBX. Both sites involved in the
Branch Office connection must use the same Password.

YES= to require that the branch office register with the PBX system. Only used if
the Host is set to dynamic.

NO = does not require that the branch office register with the PBX system.
YES = Branched PBXs are able to dial calls out your PBXs trunks.
NO = Branched PBXs are not able to dial calls out your PBXs trunks.

Defines if Multi-Site Call Manager functionality is enabled. This feature requires a
license from IPitomy to be functional.

The time in milliseconds that the PBX should check that the branch office is still
online. Setting this to zero may increase Branch Office stability.

Indicates whether to use IAX trunking. If enabled (YES), this setting can help
eliminate packet overhead by cutting the cost of continuous communication.

Defines what codecs this branch office can use for calls. Priority for codecs are
defined from top to bottom.

Allows for individual Branch Offices to use different COS. Setting to None will
follow the default Branch Office COS defined under PBX Setup=» General.

Table 49 — Branch Office Settings and Descriptions
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Destinations / Branch Offices Logout | Apply Changes
Branch Offices

F System

. Add Office Show Extensions
» Providers
+ Destinat
estinations Name Prefix Actions

Extensions

Groups Houston *12 4 @
Menus

Conferences Mew York *B6 >~ @
Voicemail ,
Schedules Seattle *09 / ®

Branch Offices

b Call Routing
» PEX Setup

} Reporting

Copyright @2011 IPitomy Communications, LLC
wwew.ipitomy_com | ESi~ (941) 306-2200 & | support@ipitomy.com

Figure 70 — Branch Offices Page

Configuring Office 1

P STEPS:
1 Click on Destinations=»Branch Offices. The Branch Offices page is displayed.

2 Click on the ADD office button. The Edit Branch Office page appears.

3 Give a unique NAME for the connection. The name should only contain alpha-numeric
characters and no spaces. It should be ONE WORD ONLY.

4 Enter the External IP of the PBX in the Host field.

5 Enter a unique DIALING PREFIX of an asterisk followed by two numbers.

6 Give a unique PASSWORD for the connection.

7 Select NO for REGISTER (Note: that registration is not required if host is known).
8 Configure Enable Trunking as needed.

9 Configure Enable Multisite Manager Connection as needed.

10 Set QUALIFY at 0.

11 Configure Enable IAX2 Trunking as needed.
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5 Ch
12 Click the | "+ "B 1 itton to save the changes.

13 Click the Apply Changes link located at the top right hand corner of the page, to commit
the changes to the database

Configuring Office 2

D sTEPS:

1 Click on Destinations=»Branch Offices. The Branch Offices page is displayed.

2 Click on the ADD Office button. The Edit Branch Office page appears.

3 Enter a name in the NAME field that matches that given to the Office 1 PBX. The name
should only contain alpha-numeric characters and no spaces. It should be ONE WORD
ONLY.

4 Enter an external IP address or domain corresponding to the IP of the main office PBX
in the HOST field.

5 Enter a UNIQUE dialing prefix for the extensions connected to the Office 2 PBX.

6 The PASSWORD for Branch Office 2 needs to be the same as the one assigned in the
Branch Office 1 PBX.

7 Select NO for REGISTER.

8 Configure Enable Trunking as needed.

9 Configure Enable Multisite Manager Connection as needed.
10 Set QUALIFY at 0.

11 Configure Enable IAX2 Trunking as needed.

Save Ch
12 Click the |~ “MMBEE | ) tton to save the changes.

13 Click the Apply Changes link located at the top right hand corner of the page, to commit
the changes to the database

-z@‘: To setup additional Branch Olffices in the PBX, use the steps outlined above.
Keep in mind to use the same logic (pattern) and make sure that the dialing
prefix is unique to each office.
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Edit Branch Office
P sTEPS:

1 From the Destinations=»Branch Office page, locate the schedule name that you want
to edit.

~

2 Clickon icon to the right of the Name of the Branch Office you want to update. The
Edit Branch Office page appears.

3 Edit the necessary parameters to configure the branch office.

Save Changes

4 Click the button to save the changes.

5 Click the Apply Changes link located at the top right hand corner of the page, to commit
the changes to the database

Delete Branch Office
D sTEPS:

1 From the Destinations=»Branch Offices page, locate to the Name from the Branch
Office listing that you want to remove.

2 Click on @ icon to the right of the Name of the Branch Office you want to delete. The
Branch Office is removed from the listing page.

5 Ch
3 Click the | ™= “MMEEF [ jtton to save the changes.

4 Click the Apply Changes link located at the top right hand corner of the page, to commit
the changes to the database

Branch Extensions

Branch Extensions are created through the add extension field at the bottom of the branch office edit page.
Branch extensions can be dialed directly without a prefix, provided that these extensions are properly configured
on the PBX for which the branch extensions are defined. Branch extensions will appear in call routing drop down
lists throughout the system after they are created. If needed, you can add Ring Group and Menu numbers as
Branch Extensions.
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Configuring Office 2 with Branch Extensions

Branch Extensions

Add
Name Extension Action
Branch Extension 242 ®
Branch Extension 245 ®
Branch Extension 288 )
Branch Extension 212 )
Branch Extension 100 ®
Branch Extension 101 ®

Figure 71 — Branch Office Extension Section

D SsTEPS:

1 Click on Destinations=»Branch Offices. The Branch Offices page appears.
2 Click on the Branch Office connection (Name) assigned to Office 1.

3 Assuming Office 1 has extension numbers 100 thru 110, enter the numbers 100 to 110 in
the field above the Add button then click ADD. You will enter (add) each extension one at
a time. Note: Using the format X-Y will add all extensions in the specified range.

4 If the extension number is valid (not already in use), the new extension will appear in the
list of Branch Extensions.

Save Ch
5 Click the -~ = “M%5 | ) ton to save the changes.

6 Click the Apply Changes link located at the top right hand corner of the page, to commit
the changes to the database.

7 Verify the new extension by calling the number from phones located (registered) at
Branch Office 2.

z@\ To place a call from one Branch Office to another simply dial the prefix that was
assigned to that locations PBX + the extension of the user trying to be reached at
the other office. This same easy concept works for transferring calls from one
Branch Office to another. Or, if you have the extension configured as a Branch
Extension on your PBX, you can simply dial the extension number and it will be
automatically routed to the branch.
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View Branch Office Extensions

) Mozilla Firefox

|:] http: {72 .64.129.43/ippbxfextReport. php

Branch: 3eattle:

222

245

288

212
Branch: Houston:

300

3z0

338

399
Branch: MNew York:

G606

505

401

709

Figure 72 — Show Extensions Page

D SsTEPS:

1 From the Destinations=»Branch Office page, click on the Show Extensions button
located at the top of the Branch Office list page.

2 A popup window appears displaying all the extension information for each Branch Office
that is currently in the system.

3 Click on the “X” to close the popup window.
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Call Routing

Call routing sends callers to specific inbound destinations within the system, and routing outbound callers over
specific outbound routes like local, long distance, international and emergency.

Incoming Call Routing

[Msable Day/Might Mode Edit Hight Edit Hours

DayMight Mode is: Enabled Displaying: Day Mode

Edit DID Caller I}

Default Incoming Destination
benus || Menu: Auto Attendant

This setting is applied to all incoming trunks where use system default setting is selected.

Proviiders:

ip400 Extensions || Extansion: 807«

1111 Menus w | hdenu: Auto Attendant |
Ry Mone | |

Save Changes

Figure 73 — Incoming Call Routing Page
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This table describes the parameters that can be set for incoming calls. Calls can be routed to destinations
and you can also enable (set) the time parameter when the calls will get sent to their defined route.

Sections/Fields Description
The PBX system defaults to Day/Night Mode Disabled. To toggle between
Disable Enabled/Disabled settings for the Day/Night Mode setting. When enabled the
Day/Night Mode Edit Night and Hours button will appear which will allow you to configure the night
Button destinations and hour parameters.

Toggles between Day/Night Mode settings. When selected, it will change the
Edit Night/Day Displaying field to either “Day Mode” or “Night Mode”, allowing you to configure
Button the destination for calls when in and out of hours.

Allows you to edit the hours for the incoming calls to routing.

. IMPORTANT: If you enable day night mode service you must
Edit Hours populate the system hours schedule otherwise all calls will

be routed to the night destinations.

Allows you to edit CID information for incoming calls based on DID. If you wish to
. retain the original CID information as well as display the override info, be sure to
Edit DID Caller ID ook the box for Prepend.

Each provider will display in a gray box. DIDs for each provider will display
beneath the gray box in white. If a DID destination is set to None, it will follow the

Providers settings for the provider itself. If a provider destination is set to None, calls will
route to the Default Incoming Destination.

This button allows for configuration of destination specific settings.

Groups: Allows you to define a priority, increasing or decreasing the calls
importance in the queue. The higher the number, the higher the priority.

Extension: Allows you to define a group of numbers that will be dialed once the call
has been answered. Typically used when connecting an extension to a fax server
that routes faxes to people based on the digits read at the time of answering the
call.

Table 50 — Incoming Call Routing Settings and Descriptions

Set Default Incoming Destination

D SsTEPS:

1 From the Call Routing=>»Incoming Routing page, go to the Default Incoming
Destination section.

2 Select the desired Destination category from the first drop-down list, then select the
specific destination from the second drop-down list.

5 Ch
3 Click the | ™= “MMEEF [ jtton to save the changes.

4 Click the Apply Changes link located at the top right hand corner of the page, to commit
the changes to the database.
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Set Provider Trunk Incoming Destination

1

From the Call Routing=>»Incoming Routing page, go to the section that corresponds to
either your SIP Provider or Channel Group name.

Select the desired Destination category from the first drop-down list, then select the
specific destination from the second drop-down list.

Repeat step 2 for all other providers. Any provider that can follow the Default Incoming
Destination can be left as None.

. 5 Ch
Once you have made the necessary changes, click the ave HhaneEs | putton to save

the changes.

Click the Apply Changes link located at the top right hand corner of the page, to commit
the changes to the database.

Enable/Disable Day/Night Mode
The following section outlines steps to enable or disable the Day/Night Mode for Incoming Calls.

D sTEPS:

1

From the Call Routing=>»Incoming Routing page, click on the Enable/Disable
Day/Night Mode button located at the top of the page.

2 The Day/Night Mode changes either Enabled or Disabled (depending on its previous

setting).
) . Save Changes

3 Once you have set the parameter to the desired mode, click button to
save the changes.

4 Click the Apply Changes link located at the top right hand corner of the page, to commit
the changes to the database.

Switch Day/Night Mode

This feature allows you to change whether you are editing the Day destinations or the Night destinations for
incoming calls. The following section outlines the steps to switch or toggle to/from night or day.

D sTEPS:

1

From the Call Routing=>»Incoming Routing page, click on the Edit Night or Edit Day
button located at the top of the page.

2 The Displays field changes either Day Mode or Night Mode (depending on its previous
setting).
3 Modify the destinations for whichever mode you are working with, then click
Save Changes button to save the changes.
4 Click the Apply Changes link located at the top right hand corner of the page, to commit
the changes to the database.
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Edit Hours

D STEPS:

1 From the Call Routing=»Incoming Routing page, click on the Edit Hours button
located at the top of the page, which will open the schedule page for Day/Night mode.

2 Set the hour parameters for the incoming route to meet the business requirements. See
the previous section pertaining to Schedules for more details.

3 Click | e hanees [ ton to save the changes.

4 Click the Apply Changes link located at the top right hand corner of the page, to commit
the changes to the database.

Edit Incoming Caller DID

If you want a particular DID to display the override CID information followed by the original inbound CID
information, be sure to check the box for Prepend, otherwise the original CID information will be lost.

DID Humber Caller ID Name Caller I Number

9413062201 LI Prepend [ Prepend
9413062203 O Prepend O Prepend
9413062204 O Prepend O Prepend
9413062205 LI Prepend [ Prepend
9413062206 LI Prepend [ Prepend

Figure 74 — Incoming Routing Edit Incoming DID CID Page

D SsTEPS:

1 From the Call Routing=>»Incoming Routing page, click on the Edit DID Caller ID button
located at the top of the page.

2 Alist of existing DID numbers is displayed. Enter Caller ID Name and corresponding
Caller ID Number for the desired DID Number.

3 Enable Prepend for each by checking the box, if desired.
4 Once you have made the necessary changes to the DID numbers, click the
Save Changes

button to save the changes.

5 Click the Apply Changes link located at the top right hand corner of the page, to commit
the changes to the database.
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Outgoing Call Routing

By default, the PBX has five dialing routes built and included in the System Default Class of Service. These
routes are 7 Digit, 10 Digit, 11 Digit, International, and Emergency, and should handle the normal day to day
calling needed on a PBX. Once you have configured trunks on the PBX, you must add them to whichever dialing
routes you wish to use those trunks. IPitomy advises you add ALL available trunks to the Emergency route, and
to check with the end user before adding trunks to the International dialing route. Some users may require
specific dialing routes to be built to meet their needs.

IMPORTANT: Please keep in mind that all new routes need
to be added to a Class of Service before the route can be
used.

Sections/Fields

Description

Click this button to create a new Outbound Dialing Route.

Add Route
Advanced feature only available through licensing. Contact IPitomy for more
ggdtgustom information.
u

Class of Service

A Class of Service (COS) pertains to a group of outbound dialing routes. You can
define a specific COS for an extension or branch office, limiting which routes are
usable by those entities. Select a specific COS from the dropdown to view the
routes included for that COS. Click on the blue words Class of Service to create,
modify, or delete a Class of Service.

7 Digit Local By default this route looks for a pattern of any number 7 digits long.
Dialing
o By default this route looks for a pattern of any number 10 digits long.
10 Digit Dialing
. By default this looks for a pattern of numbers that start with a 1 and is 11 digits
1+ Dialing (11 long.
Digit)
By default this looks for a pattern of numbers that start with 011 that is between 4
International and 15 digits long.
By default, this looks for the specific pattern of 911.
Emergency
Table 51 - Outbound Routing Page Descriptions
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Add Route Add Custom Route

Class of Service: | All b

1+ Dialing (11 Digits)

Rowute Number Action

1+ Dialing (11 Digits)  Default ” ®
10 Digit Dialing

Rowute Number Action

10 Digit Dialing Default PV ®

T Digit Lecal Dialing

Rowute Number Action

7 Digit Local Dialing Default ~ )
Emergency

Rowute Number Action

Emergency Diefault ”~ )
International

Rowute Number Action

International Diefault ~ )

Figure 75 — Outgoing Routing Page
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Edit Qutbound Route

Route Mame 1+ Dialing (11 Digits)
Route Type 1+ Dialing (11 Digits)
Start Pattern

Digits

Exact Length Yes -

Subroute Digits

Subroute Offset

Trunks: T1 Trunks - #

Vintalk -

Disable Ext CID Override
Force Use PSTHN CID
Cwerride Default CID{name)
Override CID Mame

Cwerride Default CID(number)

Cwerride CID Mumber

Save Changes

Up Strip Digits
Dn Prefix Digits
Add | 4877503 -
Delete

no -

no -

no -

no -

Figure 76 — Add New Outgoing Route Page

IMPORTANT: Please keep in mind that all new routes need
to be added to a Class of Service before the route can be
used. Subroutes are automatically added under the parent
route they use.

2011 Copyright © IPitomy Communication, LLC

143
www.ipitomy.com

v4.0.1



IPiTomy

IPitomy IP PBX Admin Guide SMARTER BUSINESS COMMUNICATIONS

Sections/Fields

Route Name

Route Type

Start Pattern

Digits

Exact Length

Subroute Digits

Subroute Offset

Number

Trunks

Description
This is the name associated with the outgoing route.
Set to New Route for a brand new dialing route, or select an existing route to build
a subroute.
Defines what type of digit pattern will match the route. Acceptable entries are:
Numbers
X = Any number
N = Any number, excluding 1 and 0
Length of the pattern that will match the route.
Defines if the number dialed has to exactly match the pattern length defined under
Digits.
Yes — Does need to match exactly.
No — Does not need to match exactly.

How many digits of the number dialed to read for comparison to any subroutes that
may be built for this route.

How many digits of the number dialed to skip before starting to read Subroute
Digits

When building a subroute off of an existing Outbound Dialing Route, this is the
number that will match the subroute digits of the parent outbound route. For

example, the 11 digit dialing route reads the area code for subroute digits by
default. Here, you would enter the area code that needs to be subrouted.

In order to dial outbound from a dialing route, you need to define what trunks it will
use.

Add — Use this button to add the trunk selected from the dropdown to the route.
Delete — This button allows you to delete the trunk selected from the route.

Up — Highlight a trunk and click this button to move it up the list, and in priority.
Dn - Highlight a trunk and click this button to move it down the list, and in priority.

Strip Digits — This indicates whether the PBX will strip any digits before sending
the call out a particular Trunk. This is set per trunk.

Prefix Digits — Defines the digits to be prepended to the dialed number before
sending the call out a particular Trunk. This is set per trunk.
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In addition to the Extension and Trunk, Caller ID (CID) override can be set on a per
route basis. Each outbound route can be configured to override the CID name
and/or CID number that is sent when dialing out each trunk in the route. Each
outbound route also has control over whether extensions with Ext CID Override
configured are able to send their CID information.

Disable Ext CID Override - Set to “YES” if you want to disable the CID override for
the outgoing route, including Extension CID settings.

Force Use PSTN CID - New in version: 3.4.1, it is now possible to deliver the CID
received on PSTN inbound calls out on calls being transferred outbound. This
feature is subject to the ability of the provider associated to the outbound call. This

CID Override for provider must be able to allow substitution of CID. Set to “YES” if you want to send

Qutbound Route the received CID with a call transferred outbound..

Parameters
Override Default CID (name) - Set to “YES” if you want to enable custom Name
CID override for the outgoing route.
Override CID Name - If the Override Default CID (name) is set to “YES”, enter the
new CID override name for the outgoing route.
Override Default CID (number) - Set to “YES” if you want to enable custom
Number Default CID override for the outgoing route.
Override CID Number - If the Override Default name is set to “YES”, enter the
new CID override number for the outgoing route.

Table 52 — Outbound Route Settings and Descriptions
Add Outgoing Route
P STEPS:

1 From the Call Routing=>»Outgoing Routing page, click on the Add Route button
located at the top of the page. The Edit Outbound Route page appears.

2 Enter the parameters to configure the outbound call route.

Save Changes

3 Once you have entered all the necessary information, click the button to

save the changes.
4 Add the new route to any Class of Service it will be used with.

5 Click the Apply Changes link located at the top right hand corner of the page, to commit
the changes to the database.

Edit Outgoing Route

D SsTEPS:

1 From the Call Routing=>»Outgoing Routing page, locate the Outbound Route name that
you want to edit.

~

2 Clickon icon to the right of the Route you want to update. The Edit Outbound
Route page appears.

3 Edit the necessary parameters to configure the outbound route.
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5 Ch
4 Click the | ~™& =185 [ ton to save the changes.

5 Click the Apply Changes link located at the top right hand corner of the page, to commit
the changes to the database.

Delete Outgoing Route

D sTEPS:

1 From the Call Routing=>»Outgoing Routing page, locate to the Route Name from the
Route listing that you want to delete.

2 Click on @ icon to the right of the Route Name you want to delete. The Route is
removed from the listing page.

5 Ch
3 Click the | ™= “MMEEF [ jtton to save the changes.

4 Click the Apply Changes link located at the top right hand corner of the page, to commit
the changes to the database.
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Class of Service
A Class of Services is use

d to define which outbound dialing routes a given feature can use. By clicking the blue

words Class of Service on the Outgoing routing page, you will be able to delete, create, clone, and populate your
Class of Service with the desired outbound routes.

Clags of Service:

oystem Default

Rowute

7 Digit Local D

1+ Dialing (11 Digits)

International
Emergency
10 Digit Dialing
Cutbound Route
Company B 11
Custom Houtes

¥ || Add

Sections/Fields

Class of Service

 Swstem Default: v

Rename Create Hew Clone

Action )

aling

®® e ®

b3

digit + || Add

Figure 77 - Class of Service

Description

Use the drop down box to view Class of service. You can then take actions
pertaining to that COS.

Enter a new name in the far left text field, then click the Rename button to change

Rename the name of the COS currently being viewed.
Allows you to create a new, blank, COS. Name the COS in the text field to the left
Create New of the Create New button, then click the button to create.

Select from the drop down the COS you wish to clone. Enter a name in the field to
the left of the Create New button. When you click the Clone button, a new COS

Clone will be created with the new name which will be populated with the routes of the
original COS.
Clicking the Add button will add the route displayed in the dropdown to the COS

Add that is currently being viewed.
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Clicking this button in the gray bar will delete the COS. Clicking this button next to
@ a route will delete that route from the viewed COS.

Outgoing Call Routing
This section demonstrates, by example, some of the common configurations used with Outbound Routing.

Configure Block Calls Subroutes

In this example, your customers want to block their users from dialing 1-900 numbers. To achieve this, you will
need to create a subroute and configure it using the specifications below.

Edit Cwthound Rowute
Foute Mame  |Block 900

Route Type 1+ Dialing (11 Digits) +

Number |s00

Trunks: Up Strip Digits
['n Frefix Digits
Add i
Delete

Disable Ext CID Override no v

Crwerride Default ClID(name) no o W

Cwerride CID Mame

Cwerride Default CID{number) no ¥

Crwverride CID Mumber

Save Changes

Figure 78 — Blocking Dialing 1-900

Sections/Fields Description

Enter a meaningful name for the outbound route. In this case you may

Route Name want to call it “Block 900”.
Select 1+ Dialing, as this will be a subroute

Route Type
900, since the default 1+ Dialing route skips the 1 that is dialed, and

Number reads the next 3 digits for subroutes
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None should be added, as without a trunk to dial out, any 1-900 number
Trunks will be dead in the system.

Table 53 — Block 1900 Outbound Call Configuration

Configure Least Cost Routing Subroutes

In this example, the end user has multiple providers in different regions, and wants dialed calls to use the most
cost effective trunk when dialing out. The default 1+ (11 Digit) dialing route has Subroute Offset = 1 (ignores the
first digit dialed, this case being the 1 for a long distance number) and Subroute Digits = 3 (after ignoring the first
digit from subroute offset, this reads the next 3 digits (area code) in the dialed string and compares them to any
subroutes created). The subroute that will be built specifically routes calls dialed to the 941 area code through a
different, more cost efficient trunk.

Edit Outhound Route

Foute Mame  |Sarasota Route

Route Type

MNumber 541

Trunks: Local SRA Up Strip Digits
['n Prefix Digits
Delete

Digable Ext CID Cverride ho ¥

Cwerride Default ClID(name) ho (%

Cwerride CID Mame

Cwerride Default CID{number) no ¥

Cverride CI0D Mumber

Save Changes

Figure 79 — Least Cost Routing Example

Sections/Fields Description
Enter a meaningful name for the outbound route. In this case you may
Route Name want to call it “Sarasota Subroute”.
Select the 1+ Dialing as the route type, as this will be a subroute of that
Route Type dialing route.
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Enter 941 as this is the area code for the
Number
Add the trunks that will call this particular subroute in the most cost
Trunks effective manner.

Table 54 — Least Cost Outbound Call Subroute Configuration

IMPORTANT: The normal 11 Digit route is using analog 1
and analog 2 for trunks, while the 941 sub-route uses a
trunk that can dial locally to Sarasota without accruing long

distance charges.

Configure Information (411/1411) Subroute

If you would like callers to have the ability to use Information Service provided by your carrier then you must
configure the route. If they must dial 411 to get information then you will need to configure a route for 411. To do
this configure a route as below,

Edit Outhound Route

RouteName information

Route Type

Start Pattern 411
Digits 3

Exact Lenath ,-“_r’_e_s_ »
| Bubroute Digits 1
Subroute Offset I:I
Trunks:

p Strip Digits |

2

n Prefic Digits |
Add || Analogl v |

Delete

'

Figure 80 — Information (411) Subroute Setting

Sections/Fields Description
Enter a meaningful name for the outbound route. In this case you may
Route Name want to call it “Information”.
Select New Route, as this will not be a sub-route of any other route.
Route Type
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Enter the start pattern of as the code your provider uses for information,
Start Pattern in this case “411”
Enter the length of the code your provider uses for information, in this
Digits case “3"
Set the exact length to “YES”
Exact Length

. Set the Subroute digits to “-1” (minus 1).
Subroute Digits

Set the Subroute offset to “0”
Subroute Offset

Add any trunks that are appropriate for dialing Information with the code
Trunks created.

Table 55 — Information (411) Subroute Configuration

IMPORTANT: Please keep in mind that all new routes need
to be added to a Class of Service before the route can be
used. Subroutes are automatically added under the parent

route they use.

PBX Setup

PBX setup is used by a System Administrator to manage system-specific and system-wide settings. Typically
these pages will be visited once during installation, and then won’t be changed in the future.

General System Setup

While not visited often, the General settings page pertains to some core PBX components, like administrator
Username and Password, Time Settings, System Operator, Mailbox Exit Destination, Directory Type,
Autoprovisioning, and Security Settings.

Admin Settings Section

Admin Settings

Admin User Mame: phxadmin
Admin passwaord: ceeeenn
Re-type Admin password: YT

Admin Ermail Address:

Figure 81 — PBX Admin Settings Section

Sections/Fields Description

. The administrator user name for the PBX system, default is pbxadmin
Admin User Name

The administrator password for the PBX system, default is ipitomy. Once
Admin Password installed, we recommend you change this to a strong password.
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Re-type Admin This requires that you re-enter the password to confirm that they match.
Password
Admin Email This is the email address where administrative alerts will be sent.

Address

Table 56 — PBX Admin Settings Parameters and Descriptions

Edit Admin Settings

D STEPS:

1 From the PBX Setup=>» General System Setup page, locate the Admin Settings
section.

2 Enter the administrative information required.

5 Ch
3 Click the | ™= “MMEEF [ jtton to save the changes.

4 Click the Apply Changes link located at the top right hand corner of the page, to commit
the changes to the database.

General Settings Section

General Settings

System Operatar: benus * || Menu: Auto Attendant
bailbox Exit Destination: bdenus # || Menu: mailbox exit %
Directory Type: Last Name

Cascading “oicemall Matification Interval 5 minutes

Default Class of Service: System Default »

Branch Class of Service: System Default »

Internal Distinctive Ring: Default »

Sui Paging Fix: Mo«

Park Timeout 180 Sec

Feature Digit Timeout 3000 ms

Transfer Digit Tirmeout 5 sec

Auto-Provisioning: Stopped

Figure 82 — PBX General Settings Section

Sections/Fields Description
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System Operator

Mailbox Exit Destination

Directory Type

Cascading Voicemail
Notification Interval

Default Class of Service

Branch Class of Service

Internal Distinctive Ring

5xi Paging Fix

Park Timeout

Feature Digit Timeout

Transfer Digit Timeout

Extension FAX Detect
Timer

Auto-Provisioning

This is the default destination that callers will go to when pressing ‘0’
while in a voicemail box, if Allow Operator is enabled on the voicemail
box. Additionally, if an extension dials zero, this will be where they are
directed.

This is the default destination for a caller if they press ‘#‘after leaving a
voicemail message.

This determines if the name directory search will use the first or last
name.

This is the frequency with which the PBX will check and send out
cascading message notifications.

Defines what COS each newly created extension will use unless it is
changed.

This is the default COS for a Branch Office using Branch Office
Trunking.

This is the type of ring that will be used for internal calls.

Enabled (set to YES) this parameter only if IPitomy’s technical support
personnel advises.

This is how long the PBX will wait before timing out to an extension
that has a parked call, which if unanswered will failover to the System
Operator. Default value is 180 seconds.

This is the timeout parameter for the feature code digit press attempts
(in milliseconds). Default value is 3000.

This is the timeout parameter for inter-digit timing on feature code
based transfers. Default value is 5.

This is how long, in seconds, the PBX will detect to see if a call ringing
to an extension is a fax. The setting is enabled under extension
settings. Default value is 4.5.

While auto-provisioning is Running, users may use the phone-based
auto-provisioning mechanism in IPitomy phones to assign or create

extensions. Click on to start, and Off to stop the service. This does

not require saving or applying changes.

Table 57 — General PBX Admin Settings and Descriptions

Edit General PBX Settings
P STEPS:

1 From the PBX Setup=>» General System Setup page, locate the General Settings

section.

2 Enter the information required for the PBX Security settings

3 Click the

Save Changes

button to save the changes.
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4 Click the Apply Changes link located at the top right hand corner of the page, to commit
the changes to the database.
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Security Settings Section

Log Watch/Ban Service

This feature allows the PBX to monitor the SIP registration traffic and ban any IP address that makes 5 failed
registration attempts. The IP address will be banned for either 5 days or until the service is restarted.
Configuration settings allow you to ignore (not monitor) IP addresses that are communicating from the LocalNet,
as well as allowing you to manually add addresses you want the system to ignore.

Security Settings
Service is not currently Running

Enable Log YWatch + Ban Service Mo
Figure 83 — PBX Security Log Watch and Ban Service Status

Enable Log Watch/Ban Service

D SsTEPS:

1 From the PBX Setup=>» General System Setup page, locate the Security Settings
section.

2 Enable the Log Watch Ban Service by setting the parameter to “Yes” on the drop-
down list.

5 Ch
3 Click the | ™= “MMEEF [ jtton to save the changes.

4 Scroll back to the Log Watch Ban Service panel and click the Reload button.

Set Log Watch/Ban Service Parameters

Once you have enabled the Log Watch/Ban Services, you will be able to configure the parameters for the security
settings.

Security Settings

Senice 1= currently Running

Enable Log Watch + Ban Service Yes ¥

Ignore IPs in SIP LocalMets Yes ¥

Ignoring Addresses: 19216877 .44

Add Entry Add

Figure 84 — Security Log Watch and Ban Security Settings
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The following table describes the parameters and descriptions (recommended settings) for the Log Watch
and Ban feature.

Sections/Fields Description

Service is currently ~ This indicates the status of the service, either Running or Not Running.

Running

Restarts the Ban service, clearing any existing banned |IP addresses.
Reload Button

Set to Yes and the PBX will monitor failed SIP registration attempts. 5 failed

attempts and the IP is blocked for:
Enable Log Watch & * Sdays
Ban Service e Until system reboot

e Until Reload button is clicked

Set to Yes and the PBX will ignore failed SIP registration attempts from IPs
Ignore IPs in SIP from the LocalNets configured in the system. When set to No, IP addresses
LocalNets from the LocalNets are ignored for failed attempts.

Lists the addresses that were manually entered to be ignored in regards to
Ignoring Addresses  failed SIP registration attempts

Enter the IP addresses you wish to be ignored by the PBX in regards to
Add Entry failed SIP registration attempts.

Table 58 — PBX Security Log Watch/Ban Settings and Descriptions

Configure Log Watch/Ban Service

P sTEPS:
1 Navigate to PBX Setup=>»General.

2 Scroll down to the Security Settings panel, set the parameters based on your
general business requirements.

3 Click the - > hanees | jtton to save the changes.

4 Navigate to the PBX Setup=>»General page. Locate the Admin Settings section
(located at the top of the page).

5 Enter an IP address for Admin Email Address field. Depending on whether you
have Unified Messaging configured, the PBX will send an email to this address any
time that it bans an IP address. See the Unified Messaging section of this guide for
details on how to configure this parameter.

6 Click the Apply Changes link located at the top right hand corner of the page, to
commit the changes to the database.
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IMPORTANT: Please contact IPitomy’s Technical Support Group

if you need further assistance by email at support@ipitomy.com or
phone 941-306-2200 option 2. You can also search the FAQ page on
our website at www.ipitomy.com.

Disable Log Set Security Setting

D sTEPS:

1 From the PBX Setup=>» General System Setup page, locate the Security Settings
panel.

2 Disable the security setting by selecting “No” from the drop-down list for the Log
Watch Ban Service.

Save Ch
3 Click the -~ = “M8E5 [ ton to save the changes.

4 Click the Apply Changes link located at the top right hand corner of the page, to
commit the changes to the database.

Time Settings Section
Time Settings
Current Systern Time: Tue Jun 15, 2010 2:28:37 P Synchronize

Timezone: LIS/Eastern w

Metwork Time Server

remote refid st £t when poll reach delay offset Jjitter
*cime.nist.gowv LLCTS. 1w 170 256 375 0,969 O.064 1.019
LoZAL (O] LLioCL. 10 1 43 g4 37T O.ooo o.aoo 0.0o01

Figure 85 — PBX Time Settings Section

Sections/Fields Description
Current System This is the current time of the PBX system.
Time

Clicking this button will cause the PBX to sync to the time server. This will
result in a restart of services, interrupting calls. If the time is off by more

Synchronize than an hour, we advise you to reboot the PBX after synchronization.
i This is the time zone for the PBX system.
Timezone
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This is the location of the PBX time server. If nothing is entered in the field,

Network Time the PBX is using the default value of time.nist.gov.

Server
Below the Network Time Server field is a display showing information about
Time Server Info the system’s connection to its time server.
Table 59 — PBX Time Settings and Descriptions
Set Time Settings
P STEPS:
1 From the PBX Setup=>» General System Setup page, locate the Time Settings
panel.
2 Set the Timezone to match your location.
3 If needed, set the Network Time Server to the desired address. Typically the default
value will work.
5 Ch
4 Click the - button to save the changes.
5 Click the Apply Changes link located at the top right hand corner of the page, to
commit the changes to the database.
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Outbound Transfers Numbers Section

This setting allows outside numbers, such as cell phones or land lines, which receive calls through the PBX to
press ## to transfer the call. Once connected, the call can be transferred to someone else at the office or another
number, depending on configuration. Simply ask them to hold, then press ##. After a moment the PBX will say
“Transfer”, after which you can dial the number where the call should be transferred to. Any numbers listed here
will be able to perform this type of transfer.

Use the Transfer Permissions setting to define where calls may be transferred to. Internal Only restricts the
transfers to extensions only. If you set it to an extension, then you can transfer anywhere that extension could,
following the Class of Service for outbound dialing.

Ctbound Transfer Numbers

3204935

3875487
When the specified numbers are

dialed the callee has the option to

transfer using ## The permissions [ add

contral where the call may be

transferred to.

Transfer Permissions | Internal Dnl.y. ¥
Figure 86 — Outbound Transfer Numbers Section
Add Outbound Transfers

D sTEPS:

1 From the PBX Setup=>» General System Setup page, locate the Outbound Transfer
Numbers section.

2 Toin the box to the left of the Add button, enter the phone number you wish to be able to
use this transfer feature. Click Add to move the number to the list. Repeat this step for all
the numbers you want to add.

3 Select the desired permission from the Transfer Permissions drop-down list.

Save Ch
4 Click the - ™= "M% | 1) 4o to save the changes.

5 Click the Apply Changes link located at the top right hand corner of the page, to commit
the changes to the database.

Delete Outbound Transfers

D sTEPS:

1 From the PBX Setup=>» General System Setup page, locate the Outbound Transfer
Numbers section.
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2 From the list of transferable numbers, click on the number(s) that you want to delete. You
can use the SHIFT or CTRL button to select multiple numbers on the list.

3 Click the DEL button. The selected numbers are removed from the list .

Save Ch
4 Click the - ™= "M% |1 4o to save the changes.

5 Click the Apply Changes link located at the top right hand corner of the page, to commit
the changes to the database.

InGenius Connector

InGenius is a 3" party software licensable on the IPitomy PBX. The settings under PBX Setup=»General are
where you would configure the user name and password InGenius. Contact IPitomy for more information.

InGenius Connector Settings
Lser ic

Fassword ic

Figure 87 — InGenius Connector Settings Section
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Database Administration

Create Backup Section

Create Backup

Description:

Categaries:

Create

[ Prompts ¥ Music On Hold 4] Database
M License Cvoicemail OLogs

Sections/Fields

Description

Categories

Create

Creating a Backup
P STEPS:

Figure 88 — Create Backup Section

Description

Use this field to enter keywords to identify what the backup you are making
pertains to.

This is the types of files that you want to create backups for. Select the
desired type by clicking in the box to the left of the item. This will place a
checkmark next to the item. Available categories are:

Prompts

Music On Hold
Database
License
Voicemail
Logs

Clicking the Create button will generate a backup file on the PBX containing
the information selected under Categories.

Table 60 — Create Backup Settings and Descriptions

1 From the PBX Setup=»Database Administration page, locate the Create Backup

section.

2 From the Create Backup section, enter the keywords in the Description field for the
backup file you want to create.

3 Select the categories you want included in the backup.

4 Click on the CREATE button to create the backup file.

5 Scroll down to the Date/Time section of the Database page. The backup file that was
just created will appear at the bottom of the list with the corresponding date and time the
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backup was made. Use your mouse to hover over the date and time field and the
keywords entered will be displayed.

Automatic Backups Section

With this feature, you can have the PBX automatically create backups at a set interval, as well as send

those backups to an external FTP. The system will only store a total of 4 automated backups at any given
time, overwriting the oldest when a new on is created.

Automatic Backups

Enabled: Yes ¥
Backup Categories MPrormpts M Mosic On Hold 4] Database
Mvaicernail M License ] Logs
Schedule: YWeekly v
FTP Backups Enabled: Mo v
FTP Semer:
FTF Directory:
User:
Fassword:
Save Test Settings

Sections/Fields

Enabled

Backup Categories

Figure 89 — PBX Database Automatic Backups Section

Description

If Enabled (set to YES), a backup will be performed automatically based on
the interval set under Schedule.

This is the types of files that you want to create backups for. Select the
desired type by clicking in the box to the left of the item. This will place a
checkmark next to the item. Available categories are:

Prompts

Music On Hold

Database

License

Voicemail

Logs

This is the frequency for which you want the automated backup to be

Schedule performed. Options are Daily, Weekly and Monthly.
If Enabled (set to YES), the PBX will send automatic backups to the
FTP Backups configured FTP server
Enabled
This is the FTP server address that the FTP backup will be stored.
FTP Server
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This is the FTP directory on the server where a backup will be stored.

FTP Directory

Enter the Username required to write files to your FTP
User

Enter the password associated with the Username used to access your FTP
Password

This button will save the changes made to the automated backup settings.
SAVE Button

This button will initiate a test to validate the FTP server, directory, username,
Test Settings and password. A message will display the success or failure, and if
Button successful, a test file will be placed on the FTP

Table 61 — PBX Database Automatic Backup Settings and Descriptions

Set Automatic Backup

D SsTEPS:
1

Upload Backup

From the PBX Setup=»Database Administration page, locate the Automatic Backup
section.

Enabled the Automated Backup process by setting the Enabled field to “YES”.
Select the Category that you want to have backed up.
Set the Schedule to the desired interval.

Enter FTP parameters and Username and Password if you want the backup to be sent
to an external FTP.

Click the Save button to save the settings.

Click on the Apply Changes link at the top of the page to save the information and
commit the changes to the database.

Click the Test Settings button to validate the automated backup settings. You should
receive a backup “Successful” message. If the setup test failed, you receive an “Error”
with a message indicating what parameters failed.

Make the necessary adjustments to the backup parameter, Save, Apply Changes, and try
the test again.

File Section

This feature allows you to upload backup files to the PBX system.

Upload Ba

ckup File

2011 Copyright © IPitom
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Upload Backup Files
>STEPS:
1 From the PBX Setup=»Database Administration page, locate the Upload Backup File
section.

2 Click on the Browse button to search for the file you want to upload.

3 Double click on the file that you want to upload. The file directory will appear in the box
next to the Browse button.

4 Click on the Upload File button to initiate the upload process. You should receive a
message stating that the upload was “Successful”. If the upload process failed you will
receive an “Error’ message indicating what failed during the process.

Backup Storage Section

The bottom of the Database Backup page lists the backup files that are stored on the PBX. The list will provide
the following information for each backup file created:

Sections/Fields Description

The Date and time the backup was created. If you mouse over the date/time
for a particular entry, a tooltip with further information like categories and

Date/Time description will display. An asterisk denotes the backup was created by the
automated backup feature.

Version of the database when the back up was created.

Version
. The size of the backup file.
Size
@ Delete Backup
Action @ Restore Backup
@ Download Backup
Table 62 - Saved Backups
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DateTime Version Size Action

May 23, 2010 4:22 AM* 1.0.39 13 ® @ ®
May 30, 2010 4:22 AM* 1.0.39 13 ® @ ®
Jun OB, 2010 4:32 AM* 1.0.39 1M ® @ @
Jun 13, 2010 4:22 AM* 1.0.39 a2 ® @ ®
May 21, 2010 2:40 PM 1.0.39 1228 ® @ ®
May 21, 2010 4:43 PM 1.0.39 13.2 ME ® @ ®
May 27, 2010 1:12 PM 1.0.39 137 ® @ @
Jun 08, 2010 2:22 PM 1.0.39 13358 2 2® @ @
Jun 10, 2010 10:25 A 1.0.39 133 ® @ @

* Denotes an automatic backup.
Figure 91 — Backup Date/Time Information
Delete Backup File

D SsTEPS:

1 From the PBX Setup=»Database Administration page, scroll to the bottom of the page
to find the backup files stored on the PBX.

2 Find the backup file that you want to delete.

3 Selectthe @ icon to the right of the backup file name. The file is removed from the list.
4 Click on the Apply Changes link at the top of the page to save the information and

commit the changes to the database. This will permanently remove the backup file from
the server.

Restore Backup File

D SsTEPS:

1 From the PBX Setup=»Database page, scroll to the bottom of the page to find the
backup files stored on the PBX.

2 Find the backup file that you want to restore.

3 Selectthe @ icon to the right of the backup file name you want to restore.

4 A box will appear prompting you on which values you wish to restore. Select per your
needs, and click Restore.

5 Click on the Apply Changes link at the top of the page to save the information and
commit the changes to the database.

2011 Copyright © IPitomy Communication, LLC 165 v4.0.1
www.ipitomy.com



IPiTomy

IPitomy IP PBX Admin Guide SMARTER BUSINESS COMMUNICATIONS

Download Backup File

D STEPS:

1 From the PBX Setup=»Database Administration page, scroll to the bottom of the page
to find the backup files stored on the PBX.

2 Find the backup file you want to download.

3 Select the @ icon to the right of the backup file name. The system will ask you whether
want to open or save the file. Choose Save.

4 Depending on your browser settings, you may have to define where the file should be
downloaded to.

Voicemail Setup

This page is used to configure global voicemail box settings, interact with the voicemail archive, as well as
configuring the PBX to send out email notifications.

General Settings Section
Used to configure global mailbox settings that are not found elsewhere in the PBX.

General Settings

Max Mumber of Messages: 100
Max Message Length: 180
Min Message Length: 3
Max Greeting Length: B0
Max Seconds of Silence: 10
silence Threshald: 128

Figure 92 — PBX Voicemail General Settings Section
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Sections/Fields

Max Number of
Messages

Max Message Length
Min Message Length

Max Greeting Length

Max Seconds of Silence

Silence Threshold

Description

Maximum number of messages allowed for a voicemail box. Default
value is 100.

Maximum length of a message in seconds. Default value is 180.
Minimum length of a message in seconds. Default value is 3.

Maximum length of a greeting in seconds. Default value is 60.

Maximum seconds of silence before the message is considered
complete. Set this to zero for an infinite time period. Default value is
10.

When using the maximum Seconds of Silence setting, it is sometimes
necessary to adjust the silence detection threshold to eliminate false
triggering on background noise. The higher the number, the more
background noise is needed to break the silence. Default value is 128.

Table 63 — PBX General Settings and Descriptions

Set General Voicemail Settings

D sTEPS:

1 From the PBX Setup=>»Voicemail Setup page. Scroll to find the General Settings

section.

2 Set the General Voicemail parameters base on your business. In most scenarios, the
default settings are fine.

3 Click the Save button to save the settings.

4 Click on the Apply Changes link at the top of the page to save the information and
commit the changes to the database.

Voicemail Menu Section

Configure settings that an individual voicemail box can follow globally.

Voicemail Menu

Flay Ervelope Message:
Say Caller 1D

Skip ms on playback:

Wax Failed Login Attempts:

On Delete, play next msy:

Yes @ Mo O

Yes @ No O

B . Allow Review WMode Yes O No @
3000 Allow Operator fes O Mo @&
3

Yes @ Mo O

Figure 93 — PBX Voicemail Menu Section
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Sections/Fields

Play Envelope
Message

Say Caller ID

Skip ms on
playback

Max Failed Login
Attempts

On Delete, play next
msg.

Allow Review Mode

Allow Operator

Description

Play the envelope message (date/time) before playing the voicemail
message. Default value is Yes.

Play the Caller ID information prior to the message, if available. Default
value is Yes.

This setting defines an interval in milliseconds to use when skipping forward
or reverse while a voicemail message is being played. Default value is
3000.

The number of retries a user has to enter voicemail passwords before the
PBX will disconnect the user. Default value is 3.

Defines if the PBX will automatically play the next message after deleting a
voicemail message. Default value is Yes.

Global setting that defines if callers are able to listen to a message they left,
and then decide if they want to re-record it or leave it as it is. Default value
is No.

Global setting in regards to if a voicemail box allows callers to press “0” to
reach the System Operator

Table 64 — PBX Voicemail Menu Setting and Descriptions

Set Voicemail Menu Options

D sTEPS:

1 From the PBX Setup=>»Voicemail Setup page, locate the Voicemail Menu section.

2 Set the Voicemail E-mail parameters base on your business requirements. Typically the
default setting will work.

3 Click the

Save Changes .
button to save the settings.

4 Click on the Apply Changes link at the top of the page to save the information and
commit the changes to the database.
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E-mail Settings Section

This section is used to define the email address and server the PBX will use to send out Unified Messaging and

notification emails. Unified Messaging allows a user to receive emails whenever they receive new voicemail

messages. If the PC where you check your email has the capacity to play .wav files, the you will be notified when
an email is received, and will be able to listen to the new message directly from the email. Notification emails are
sent out for features like Log Watch/Ban.

Sections/Fields

Voicemail as
Attachment

From Address

Voicemail Server

E-mail Settings

Yoicemail as Attachrment: Yes ® No O

From Address: voicemail@youremail. com
Yoicemail Server: loc O Ext @

oerer Address: smtp. yourserver. net

ool Support: Yes O No @

mervar Port:

Authentication Required: Yes @ Mo O

Llzer Name: email

Password: reccceee

Test Settings

Figure 94 — PBX Voicemail Settings Section

Description
Defines if new voicemail messages will be attached and set in an email.

The email address to be used in the From address of the voicemail
message. . Note: Most providers require that this is set to the address of the
account used for sending the messages.

Allows voicemail services to be provided by an external server. It is not
recommend to use the “Loc(local)” setting. This setting will be removed in a
future release.

This is the mail server address. Enter either a fully qualified host name or an

Server Address IP address.
Enable if the email server uses SSL encryption.
SSL Support
If the email server uses a port other than 25, define that port here.
Server Port
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L Defines if the email server requires a username and password to gain
Authentication access and send messages.
Required
The user name associated with the use of the external email server.
User Name
The external email server password.
Password
Table 65 — PBX Voicemail Settings and Descriptions
Set E-mail Settings
P sTEPS:

1 From the PBX Setup=>»Voicemail Setup page, scroll to find the Email Settings section.

2 Set the Voicemail E-mail parameters base on your business requirements or what is
recommended by IPitomy.

3 Click the Save button to save the settings.

4 Click on the Apply Changes link at the top of the page to save the information and
commit the changes to the database.

Test Settings Button
P STEPS:
1 From the PBX Setup=>»Voicemail Setup page, locate the E-mail Settings section.

2 Located at the button of the E-mail Settings section is the Test Settings button. Click on
this button to generate a test of the email settings entered.

3 The “Email to send a Test message to:” window appears. Enter the email address that
you want the test message sent to then click the OK button.

The page at http://72.64.129.43 says:

6 Email ko send a Test message ko

[ ok l I Cancel

4 If the email setting and address is valid, you will receive a “SENDEMAIL Successfull”
message at the button of the Test Settings button. The email recipient that was entered
will also receive an email with a subject titled “Voicemail Server Test”.

5 If the email setting test failed, you will receive an “Error!” message at the button of the
Test Settings button. Check the message for hints as to what caused the failure (ie. SSL
enabled but not needed).
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6 Reconfigured the email parameters per the Set Email Settings steps above, then test
again.

-

z@‘: Refer to the Extension Settings Section for information on configuring email
addresses for Unified Messaging. Refer to the PBX Admin ®General Section for
information on configuring email addresses for Log Watch/Ban.

Voicemail Archive Section

Use this section to view which mailboxes currently have voicemail messages, and to download, upload, or erase
the voicemail messages archived on the PBX.

Voicemail Archive

Size: Envelopes 438 kB Recordings: 41.5 MB(07:25:33) Total: 42 mE

List Mailboxes Using Space

Download Erase Upload

Figure 95 — PBX Voicemail Archive Section

Sections/Fields Description
Displays the amount of space being used on the PBX for voicemail
Size messages (Envelopes), greetings (Recordings), and the total.
. . ) Clicking on this box will display the list of mailboxes and the number of
lé;fat élgallboxes Using voice messages stored for each.

This allows you to download a backup of all user voicemail messages,
Download Button message envelopes and greeting files to your computer.

Deletes all user voicemail data on the PBX, including personal
Erase Button greetings.

Used to upload a previously downloaded voicemail archive.

Upload Button ‘:: IMPORTANT: Uploading a voicemail archive will overwrite
existing voicemail files on the PBX.

Table 66 — PBX Voicemail Archive Settings and Descriptions

Download Voicemail Archive Settings

D sTEPS:

1 From the PBX Setup=>»Voicemail Setup page, locate the Voicemail Archive section.
2 Click on the Download button. Select Save File if prompted by your browser.

3 Define the location you wish to save the file if prompted by your browser.
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Erase Voicemail Archive Settings

D STEPS:

1

2

From the PBX Setup=>»Voicemail Setup page, locate the Voicemail Archive section.

Click on the Erase button. The warning message “This will delete all Voicemail
recordings and user greeting. If you are sure you want to do this, click OK.”

Click the OK button to continue. The system performs the erase and returns you to the
Voicemail Setup page.

Upload Voicemail Archive Settings

D sTEPS:

1

2

From the PBX Setup=>»Voicemail Setup page, locate the Voicemail Archive section.
Click on the Browse button to search for the file location of the file you want to upload.

Click on the file that you want to upload. The file directory will appear in the box next to
the Browse button.

Click on the Upload button to initiate the upload process. You should receive a message
stating that the upload was “Successful’. If the upload process failed you will receive an
“Error’ message indicating what failed during the process.

Save Changes

Click the button.

Click on the Apply Changes link at the top of the page to save the information and
commit the changes to the database.

View Voicemail Listing (Usage Space)

el A s

Siza!

Blailias [ FER T

Total

Figure 96 — PBX Voicemail Listing Page
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D sTEPS:

1 From the PBX Setup=>»Voicemail Setup page, locate the Voicemail Archive section.

2 Click the List Mailboxes Using Space link. A listing of the Mailboxes (extensions) and
number of messages for each mailbox appears.

3 Click on the Hide Mailboxes Using Space link to close the listing.

SIP Setup
SIP Networking Settings Section

SIP Networking Settings

Local Metworks & Subnet Masks: 192.1658.1.0/265.266.266.0
192 168.2 0/265.255 2660
192 168.3.0/265.255 2660

Delete Selected

Add Local Metwork: IP Address Subnet Mask
i
Add
External IP: 726412945

Figure 97 — SIP Networking Settings Page

Sections/Fields Description

This is the IP address to the local network and associated subnet

Local Network & Subnet masks.

Masks

Allows you to delete the item selected from list of networks.
Delete Selected

Allows you to add local network information. This information will appear

Add Local Network in the list of networks.
The public IP address associated with the SIP network.
External IP
This button will create/add the network information to the list of local
Add Button network section.
Table 67 — SIP Networking Settings and Descriptions
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Add SIP Networking Settings

P STEPS:
1 From the PBX Setup=>SIP page, locate the SIP Networking Settings section.

2 Enter the IP Address and Subnet Mask for the network the PBX is being installed on.

3 Click the Add button.

4 Click the Save Changes

Click on the Apply Changes link at the top of the page to save the information and
commit the changes to the database.

button.

Delete SIP Networking Settings

P STEPS:
1 From the PBX Setup=>SIP page, locate the SIP Networking Settings section.

2 Highlight the listing you wish to delete. You can use Shift/Ctrl click functionality to select
multiple listings.

3 Click the Delete Selected button.

Save Changes

4 Click the button.

5 Click on the Apply Changes link at the top of the page to save the information and
commit the changes to the database
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SIP Advanced Settings Section

Advanced SIP settings define in more detail the management of network traffic. These settings are automatically
provisioned when the system registers with the router. In most business implementations it is not necessary to
make changes to these defaulted settings
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SIP Advanced Settings

Call Context: |in|:|:|ming |

Allow Guest Calls: Yes @ Mo O

Host/Domain name: | |

UDP Port: 5060 |

Bind Address: 0000 |

Enable DMNS SRY lookup: Yes @ Mo O

Domains: | |
add remove

Allow External Invites: Yes @ Mo O

Auto Dornairn:

¥es O No O nes ®

Enable Pedantic Checking:

v¥es O No @ wea O

SIP TOS:
RTP TOS:
Video TOS:
Wlax Length of Registration: |F2EIEI |
Default Length of Registration: |SEEIEI |

Motify Mime Type:

Time between Mailbox Checks:

“Yoicemaill Extension:

=IP Yideo Support:

Yes @ No O s O
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Fecord History by Default; Yes O No O Mis @
First disallow all Codecs: |a|| |
Allow Codecs:
G.72371 ) |G (ulaw)
G726 G711 (alaw) Up
iLEC || GEM
Speex Drown
LFC10 w
Add Delete
Default Music an Haold: | Support Flaylist V|
Felax dimf handling: Yes @ Mo O
RTP Timeout: 10 |
RTP Timeout on Hald: 5000 |
Trust Remate Party 1D: Yes @ Mo O pis O
Send Remote Party 1D: Yes O No O nia @
Frogress in Band:

User Agent: | |

Allow Redirect to Mon-local SIP address: yes O Mo O pra @

llser = Phone: Yes O Mo O Mis @
DTMF Mode:

Compact 3IF Headers: Yes O No O Mis @
SIP Debug; Yes O No O N2 @

Subscriber Contest: | |

Matify Ringing: Yes @ Mo O
Qualify: 8000 |
Senerate Manager Events: Yes @ Mo O
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External Host:

External Host Refresh:

MAT: VLR

Insecure: Wary w

Can Reimite: Yes O Mo O NA @
Cache Realtime Friends: Yes @ Mo O

Feal Time Update:

Auto-Expire Friends:

Yes O No O Mia ®
Yes © No ©O wa @

lgnore Registration Expiration: Yes O No O WNia ®

Allowe External Domains: ez @ No O

Save Changes

Figure 98 — SIP Advanced Settings Page

IMPORTANT: The default settings for the SIP configuration
should not require any changes. If it is necessary for you to do so
to meet your customer’s business requirements, we recommend
that you contact IPitomy’s Technical Support for assistance.

Sections/Fields

Call Context

Allow Guest Calls

Host/Domain Name

Description/Default Parameters

Default: INCOMING
Default: YES
Default: BLANK

Default: 5060

UDP Port
, Default: 0.0.0.0
Bind Address
Enable DNS SRV Default: NO
Lookup
. Default: BLANK
Domains
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Allow External Invites
Auto Domain

Enable Pedantic
Checking

SIP TOS

RTP TOS

Video TOS

Max Length of
Registration

Default Length of
Registration

Notify Mime Type

Time Between Mailbox
Checks

Voicemail Extension
SIP Video Support

Record History of
Default

First disallow all
Codecs

Allow Codecs
Default Music on Hold

Relax DTMF Handling

RTP Timeout

RTP Timeout on Hold

Trust Remote Party ID

2011 Copyright © IPitomy Communication, LLC

Default: YES

Default: N/A

Default: N/A

Default is CS3. To configure QOS on your LAN, set your
managed switches to prioritize packets flagged with CS3

Default is CS3. To configure QOS on your LAN, set your
managed switches to prioritize packets flagged with CS3

Default is CS3. To configure QOS on your LAN, set your
managed switches to prioritize packets flagged with CS3

Default: 7200

Default: 3600

Default: BLANK

Default: BLANK

Default: BLANK

Default: YES

Default: N/A

Default: ALL

Default: G.711 ulaw, G.711 alaw, GSM

This will display whatever playlist is set to default on the PBX
Setup=>Music On Hold page

Default: YES

Default is BLANK. Set to a value, in seconds, if you wish the
PBX to end a call when no RTP traffic is detected for that
long. Typically used in regards to lines that are not
disconnecting correctly.

Default: BLANK

Default: N/A
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Default: N/A
Send Remote Party ID

) Default: BLANK
Progress in Band

Default: BLANK
User Agent

Allow Redirect to Non- Default: N/A
local SIP Address

Default: N/A
User = Phone

Default: AUTO

DTMF Mode

Default: N/A
Compact SIP Headers

Default: N/A
SIP Debug

. Default: BLANK
Subscriber Context

. L. Default: YES
Notify Ringing
Default: 8000
Qualify
Generate Manager Default: YES
Events
Default is BLANK. When the site is using a dynamic public
IP, you can go to dyndns.com, set up a domain with them,
External Host and enter that domain name here.
Default is BLANK. Set this under the interval used at
External Host Refresh dyndns.com for checking the current IP.
Default: YES
NAT
Default: VERY
Insecure
., Default: N/A
Can Reinvite
. . Default: YES
Cache Realtime Friends
. Default: N/A
Real Time Update
. . Default: N/A
Auto-Expire Friends
Ignore Registration Default: N/A
Expiration
. Default: YES
Allow External Domains
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Table 68 — SIP Advanced Settings and Descriptions

Edit Advanced SIP Networking Settings

P STEPS:
1 From the PBX Setup=>»SIP page, click on the Advanced link.

2 The Advanced SIP Networking Settings page is displayed.

3 Set the SIP Network parameters base on your business requirements or what is
recommended by IPitomy.

-

z@‘: The default settings should not require any changes. If it is necessary for you to
do so to meet your customer’s business requirements, we recommend that you
contact IPitomy’s Technical Support for assistance..

4 Click the | Ve Chanees | . on.

5 Click on the Apply Changes link at the top of the page to save the information and
commit the changes to the database.

Prompts

Prompts are voice recordings used by a Menu to define the options that can be selected in the menu, or to simply
convey information.

Upload Voice Prompt Section

This feature allows you to upload a voice prompt file and store it in the PBX server for use. Once loaded, you can
select which menus you wish to use the Prompt file.

Upload Voice Promp

File Mame: Upload File

Figure 99 — Upload Voice Prompt Section

Upload Voice Prompt

P sTEPS:
1 From the PBX Setup=>»Edit Prompts page, locate the Upload Voice Prompt section.

2 Click on the Browse button in the Upload Voice Prompt section of the page.

3 Specify the location of the voice prompt file you want to upload (the accept file format is
.gsm, the file name should not contain any spaces or special characters)

4 Click the Upload File button.
5 Once the file is uploaded it will be listed in the Prompt Files on Server section.

6 Click on the Apply Changes link at the top of the page to save the information and
commit the changes to the database.
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Record New Voice Prompt Section

This feature allows you to record a new voice prompt and store on the PBX server. Once created you can define
which menus you wish to use the Prompt file.

Record New Voice Prompt

Frompt Marne: Extension: Record

Figure 100 — Record New Voice Prompt Section

Record New Voice Prompt

D sTEPS:

1 From the PBX Setup=>»Edit Prompts page, locate the Record New Voice Prompt
section.

2 Enter a description in the Prompt Name and the Extension number of the person who
will be recording the prompt.

3 Click on the Record button. The system will display a message stating that it is trying to
call the extension. When the connection is successful, the phone at that extension will
ring.

4 Answer the call and record the message. Be sure to follow the in-call directions through
till the system says ‘Goodbye”.

5 When you have completed the recording, press the Continue button. The system will
return you to the Edit Prompts page.

6 Click on the Apply Changes link at the top of the page to save the information and
commit the changes to the database.
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Prompt Files on Server Section

All record prompt files are stored on the PBX server and will appear in the Prompt Files on Server listing of the
Edit Prompts page.

Prompt Files on Server

File Name Size Delete  Download
1-zec-silence. gsm 1650 ® ®
I EL 1650 ) ®
aable.gsm F722 ) ®
AnimalHealth_day_1-2.gsm 40491 ) ®
Christmas. gsm 16396 ) ®
enter-ext-of-person.gsm 4520 ) ®

Figure 101 — Prompt Files on the Server Section

Delete Prompt Files on Server

P sTEPS:
1 From the PBX Setup=>»Edit Prompts page, locate the Prompt Files on Server list.

2 Select the @ icon to the right of the prompt file, listed under the File Name column, that
you want to delete. The file is removed from the list.

3 Click on the Apply Changes link at the top of the page to save the information and
commit the changes to the database.

Download Prompt Files on Server

P STEPS:
1 From the PBX Setup=»Edit Prompts page, locate the Prompt Files on Server list.

2 Select the @ icon to the right of the prompt file, listed under the File Name column, you
want to download.

3 Specify the location where you want to download voice prompt file. Once the download is
complete, the system will return you to the Edit Prompts page.

4 Click on the Apply Changes link at the top of the page to save the information and
commit the changes to the database.
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Music on Hold

The PBX allows you to create multiple play lists that can be populated with music files. Once a playlist is
configured, you can define for this to be the System Default Hold music, or specify to use this playlist under
individual Extensions, Groups, or Menus.

Systems Default Music on Hold Section

Systems Default Music on Hold

Suppor Flaylist » Set Default

Figure 102 — System Default Music on Hold Section

Set Default Music on Hold Section

D sTEPS:

1 From the PBX Setup=>»Music on Hold page, locate the Systems Default Music on
Hold section.

2 Select the desired Music on Hold Playlist from the drop-down list.
3 Click on the Set Default button.

4 Click on the Apply Changes link at the top of the page to save the information and
commit the changes to the database.
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Create a Playlist Section

Marme:

1. Create a Playlist [zave playist before uploading music files)

Randaorm:

Save Changes

2. Upload Music Files

Music Files on Server Actions

moh-beethoven. gsm )

Beethoven

Yes O Mo ®

Upload File

Figure 103 — Create a Playlist Section

Add New Music on Hold
P STEPS:

1 From the PBX Setup=»Music on Hold page, locate the Create a Playlist section.

2 Enter a single word description of the playlist in the Name field.

3 Set the Random preference to either YES or NO.

4 Click the Save Changes button to save the changes.

5 Click on the Apply Changes link at the top of the page to save the information and

commit the changes to the database.

6 The new Playlist name is added to the playlist on the Music on Hold page.
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Upload Music Files

Name Play Mode Random Action

Beethoven files no ’ ®

Rock files ho ’ ®

jazz files no ’ ®

Christmas files yes ’ ®

Ringing files no ’ ®

Suppaort Playlist files ho ’ ®

Figure 104 — Music on Hold Playlist

The following steps describe how to upload Music on Hold file to the PBX system.

D SsTEPS:

1

From the PBX Setup=»Music on Hold page, locate the Name of the Music on Hold
playlist you wish to upload the music file to.

5]

Click on the Name link from the list of Music on Hold files or the - icon to the right of
the name.

The Edit Music on Hold page appears. Click on the Browse button in the Upload
Music on Hold section of the page.

Specify the location of the music file you want to upload (accept formats are .mp3, .wav
or .gsm) to the PBX system then click the Upload File button.

Save Ch
Click the | ' "MMEE% [ ) tton to save the changes.

Click on the Apply Changes link at the top of the page to save the information and
commit the changes to the database.

Delete Music Files on Server

D SsTEPS:

1

From the PBX Setup=»Music on Hold page, locate the Name of the Music on Hold file
that you want to delete.

Select the @ icon to the right of the music file Name that you want to remove. The file

2
name is removed from the list of music files.
) Save Changes
3 Click the & button to save the changes.
2011 Copyright © IPitomy Communication, LLC 186 v4.0.1

www.ipitomy.com



IPiTomy

IPitomy IP PBX Admin Guide SMARTER BUSINESS COMMUNICATIONS

4 Click on the Apply Changes link at the top of the page to save the information and
commit the changes to the database.

Feature Codes

This section lists a number of basic codes users can dial from their phone to access certain features on the PBX.
Additionally, at the bottom of the page you can find a section that allows for configuration of System Speed Dials.

Speed Dialing Section

Speed Dialing
Extensions 00 to 98

Extension Label Numhber Action Add / Edit Speed Dial
175 Office Max 8417580436 T ® Extension
76 SRQ Chamber 0419558187 T ® Label
O77 Wintalk BOE2658577 T ® PSTM number
078 Scatt Merrill 9413062200 T ® B
79 Bria Wilson 9419553000 T ®

Delete Selected

Import/Export List {CSW)
Import Export
Figure 105 — Features Code Speed Dialing Section
Sections/Fields Description
Enter a 2 digit code between 00 and 98. This is the code the user will
Extension enter to access the speeddial.
Label Enter a recognizable value that relates to the number being dialed
This is the phone number that will be dialed when the code is dialed.
PSTN number Only enter digits that could be dialed from a phone (numbers, *, #).
Table 69 — Features Code Settings and Descriptions
Add Speed Dialing
P STEPS:

1 From the PBX Setup=>»Feature Codes page, locate the Speed Dialing section.

2 Enter the Extension number, Label name and PSTN number for the speed dial in the
Add/Edit Speed Dial section.

3 Click on the Save Entry button to save the information. The system will create the speed
dialing code and it will appear in the listing.
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4 Click on the Apply Changes link at the top of the page to save the information and
commit the changes to the database.

Edit Speed Dialing

P STEPS:
1 From the PBX Setup=>»Feature Codes page, locate the Speed Dialing section.

-

2 Click onthe ¢ icon to the right of the speed dial code you want to edit. The information
for the speed dial code will appear in the Add/Edit Speed Dial section.

3 Edit the necessary information then click on the Save Entry button to save the
information.

4 Click on the Apply Changes link at the top of the page to save the information and
commit the changes to the database.

Delete Speed Dialing

P STEPS:
1 From the PBX Setup=>»Feature Codes page, locate the Speed Dialing section.

2 Selectthe ® icon to the right of the speed dial code you want to remove. To remove
multiple speed codes at one time, click on the box to the left of the codes then click the
Delete Selected button.

3 The file name is removed from the list of speed dial codes.

4 Click on the Apply Changes link at the top of the page to save the information and
commit the changes to the database.

Import/Export Speed Dialing List (CSV)

P STEPS:
1 From the PBX Setup=>»Feature Codes page, locate the Import/Export List section.

2 Click on the Browse button in that section of the page.

3 Specify the location of the file you want to import from or export to and then click the
appropriate function button (import or export).

4 The system will perform the function you selected and will tell you whether it was
successful in the attempting to process the request.

5 Click on the Apply Changes link at the top of the page to save the information and
commit the changes to the database.
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Services
System Information Section

System Information

system Software Mersion: 3.2 (cfd227 dda? d473d349adb5dfebffl 24 e2ebdbd 02
RAID Status: Ok i | i |

O O
| | | |
. | | (i |
| | = *5
| LY = s
R Ik

Licensed to: IFitormy

Licensed extensions: A00

semice Tag : |Testing

Host [D: | LO18501 CE230301

system Kay:

—————— SERVER ADAFPTER DATA ————-—

UYWeU940mF 4762 U3 kp2p i FEUTAGYNO 7

UuBdzjIHLHEeExHi/ qorkj7i0D5isEL1

035elixsSRepclin

Download License Info

Figure 106 — Services System Information Page
Sections/Fields Description
System Software This is the software version that is running on the PBX system.
Version

Defines the status the system Raid (if it has one). RAID is Redundant
Array of Independent Disks. RAID is available in Software and Hardware

RAID Status versions. 1100 and 1200 systems can only deploy SW RAID. 2000 and
5000 systems are typically deployed using Hardware RAID.

. Displays the name of the company the PBX is licensed to.

Licensed to

Displays how many extensions the system is licensed for. If you try to
create more extensions they the PBX has licenses, a warning will
display to alert you. There are licenses for both IPitomy branded
telephones and non-IPitomy branded telephones. Telephones are
assigned the correct license automatically.

Licensed extensions

) Unique serial number for the PBX, used when licensing the system.
Service Tag
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Unique ID used for licensing the system.
Host ID
Unique key used for licensing the system.
System Key

Clicking this button will save a text file on your PC. This file contains the
Download License Info Unique ID, Serial, and Key of the PBX. Be sure to email this file along
Button with your purchase order when buying additional licenses,

Table 70 — Services System Settings and Descriptions

View System Information

D SsTEPS:

1 From the PBX Setup=>Services page, locate the System Information section.

2 Use the table of settings and their description for an explanation of how the system is
configured.

License Information Section

This feature allows you view what licensed features are available on the system. You can upload or download
licenses for the PBX applications. You can also assign Call Manager licenses to users. The following section
describes how to perform these functions.

Features: ACD

Desktop Call Manager Licenses:

Uzers: O

Agents: 0 Assign User Licenses
Cperatars: 0

ClueueManagers: O

License Fila:
Upload File Download File
Figure 107 — Services Download License Information Section
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Sections/Fields

Features

Desktop Call Manager
Licenses

License File

Upload License File
P STEPS:

Description

Defines which additional features are licensed on the system. Available
features are:

ACD

InGenius
Multisite

Call Scheduling

Displays how many of each Call Manager member type are licensed on
the PBX. Currently Operator and User are the only functional license.

Clicking the Assign User Licenses button will open a new window for

assigning call manager licenses.

In this panel you can download the current license file, or upload a new
license.

Table 71 - License Info Descriptions

1 From the PBX Setup=»Services page, locate the License Info section.

2 Click on the Browse button in that section of the page.

3 Specify the location of the file you want to upload, then click Upload File button.

4 The system will log you out of the PBX.

5 Log back into the PBX.

6 Click on the Apply Changes link at the top of the page to save the information and
commit the changes to the database.

Download License File

D SsTEPS:

1 From the PBX Setup=»Services page, locate the License Info section.

2 Click the Download File button.

3 Your browser may prompt you as to where you wish to save the file.
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Assign IPitomy User licences

[] Name Ext. Number User Type

O Judy Garland 111 Unassigned |+
O Tiger Woods 113 Unassigned |+
] Donna Adams 186 Unassigned |+
. cheavers 201 Unassigned v
O Roger Townsend 204 Unassigned |+
] John Wayne 230 Unassigned v
] E. 2207 Unassigned |+
. 4211 4211 Unassigned v
O Jeff Ulrich - Demo 1 6200 Unassigned |+
O  Barbara Walker 6270 Unassigned |+
] Can Merrill 6280 Unassigned |+
LI Winifred Applegate 6290 Unassigned v

Change Selected:

Unassigned b

Close

Figure 108 — Services Assign Licenses Page

Assign Single User License

D SsTEPS:

1 From the PBX Setup=>Services page, locate the License Info section.

2 Click the Assign User Licenses button. The “Assign IPitomy User Licenses” window
appears. Find the name of the extension that you want to assign the license to. Choose
the desired license type from the drop-down list (User/Operator).

3 Click the Submit button to save the changes. Click the Close button to close the active
window.

5 Ch
4 Click the | ~™& =185 [ ton to save the changes.

5 Click the Apply Changes link located at the top right hand corner of the page, to commit
the changes to the database.

_/@\- If this is the first time a license has been assigned, be sure to return to the servies
page and click the Restart Call Manager button.
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Assign Multiple User Licenses

D STEPS:

1 From the PBX Setup=>»Services page, locate the Download License info section.

2 Click the Assign User Licenses button. The “Assign IPitomy User Licenses” window
appears. Click on the box (place a checkmark) to the left of each of the extensions that
you want to assign the licenses to.

3 Scroll down to the button of the page and select the license type (User/Operator) to
assign to these extensions.

4 Click the Submit button to save the changes. Click the Close button to close the active
window.

5 Ch
5 Click the |7 “"M8EF [ jtton to save the changes.

6 Click the Apply Changes link located at the top right hand corner of the page, to commit
the changes to the database.

System Functions Section
This section allows the administrator to restart some or all services in the PBX, as well as clear the Diagnostic log.

System Functions

Festart PBX Daeman: Restart PBX

Feboot the PBX: Reboot PBX

Restart All Services Restart Services
Restarnt CallManager Daemon; Restart CallManager
Clear Diagnostics Log; Clear Diagnostics

Figure 109 — Services System Functions Section
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Sections/Fields Description

This will stop and restart all asterisk services on the PBX.

Restart PBX Daemon A‘:: ngsgz'll;:«NT: Performing this function will drop all

This reboot the PBX.

Reboot the PBX A‘:: LI(\:{ESZ;III'SANT: Performing this function will drop all

This will restart all services, including asterisk, drivers, and web services
of the PBX.

Restart All Services A‘:: IMPORTANT: Performing this function will drop all
active calls.

This will reinitialize Call Manager Sevices. It will drop any active
instances of Call Manager.

Restart CallManager
Daemon

. . This will clear the Diagnostics logs from the PBX system.
Clear Diagnostic Log

Table 72 — Services System Functions and Descriptions

Restart PBX
D sTEPS:

1 From the PBX Setup=>Services page, locate the System Functions section.

2 Click on the Restart PBX button. All asterisk services on the PBX and return you to the
Services page when it is done.

Reboot PBX
D sTEPS:

1 From the PBX Setup=>»Services page, locate the System Functions section.

2 Click on the Reboot PBX button. The will perform a software reboot, and require you to
log back in when it is done.

Restart Services

D SsTEPS:

1 From the PBX Setup=>Services page, locate the System Functions section.

2 Click on the Restart Services button. The system will restart all the services that are
running and return you to the Services page when it is done.
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Restart Call Manager
P STEPS:

1 From the PBX Setup=> Services page, locate the System Functions section.

2 Click on the Restart Call Manager button. The system will restart process for the
CallManager application and return you to the Services page when it is done.

Clear Diagnostics

D sTEPS:

1 From the PBX Setup=>»Services page, locate the System Functions section.

2 Click on the Clear Diagnostics button. The system will clear all the diagnostic messages
on the PBX server and return you to the Services page when it is done.

Load File System
This area is used to load software files when performing an upgrade.

File System

Load system update file: Load File

Figure 110 - Services Load File System Section

D sTEPS:

1 From the PBX Setup=>Services page, locate the File System section.

2 Click on the Browse button in that section of the page.

3 Specify the location of the file you want to load. The file must have the .tgz file extension.
4 The PBX will load the file, and the PBX will reboot.

5 Upon logging in, a prompt declaring the database version does not match will appear,
Click OK and the database will be converted.

6 Click on the Apply Changes link at the top of the page.
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TFTP Files

This panel allows the administrator to view, load, download, and delete files on the TFTP in the PBX. Typically,
the files you would be loading will be phone firmware files.

TFTP Files
Load this file to tip: Send File
TFTP Files
Figure 111 — Services TFTP Files Section
Load TFTP File
P STEPS:

1 From the PBX Setup=>»Services page, locate the TFTP Files section.
2 Click on the Browse button in that section of the page.
3 Specify the location of the file you want to load onto the PBX.

Download TFTP File

P STEPS:
1 From the PBX Setup=>Services page, locate the TFTP Files section.

2 Click on the blue TFTP Files link. A listing of the files that have been loaded on the TFTP
server will be displayed.

3 Click on the blue link for the file you want to download. Your browser may require you to
specify the location where you want to download the TFTP file.

Delete TFTP File

P STEPS:
1 From the PBX Setup=>Services page, locate the TFTP Files section.

2 Click on the blue TFTP Files link. A listing of the files that have been loaded on the TFTP
server will be displayed.

3 Find the name of the file you want to delete from the list.

4 Click on the Delete button. The file is removed from the list and the system will return you
to the Services page.

2011 Copyright © IPitomy Communication, LLC 196 v4.0.1
www.ipitomy.com



IPiTomy

IPitomy IP PBX Admin Guide SMARTER BUSINESS COMMUNICATIONS

Log File Settings
This feature allows you indicate whether you want the logs to be written to a file or displayed on the PBX
webpage.

Log File Settings
Log to File
Display on Fage

Figure 112 — Services Log File Settings Section

Sections/Fields Description
If selected — the system will write the log messages to the ipitomy.log
Log to File file, accessible by IPitomy Support. Default is enabled.

If selected — the system will display the log messages on the System
. Diagnostics page, accessable by anyone with Administrator access to
Display on Page the PBX. Default is enabled.

Table 73 — Services Log File Settings and Descriptions

Select Log File Settings
P STEPS:
1 From the PBX Setup=>Services page, locate the Log File Settings section.

2 Select (placing a checkmark in the box) the method that you want the log files to be
handled. You can elect to do both, if so desired.

5 Ch
3 Click the | ™= “MMEEF [ jtton to save the changes.

4 Click on the Apply Changes link at the top of the page to save the information and
commit the changes to the database.
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Logging Level Section

This section of the Services page allows you to specify the type of messages that will be captured and available
on the System Diagnostics page.

Lagging Level
L] Information

Warnings

Errors
All
Figure 113 — Services Logging Level Section
Sections/Fields Description
. If selected — the system will log Information level messages.
Information
) If selected — the system will log Warning level messages.
Warnings
If selected — the system will log Error level messages.
Errors
If selected — the system will log all the message types above and some
All other types such as Notice.
Table 74 — Services Logging Levels and Descriptions
Select Logging Level
P STEPS:

1 From the PBX Setup=» Services page, locate the Logging Level section.

2 Select (placing a checkmark in the box) the method that you want the log files to be
handled. You can elect to select all the types, if so desired.

Save Changes

3 Click the button to save the changes.

4 Click on the Apply Changes link at the top of the page to save the information and
commit the changes to the database.
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Call Event Log Section
This allows you to enable web service and indicate the call event logs retention time.

Call Bvent Log
Enable Web Service: |Yes # Faszswoard: [fpOdmDEwEh
Log Retention b Months
Figure 114 — Services Call Event Log Section
Sections/Fields Description

If Enabled (set to YES), the system will allow call events to be polled via

Enable Web Service )
the web service.

Password This is the password that will be used to access the call event log files.

This indicates the number of months that the log files will be retained on

Log Retention the server. Default is 6 months.

Table 75 — Services Call Event Logging and Descriptions

Set Call Event Logging

P STEPS:
1 From the PBX Setup=>»Services page, locate the Call Event Log section.

2 From the Enable Web Service field, select YES to enable the system to start polling the
event logs. Otherwise, select NO if you do not want the system to perform this function.

3 Inthe Password field, enter the password that will be used to access the polling service.

4 Enter the number of months you want to retain the call event logs in the Log Retention
field.

Save Changes

5 Click the button to save the changes.

6 Click on the Apply Changes link at the top of the page to save the information and
commit the changes to the database.
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Automated Phone Firmware Updates

This allows you to set the parameters for the system to perform automated firmware updates. Currently, when
enabled, the PBX will check at midnight to see if there are more current phone firmware files available, and will

download them if they exist.

Atomated Phone Firmware Updates

Enable Firrmware Lpdate Senice: Mo w
Intereal: Daily  »
Check For firrmeeare Mowe Check How

Figure 115 — Services Automated Phone Firmware Updates

The following table provides the parameters and their descriptions for the Automated Phone Firmware
Updates feature.

Sections/Fields Description
Enable Firmware Update If enabled (set to YES), then the system will perform an automated
Service check for firmware updates.

This allows you to indicate how often the system will check for new

Interval firmware. Available internals are Daily, Weekly or Monthly.

Check for Firmware Now This allows you to check for firmware on demand.

Table 76 — Services Automated Firmware Parameters and Descriptions

Set Automated Firmware Update Parameters

D sTEPS:

1 From the PBX Setup=>»Services page, locate the Automated Phone Firmware
Updates section.

2 Set the parameters defining if the system should automatically check for firmware, and
the interval is should check.

Save Ch
3 Click the |~ = “M8E5 [ ) ton to save the changes.

4 Click on the Apply Changes link at the top of the page to save the information and
commit the changes to the database.

Check for New Firmware Now

D SsTEPS:

1 From the PBX Setup=>Services page,
locate the Automated Phone Firmware
Updates section.

Comparing checkswum for IPitomy 550 file
IPFitomy 550 Checksums match. Nothing to do

Comparing checksum for IPitomy 120 file

2 C”Ck on the Check NOW button. The IPitomy 120 Checksums match. Nothing to do
system will display the results once the
process is complete. The following is a
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sample of what the message that will be displayed. This message demonstrates that the
firmware version in the PBX and at IPitomy match.

Scheduled Calling

This is a licensed feature that allows for periodic automated calls to be made by the PBX. This can be used for
announcements, bells, alarms etc.

Scheduled Calling:

Enable Scheduled Calls: | Enabled  » Manage Calls

Figure 116 - Scheduled Calling

Enabling Scheduled Calling

} STEPS:From the PBX Setup=>Services page, locate the Scheduled Calling section.
2 Change the dropdown to Enabled.

Save Ch
3 Click the | = "S5 [ ton to save the changes.

4 Click on the Apply Changes link at the top of the page to save the information and
commit the changes to the database

Select Enabled Name Start End Interval Execiute Target Destination
Fi ] AMarme Jul 19, 2010 Every 1 Weeks on MWW =3a 930 am 201 4444 _
O 1] Bell Aug B, 2010 Aug 31, 2010 Everyday 230 pm 15900 :
[ 1 no_touch  Aog 17, 20010 Augg 24, 2011 Ewveryday 323 pm 4880 1900 ,

Edit Delete

Back To Services

Figure 117 - List of Scheduled Calls
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Sections/Fields

Select

Enabled

Name
Start
End

Interval
Execute
Target

Destination

©
®

Description
Use this column to select which multiple entries to delete or edit.

Displays if the entry is active.
1: Enabled
0: Disabled

Displays the name of the Scheduled Call.

Displays the date which a particular entry is set to start.

Display the date which a particular entry is set to end

Displays information on when the Scheduled Call will take place.
Shows the time the Scheduled Call will happen.

Displays the Number to Call as defined in the Scheduled Call.
Displays the Number to Connect as defined in the Scheduled Call.

Click to edit individual entries.

Click to test an individual entry. A call between the Target and Destination will be
established.

Click to delete individual entries.

Click to edit multiple entries if checked in the Select column.

Edit
Click to delete multiple entries if checked in the Select column.
Delete
Click to create a new Scheduled Call.
Add
Table 77 - Scheduled Call List Descriptions
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Edit Entry

Name [ ]

Date / Time
Start
End

Recurrence

O Daily
O wWeekly
O Monthly

Execute At
Time:
Action(s)
Mumber Ta Call:
Mumber to Connect:
Extension for COS: v

Enable/Disable: v

Sections/Fields

Name

Date/Time

Recurrence

Execute At

Number to Call

Number to
Connect

Extension for

[ Reset ][ submit ]

Figure 118 - Edit Scheduled Call

Description
Enter a name to identify this Scheduled Call.

Define what date and time the Scheduled Call should start and end. You do not
need to set an end time.

Defines the interval the Scheduled Call will take place. Calls can be set to Daily,
Weekly, or Monthly. See the Recurrence table below for more details.

Defines the time the call will take place for each Recurrence.

Defines the entity that will be called.

Defines what destination the called party will be connected to.

Set this to the extension number that is using the Class of Service you wish this
Scheduled Call to use when making outbound calls.

cOoS
Choose Enable for this Scheduled Call to be active, and Disable for it to be
Enable/Disable  inactive.
Table 78 - Edit Scheduled Call Descriptions
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O Everyday
Daily O Every | Days
O Every Weekday

Every = Weekis) on
Wy eekly CmMonday ClTuesday [Clvednesday [ Thorsday
OFriday O Saturday O Sunday

O Day —
ranthiy O The ~ | Week on v
Every = Months
Figure 119 - Recurrence
Sections/Fields Description

Everyday: Will call at the defined Time every day.
Dail Every X Days: Will call at the defined Time every (1-1550) days.
iy
Every Weekday: Will call at the defined Time every M-F.

Every X Weeks on Y: Will call at the defined Time every (1-1550) weeks on the
Weekly day defined.

Day: Will call at the defined Time every (1st-31st) day of the month.

The X Week on Y: Will call at the defined Time on the 1%, 2™, 3™, or 4" week of
Monthly the month on the day defined.

Every X Months: Will call at the defined Time every (1-31) months.

Table 79 - Recurrence Descriptions

Adding a New Scheduled Call

} STEPS:From the PBX Setup=Services page, locate the Scheduled Calling section.

2 If enabled, click the button for Manage Calls, which will take you to the List of
Scheduled Calls page.

Click the Add button.

Configure your new Scheduled Call. If errors are made, you can click Reset to start over.
Click Submit to save.

Click the blue link Back to Services to return to the PBX Setup=»Services page.

o g A W

Save Ch
Click the | ' "MMBE% [ ) tton to save the changes.

Click on the Apply Changes link at the top of the page to save the information and
commit the changes to the database
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Edit a Scheduled Call

} STEPS:Navigate to the List of Scheduled Calls page.

2 Click the vicon to edit an individual entry, or place a check next to multiple entries and
click the Edit button.

3 Make the necessary changes.

4 Click Submit to save.

5 Click the blue link Back to Services to return to the PBX Setup=»Services page.

6 Click the Save Changes button to save the changes.

7 Click on the Apply Changes link at the top of the page to save the information and
commit the changes to the database

Edit a Scheduled Call

} STEPS:Navigate to the List of Scheduled Calls page

2 Click the ® icon to delete an individual entry, or place a check next to multiple entries
and click the Delete button.
3 Click the blue link Back to Services to return to the PBX Setup=»Services page.
4 Click the Save Changes button to save the changes.
5 Click on the Apply Changes link at the top of the page to save the information and
commit the changes to the database
Test a Scheduled Call

} STEPS:Navigate to the List of Scheduled Calls page.

2
3

Click the Q button to test the call connection immediately.

If the call does not work to your end users desires, reconfigure the Scheduled Call and
test again.

REPORTING

Reports

The Call Data Records (CDR) contain information about calls collected from the IPitomy IP PBX for a specified
period of time. The report details the number of calls, call duration, call origination, call destination, and status.

Call Data Records (CDR) can be sorted by specific time periods. CDR may also be exported in the same date
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range format. The records have also been enhanced for easier reading, and comprehension of data. To sort
simply select the date range you wish to be displayed, and then press the view button. The display will be
arranged and sorted according to your date selections.

First <1234567 3591011 = Last

CDR-Report Queue Graphs
CDR Report
Frarm 97202010 To 942172010 View || Export
Date Time Direction Source Destination Trunk Duration Status
Sep 210345 pm Incoming 5551234567 Bill YWood Zap/2-1 00018 ConnectEwvt
Sep 210339 pm Incoming 5551234567 Elaine Blodgett Lapf2-1 00358 AGENT COMPLETED
Sep 210332 pm Incoming 5551234567 Bill ¥Waad Zap/3-1 005486 CALLER COMPLETED
Sep 210339 pm Incoming 5551434567 John Walfe Zap/-1 0:00:03 =
Sep 210333 pm Outgoing John Wolfe 5551234567 Yintalk 000345 AMNSWER
Sep 210336 pm Internal ooy Faul Falanga 0:00:15 MOANSWWER
Sep 210333 pm Internal Tonie Office EJ Donovan 0:02:04 ANSWER
Sep 210329 pm Incoming 5551234567 Mortheast Region Sales  Zapf1-1 0:00:55 TIMECQUT EXIT
Sep 210320 pm Internal Mick Branica Taonie Office 0:07:38 ANEWER
Sep 210323 pm  Internal 5551234567 Testhick - 0:00:18 HAMGLP
Sep 210322 pm Incoming 5551234567 John Waolfe Lapf-1 00549 CALLER COMPLETED
Sep 210322 pm Incoming 9551234567 Elaine Blodgett Lapd3-1 01403 AGENT COMPLETED
Sep 210320 pm Incoming 5551234567 fain henu Zap/2-1 0:00:08 HAMGLP
Sep 21 03:05 pm  Outgoing IPEE0 Two A551234567 Wintalk 001416 AMNSWER
Sep 210309 pm Incoming 5551234567 Aastra Test Mobile Zap/2-1 0:09:00 ANSWER
Sep 21 0317 pm Incoming 5551234567 Support fap/S-1 00102 ABAMNDOMED
Sep 210311 prm Incoming 9551234567 John Wolfe Lapid-1 0:07:54  CALLER COWMPLETED
Sep 21 03:08 pm Cutgoing  Elaine Blodgett 5551234567 “intalk  0:02:20 ANSWER
Sep 210308 pm Internal Tonie Office Aastra Test Mobile 0:00:35 AMNSWER
Sep 21 03:04 pm Cutgoing BlackBox Test 5551234567 “intalk  0:00:01 CAMCEL

Figure 120 — CDR Reports Page
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Sections/Fields

Date/Time

Direction

Source
Destination
Trunk

Duration

Status

Description
The date and time of the call.
Defines where the call originated:
Internal: The call took place entirely within the PBX
Outgoing: An internal entity made a call out a trunk.
Incoming: An external party made a call inbound over a trunk.
The originating party for the call.
The end location for the call.
Defines which trunk was used for the call.
The length of the call in hours:minutes:seconds.
The status describes the final state of a call through the PBX:

Adandoned: Call entered a Queue, but the caller hung up before the
call was answered or met the failover requirement.

ChanUnavail: No channel was able to be created for the call due to a
possible error state for the intended destination.

Agent Completed: Connected Queue call was terminated at the
extension.

Hangup: Call to a Menu, but the caller hung up before taking any
actions.

Caller Completed: Connected Queue call was terminated at the calling
parties end.

Cancel: Call from an Extension, but the caller hangs up before the call
is connected.

Answer: A connected call.

No Answer: A call that met the ring time of an extension without being
answered.

Timeout Exit: Call to a Queue that meets the Timeout.

VM Not Left: Call ended with the caller being sent to voicemail where
they did not leave a message.

VM Left: Call ended with the caller being sent to voicemail where they
left a message.

Transferred: Connected call successfully transferred.
Busy: Call out a trunk returned busy status, or extension was busy.

- : Defines the call is still active, and the status will update when
completed. Click on the call record for details.

Exited Empty Queue: Call to Queue that follows Exit Empty rule.
Exited With Key: Call to Queue that follows the Exit Menu key press.
Table 80 - CDR Report Descriptions
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View CDR Report — Smart Personal Console

IPitomy PBX Software version 3.4.1 and above have the added ability to view CDR Reports and Queue data from
Smart Personal Console (SPC) using a special user name and password.

>STEPS to access CDR and Queue Graphs via Smart Console Console:

v4.0.1

1 Within PBX Administration, navigate to the PBX Setup=>» General page
2 Locate to the General Settings section (second section from the top).
3 Locate the SPC Reports User Password field (bottom of section)
SPC Reports User Password display
4 It may be helpful to change this to a user-friendly password. If you change the password
Save Ch Applv,Ch
besureto | B | ang b
5 Make a note of this password.
6 On the PC that will be used to access CDR Reports and Queue Graphs via SPC, open a
web browser and navigate to the IPitomy PBX login screen
7 Using the right side — Smart Personal Console (User Login) input the word “reports” as
the user name and the password that you noted previously.
Aomin LogiN - Usen LoGIN
Llser Mame; Lser Mame: |repors
Password: Password: -|
Login Login
Logi
8 Clickon o
9 The CDR-Report page is opened, use the instructions below to extract the data you wish.
Or,
. Queue Graphs . . .
10 Click on to open that interface and use the instructions below to extract
that data.
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View CDR Report — PBX Administration
P STEPS:

1 From the Reporting=>»Reports page, click on the CDR Report button. The CDR Report
page appears.

2 Select the From and To date range by click on the box next to the From and To fields.
Use the calendar control page that appears to select the desired dates.

3 Click the View button. A report with call information from the date range parameter that
was entered is displayed.

4 Click on an individual call record and a new window will appear displaying more detailed
information for that call.

Export CDR Report
The Export function will provide you with a tabulated report to download to a PC.

D SsTEPS:

1 From the Reporting=>»Reports page, click on the CDR Report button. The CDR Report
page appears.

2 Enter the date range and retrieve the report that you want to export (see steps for
Viewing Report).

3 Click the Export button then specify the location where you want to download the report.

Queue Graphs

Queue Graphs display additional call information for ACD Queues. A PBX must be licensed for ACD for this
button to appear.

y— I
IPITovy

SMARTER BUSINESS COMMUNICATIONS

Reporting / Queue Reports Logout | Apply Changes

Queue Reports

¥ System CDR-Report | Queue Graphs | Live Queue
v Providers

» Destinations

Queue Graphs
¢ Call Routing
» PBX Setup
. Queue Type Date Time Sorting
* Reporting
Round Robin - Start 211052011 Start 9:00 AM 2 :

Reports -

Diagnostics Stretch Graph End 2/1002011 End 11:59 PM Hour =~
Monitoring

Queue Monitoring :'_ : : : --I-==-

Figure 121 — Queue Graphs Page
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Sections/Fields Description

This is the listing of the queue you want to view. The drop-down list is

Queue Type populated with the various groups that have been configured.

Date This allows you to specify a range of dates for which call records will display.
This allows you to specify a start and end time within the date range for the

Time reporting to display.

) This is the increment with which to sort by. The default increment is 2 hour.
Setting

Move the slider to adjust the size of the graph to meet your viewing
Stretch Graph requirements.

Table 81 — Queue Graphs Search Parameters

Run Queue Graph Report

D sTEPS:

1 From the Reporting=>»Reports page, click on the Queue Graphs button. The Queue
Graphs page appears.

2 Select the Queue Type from the drop-down list.

3 Select the Start and End date using the calendar control that appears when you click on
the date fields. Select the desired Start and End time for the reporting period you want to
search.

4 Change the Sorting parameters to the desired setting.

5 Click the Update button. The system will perform the search based on the criteria that is
specified and display the results.
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Overview Tab

The Overview Tab offers an overall summary of the calls for the period in question for that queue. The
overview will display textual information for answered and unanswered calls, as well as a graph
summarizing the information.

Owerviews | Agents

Zraph Logs

Answered Calls Unanswered Calls

Total Calls: 34

Total Calls: 4

Ay, Call Wait Length: 33,12 Seconds Ay, weait time: 55,25 Seconds

Min i ait Length: 2 Seconds

hdax Wiait Length: 273 Seconds

A, Call Length: 542.3

min Call Length: 9 Seconds

hin Wrait Length: 2 Seconds

M a: Wait Length: 175 Seconds
5 Seconds

fdax Call Length: 2224 Seconds

Sections/Fields

Total Calls

Avg. Call Wait
Length

Min. Wait Length
Max Wait Length
Avg. Call Length

Min. Call Length

Figure 122 — Reports Queue Graph Overview Tab

Description

Total number of calls answered, or unanswered.

An average of the wait time for calls answered, or unanswered.

Shortest wait time for calls answered, or unanswered.
Longest wait time for calls answered, or unanswered.
Average duration of an answered call.

Shortest duration of an answered call.
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Longest duration of an answered call.

Max Call Length
Agents Tab

Owerview  Agents

Agent Information

Agent Name

John WWalfe
Mikee Lunn
Mike Cell Ext
Victor Hassab

raph

Queue
22457 -2
1.22.20-@
0:00:00-9
1.20:04 - &

Logs

Inbound
0:08:29- (3
0:00:00- 1
0:00:00- 1

)
)
)
00000 - im

The Agents tab displays details for queue members.

Sections/Fields

Queue

Chrthound
01757 -@E
0:00:00-m
0:00:00-m

)
)
)
00106 - (1

Description

Internal
0:00:00-m
0:23:30-3
0:00:00-m

)
)
)
00000 - @m

Figure 123 — Reports Queue Graphs Agents Tab

Pause Time
£ 0000
£ 0000
£ 0000
£ 0000

Time spent on queue calls. Number of calls displayed in parenthesis.

Time spent on inbound, non-queue calls. Number of calls displayed in

Inbound

parenthesis.

Time spent on outbound, non-queue calls. Number of calls displayed in

Outbound

parenthesis.

Time spent on internal, non-queue calls. Number of calls displayed in

Internal

Time spent paused out of the queue. Number of calls displayed in
parenthesis.

Pause Time

parenthesis.
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Graph Tab

The Graph Tab provides a graphical view of queue calls only. Inbound and outbound calls are tabulated
but not graphed. The graph tab divided into time segments defined by the Sorting setting set previously.
The information presented in this tab will allow you to determine busiest times and when call coverage is

most needed.

Overyview

Agents

Graph | Logs

Every 2 hour(s) starting from - 06/21/10

Logs Tab

Figure 124 — Reports Queue Graphs Tab

The Logs Tab will display the complete call log for the queue from your search setting. It will display the
time of the call, the direction of the call either inbound or outbound, the caller ID that was delivered with
the call, the location that the call was delivered to, the wait time for the caller, the total duration of the call,

and finally the outcome of the call or the final status of the call. See the table for CDR Report

Descriptions for detailed information about the fields.

Owerview  Agents | Graph
ACD Details

Time Direction From
Jun 21 09:47 am Incoming  unknown
Jun 21 10:14 am Incoming 6135915000
Jun 21 10:45 am Internal 21158
Jun 21 11:01 am Outgoing  John Waolfe
Jun 21 11:09 am Incoming 8454940143
Jun 21 1110 am Incoming 9095333972
Jun 211127 am Incoming 4409421900
Jun 21 11:33 am Incoming 5513338003
Jun 21 1145 am Incarning 7187057451
Jun 2111048 am Outgoing  John YWolfe

Logs

To

John ¥Wolfe
John Walfe
John Wolfe
25257101
John ¥Wolfe
Wictor Hassah
Wictor Hassab
Mike Roaming™
Wictor Hassah
3713930

Wait Length Duration

0:00:04
0:00:20
0:o0:12
0:00:00
0:00:16
0:00:05
0:00:07
0:00:12
0:00:08
0:00:00

0:01:23
01352
0:04:55
0:03:17
0:09:45
0:08:13
0:04:41
0:10:27
0:30:02
0:00:51

Outcome

AGENT COMPLETED
AGENT COMPLETED
AGENT COMPLETED
ANZWER
AGENT COMPLETED
AGENT COMPLETED
AGENT COMPLETED
CALLER COMPLETED
AGENT COMPLETED
ANZWER
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Diagnostics

This section, when configured under PBX Setup=»Services, displays a message log of actions in the PBX.
Typically this page will be referenced by Tech Support to pinpoint where troubleshooting for a specific problem
should begin.

[ry——
IPITomvy

SMARTER BUSINESS COMMUNICATIONS

Reporting / Svstem Diagnostics Logout | Apply Changes
System Diagnostics
} System 12345678910 =Last
¥ Providers
¥ Destinations Message
» Call Routing [2011-02-10 12:28:11] ERRORI[2581] codec_dahdi.c; Failed to open /devidahdifranscode; Mo such file or directory
» PBX Setup ) i
[2011-02-10 12:28:11] NOTICE[2674] chan_sip.c: Peer ‘4201 is now Reachable. (17ms / 8000ms)
- Reporting
: [2011-02-10 12:28:10) MOTICE[2674] chan_sip.c: Peer '4200"is now Reachable. (19ms / 8000ms)
eports
ﬂag'f':5¢5 [2011-02-10 12:28:10] NOTICE[2674] chan_sip.c: Peer'4240 is now Reachable. (20ms / 8000ms)
OMtonng

Queue Monitoring [2011-02-10 12:28:10] NOTICE[2674] chan_sip.c: Peer ‘4203 is now Reachable. (18ms / 8000ms)

[2011-02-10 12:28:10] NOTICE[2581] app_gueue.c: The roundrobin’ queue strategy is deprecated. Please use the ‘rrmemory’ strategy
instead.

[2011-02-10 12:28:09] WARMING[2581] res_smdi.c. No SMDI interfaces are available to listen an, not starting SMDI listener.

[2011-02-10 12:28:09]) MOTICE[2581] res_smdi.c: Unable to load config smdi.conf: SMDI disabled

Figure 126 — System Diagnostics Page

View System Diagnostics

P STEPS:
1 Click the Reporting=>»Diagnostics link on the Admin Page.

2 The System Diagnostics page appears displaying the messages that have been
processed and their status.

3 The type of message that is displayed on this page is set in the Logging Level section of
the Systems page.
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Monitoring

This page gives a snapshot of the status of your SIP network. Extensions, SIP Providers, Branch Offices, and
active calls will display. Entries in Green are connected, entries in Red are unable to be reached, and entires in

Grey are not present. At the bottom of the page, active calls will display on a channel by channel basis. The

page will refresh every 10 seconds.

=P

hooount
111
113
156
zZ01
204
230
2207
4211
200
B270
G280

6220

BEranches:

Hame/ Tsername
New York/New Yo
Houston/Houston

deattle/3eattle

Channels:

Channel

0 active calls

3 laxz peers [0 online,

0 active channels

Lddress
[Tn=pecified)
[Tnspecified)
[Tnspecified)
[Thspecified)
[Mnspecified)
[Tnspecified)

97.96.45.119
[Tn=pecified)

174.22.165.81

[Tnspecified)
[Thspecified)

[Th=specified)

Location

Fort Status=

o T ETOW
o TN ECOW
o TN ELCOW
o T ET O
o T E O
o T E O
5060 CK (119
o T ETOW
EOg0 OK (136
o TN ECOW
o T ET O

] TITETIOT

Itate

ma)

ms)

SIP Trunk/siplines 216.146.210.100 5060 UNRELCHAELE

Host Mazsk Fort Acatus

[Mhepecified) () 2E5E5.25E5.2Z55.ZE5 O [T TMEI QW

105.26.45.11 (%) 25E5.ZEL.ZEE5.ZEE 4582 (T THNRELCHALELE

11.123.15.2 [3) 255.255.255.255 4569 THNRELCHAELE
3 offline, 0 ummonitored]

LApplication(Data)

Figure 127 — Monitoring Page
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APPENDICES
Appendix 1: Key Types and Codes

This table describes the function of each key type, and how to manually configure them. It is not advised to
manually configure unless the phone is in a situation where you cannot easily use the PBX to set the keys
(ie: remote phones). Unless specified, the Line field when manually configuring should be set to All.

Key Type Description

Can be set to an extension or park orbit. Pressing the key will call the extension or
retrieve a call from the park orbit. When an extension is ringing the light will flash,
and when an extension is connected to a call, the light will be solid. Park BLF keys
will lamp when a call is parked in that particular orbit. To manually configure, log
into the phone and set the key to:

BLF Type: BLF
Label: Meaningful Descriptor
Value: The extension or park orbit number to monitor
Line: 1
Dials the digits entered as for the Value and sends them to the PBX. To manually
configure, log into the phone and set the key to:
Type: Speed dial

Speed Dial
peed Dia Label: Meaningful Descriptor

Value: Any number or feature code that the PBX can recognize

Takes the connected call and parks it in an available orbit from 701-720, starting at
the lowest available slot. When parking, the PBX will tell you audibly which orbit the
call was sent to. To manually configure, log into the phone and set the key to:

Park Type: Park
Label: Park

Value: ##700#

Places the phone itself in a state where it will not receive calls. This does not
communicate your state to the PBX (see Pause key). To configure manually, log
DND into the phone and set the key to:

Type: Do Not Disturb

This key starts the transfer process and allows you to enter a transfer destination.
Once entered, press Dial or wait for the digit timeout and the call will transfer. This
key is most useful if a phone has no open lines to perform a transfer using the fixed
key on the phone, as it does not open a new line to transfer. To configure manually,
log into the phone and set the key to:

Blind Transfer ,
Type: Prefix
Label: Blind Transfer

Value: ##
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Call Pickup

Voicemail

Voicemail
Gateway

Record

Fwd On

Fwd Off

Set Fwd

Allows the user to answer calls ringing direct to extensions that are in the Call Group
that matches the phones Pickup Group. To manually configure, log into the phone
and set the key to:

Type: Pickup
Label: Meaningful Descriptor
Value: 99

Allows the user to check their voicemail messages. User will be prompted for their
password(PIN). To manually configure, log into the phone and set the key to:

Type: Speed dial
Label: Voicemail
Value: 923

Allows the user to check any voicemail box for messages. User will be prompted for
mailbox number and password(PIN). To manually configure, log into the phone and
set the key to:

Type: Speed dial
Label: VM Gateway
Value: 924

Toggles on and off the record feature on the current active call. The file will be
saved in the voicemail box for the extension, under the Work folder. To manually
configure, log into the phone and set the key to:

Type: Speed dial
Label: Record
Value: *#

With a single press, a user can enable their unconditional forwarding. If no
destination is set, you will need to define one before forwarding can be enabled. To
manually configure, log into the phone and set the key to:

Type: Speed dial
Label: Fwd On
Value: *91

With a single press, a user can disable their unconditional forwarding. To manually
configure, log into the phone and set the key to:

Type: Speed dial
Label: Fwd Off
Value: *90

With a singe press, a used can define their forwarding destination. To manually
configure, log into the phone and set the key to:

Type: Speed dial
Label: Set Fwd
Value: *92
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This takes the user to a gateway that allows them to control forwarding for
extensions other than their own. User will be prompted for an extension number
and password (PIN) before they can make changes. Once logged in, you can
enable, disable, and set the forward destination. To manually configure, log into the
phone and set the key to:

F
wd Gateway Type: Speed dial

Label: Fwd Gateway
Value: *9
This key starts the intercom process and allows you to enter an extension or group
number. Once entered, press Dial or wait for the digit timeout, and the page will
happen. To manually configure, log into the phone and set the key to:

Intercom Type: Intercom
Label: Intercom
Similar to the DND key, except pressing this key communicates to the PBX, and will
pause you out of call queues. The key is a BLF and will lamp when the phone is
paused. To manually configure, log into the phone and set the key to:
Type: BLF

Pause Label: Pause

Value: ABC<extnum>
Line: 1

When pressed, a call is established to the PBX telling the user the state of
Day/Night mode override, and gives instructions on how to change the settings. If
Day/Night mode is forced into night mode, the light will blink; and if forced into day
mode, the light will be solid. If Day/Night mode is following the schedule the BLF will
not lamp. To manually configure, log into the phone and set the key to:

Day/Night BLF Type: BLF
Label: Day/Night
Value: ff
Line: 1

Allows BLF monitoring of an extension, as well as one press paging to that
extension. TO manually configure, log into the phone and set the key to:

Type: BLF
Page BLF Label: Meaningful Descriptor
Value: **<extnum>
Line: 1
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Appendix 2: IP Telephones

|IPitomy 550

The IPitomy IP550 SIP based telephone is designed for busy business
environments. The IP550 is the workhorse phone for any business with a wide
range of telecommunications requirements. Equally, at home on the desk of a
corporate executive or on a conference table, the IP550 fits just about any
business situation.

The IP550 is an advanced open standards business telephone. With features
that are based on the technology of the future, the IP550 also includes most of
the familiar functions available on traditional business telephone systems. The
combination of high technology and practical functionality results in a standards-
based telephone that is simple to use and won’t require a long learning curve.
The 20 soft keys, 6 programmable keys and 16 fixed feature keys, provide all of
the flexibility required for any business.

Because the IP550 is designed as a SIP based telephone, its robust capabilities
perform well in or out of the office. Remote users can enjoy the same great
features as though they were right in the office. The large graphical display
conveniently displays caller ID information. Missed calls, dialed calls and
received calls are stored and can be viewed, dialed or stored in the on board
phone book. The full duplex speakerphone provides world class speaker phone
quality. The attractive appearance and sturdy stand provide a professional look
and feel. The IP550 enhances the performance of the IPitomy IP PBX systems
and is far more integrated that other open standards SIP based endpoints.

IPitomy 55i

The 55i from IPitomy offers powerful features and flexibility in a standards based
carrier-grade advanced level expandable IP telephone. With a sleek and elegant
design, 144 x 75 pixel backlit LCD display and 6 dynamic context-sensitive
softkeys, the 55i is fully interoperable with leading IP Telephony platforms,
offering advanced XML capability to access custom applications and support for
up to 9 calls simultaneously. Part of the IPitomy family of IP telephones, the 55i
is ideally suited for moderate to heavy telephone users who require more one
touch feature keys and XML based programs.

IPitomy 53i

The 53i from IPitomy offers powerful features and flexibility in a standards based
carrier-grade basic level IP telephone. With a sleek and elegant design and 3
line LCD displays, the 53i is fully interoperable with leading IP Telephony
platforms, offering advanced XML capability to access custom applications and
support for up to 9 calls simultaneously. Part of the IPitomy family of IP
telephones, the 53i is ideally suited for light to regular telephone requirements.
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IPitomy 53i IP Phone

The 53i IP phone offers powerful features and flexibility in a standards based,

carrier-grade basic level IP telephone. The 53i has a sleek and elegant design

and 3 line LCD display, the 53i is fully interoperable with leading IP Telephony

platforms, offering advanced XML capability to access custom applications and
support for up to 9 calls simultaneously.

|IPitomy 57i

The 57i CT from IPitomy offers powerful features and flexibility in a standards
based, carrier-grade advanced level, expandable, IP telephone that includes an
integrated WDCT cordless mobility handset for coverage up to 300,000 sq ft.*
With a sleek and elegant design, large 144 x 128 pixel graphical backlit LCD
display and 6 dynamic context-sensitive softkeys, the 57i CT base unit is fully
interoperable with leading IP Telephony platforms, offering advanced XML
capability to access custom applications and support for up to 9 calls
simultaneously. Part of the IPitomy family of IP telephones, the 57i CT is ideally
suited for executives, heavy telephone users who require more one touch
feature keys and a large screen to take full advantage of XML based programs
and mobile warehouse, support and retail staff.

6739i

The new 6739i, a new member of 67xi SIP portfolio, brings leading edge
communications technology to the desktop in a stylish design. This phone
features a giant touch screen display, Bluetooth, 1 GB Ethernet and enhanced
audio components which make G.711 sound almost as good as Hi-Q our G.722
codec. This product is available in December 2009.

IP120

The IP120 is a value priced SIP based IP Telephone/Speakerphone. It has two
Ethernet ports, supports Power over Ethernet and has a two line display. The
IP120 supports two calls and has 5 programmable buttons. The IP120 is
designed for applications where a low cost instrument is required such as
kitchen, breakroom, warehouse, exam room or anywhere that does not require a
large screen or more lines. The IP120 uses IPitomy's advanced Auto
Provisioning features for easy deployment.
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IP51i

The 55i from IPitomy offers powerful features and flexibility in a standards based,
carrier-grade advanced level expandable IP telephone. With a sleek and elegant
design, 144 x 75 pixel backlit LCD display and 6 dynamic context-sensitive
softkeys, the 55i is fully interoperable with leading IP Telephony platforms,
offering advanced XML capability to access custom applications and support for
up to 9 calls simultaneously. Part of the IPitomy family of IP telephones, the 55i
is ideally suited for moderate to heavy telephone users who require more one
touch feature keys and XML based programs.

IPitomy 536M

The 536M expansion module is designed to increase the power and flexibility of
the 5i Series SIP telephones. Up to three modules can be used with the 55i, 57i
or 57i CT telephone to create a powerful, feature rich console option. The 536M
shares power and signaling with the phone, eliminating the need for additional
wiring. Designed for receptionists, administrative assistants call center agents,
power users, and executives who need to monitor and manage a large volume of
calls on a regular basis, the 5i Series Expansion Modules provide an intelligent
choice for all Enterprise IP environments.

IPitomy 560M

The 560M expansion module is designed to increase the power and flexibility of
the 5i Series SIP telephones. Up to three modules can be used with the 57i or
57i CT telephone to create a powerful, feature rich console option. The 560M
shares power and signaling with the phone, eliminating the need for additional
wiring. Designed for receptionists, administrative assistants call center agents,
power users, and executives who need to monitor and manage a large volume of
calls on a regular basis, the 5i Series Expansion Modules provide an intelligent
choice for all Enterprise IP environments.

Detailed information regarding these phones including technical specifications can be found at www.aastra.com.
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APPENDIX 3: SOFTPHONES

CounterPath™ eyeBeam® 1.5 and X-Lite® 3.0

What is a Softphone?

CounterPath’s eyeBeam® 1.5 and X-Lite® 3.0 are Web-based telephones that operate from a PC. These next-
generation Voice Over IP (VolP) telephony client’s are designed to enhance a user’'s communication experience
by keeping them connected to callers anyplace and anytime through the convenience of an intuitive and user-
friendly desktop.

Based on open standards, CounterPath™ Softphones use a telephone-centric interface that allows users to
manage voice, video, instant messaging (IM) and presence applications on their desktop. This comprehensive
suite of carrier-grade solutions, give users the flexibility to meet the fast-paced and changing demands of any
business.

X-Lite® 3.0 Free Softphone

¢ Intuitive user interface makes it easy for both novice and power users to make and receive
calls, initiate video conferencing, and communicate using Instant Messaging.

e Comprehensive Personal Address Book, including detailed calls lists and history.

e Microsoft Outlook® integration allowing users to import their address book into their
eyeBeam® contact list.

e Zero-Touch Configuration of audio or video devices.

¢ Instant messaging (IM) and presence management.

e Multi-party and ad-hoc voice and video conferencing (IP and PSTN).
¢ Voice and video call recording.

e Pop-up management of incoming calls.

eyeBeam® 1.5 (Pricing available at www.counterpath.com)

¢ Intuitive user interface that makes it easy for both novice and power users to make and
receive calls, initiate video conferencing, and communicate using Instant Messaging.

e Comprehensive Personal Address Book, including detailed calls lists and history.

¢ Microsoft® Outlook® integration allowing users to import an address book into the
eyeBeam® contact list and dial directly from the application.

e Zero-Touch Configuration of audio or video devices.

¢ Instant messaging (IM) and presence management.

e Multi-party and ad-hoc voice and video conferencing (IP and PSTN).

¢ Voice and video call recording.

e Pop-up management of incoming calls.

e  Security offering signaling and media encryption via TLS and SRTP streams.
o Performance management of the SIP end-point (Softphone).

e High compression CODEC support.
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Softphone Installation

D sTEPS:

1 Using the Internet Explorer, go to the CounterPath website at the
WWW. nterpath.com.

2 Download the CounterPath™ Softphone to be used with the system. The installation
utility will install a phone icon in the toolbar of the operating system. It looks like a green
light.

3 Left click the Softphone Icon in the operating system toolbar. The Softphone will
appear.

4 Right click on the Softphone and select SIP Account Settings from the drop-down
menu.

Click Properties. The properties window for the Softphone will appear.

Enter a Display Name. This is the name of the person or department associated with the
phone.

7 Create a User Name. This is the extension the phone will be off of the IPitomy IP PBX.
Be sure to use a number that is not being used by an existing extension.

8 Enter a Password. This password will need to be the same as the one used in the
IPitomy IP PBX Extension Setup (Add New) page.

9 Enter the Extension Number in the Authorization User Name field.
10 Enter the Domain (IP Address) of the system to which the Softphone is to be connected.
11 Click Apply then select OK. Softphone Account Settings page will close.

12 Log into the IPitomy IP PBX (if not already logged in). Click Destinations and
Extensions in the navigation bar of the system’s administration menu. The Extensions
page will appear.

13 Click Add New. The Edit Extensions page will appear. Note that each new extension
added automatically has a voice mailbox created.

14 Insert the Name or department associated with the extension being created.
15 Create an Extension Number for this person or department.

16 Populate the Email address for the person or extension. This will allow the system to
forward email messages to the address of the person at the extension.

17 Select a status from the drop-down menu. An extension can be:
e Active — Currently in use.

o Disabled — Not currently in use.

18 Create a voicemail PIN for the extension. PIN numbers must be between 3 and 4
characters long. The default setting is for the PIN to be the extension number. Be sure to
instruct users to change the PIN to avoid unauthorized use.

19 Enter a Ring Time. This is the time in seconds that a call will ring before it is considered
unanswered. Ring time must be between 1 and 360 seconds in length.

20 Define a Call Limit. This is the number of concurrent calls allowable at an extension.
The Call Limit selected must be between 0 and 9. This limit will depend on the phone
being installed.
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21 Create a Call Group number. This number assigns this extension to a group with a
similar purpose (e.g., Sales or Customer Service). Multiple call groups can be assigned
to each extension by putting a comma between the group numbers. The call groups also
define which Pickup Groups can answer calls to this extension.

22 Create a Pickup Group. This number must match the Call Group number(s). It defines
the Call Group Numbers this extension can pickup remotely by pressing *8.

23 Click Apply Schedule. When an extension is created, a schedule destination is created.
This schedule is not activated until the Apply Schedule box is selected. When it is
selected, you can setup a schedule for this extension by selecting Schedule under the
Destinations Menu and clicking on the schedule for that extension. Extension schedules
will appear with the name of the extension (e.g., Extension 123 would appear as
“ext_123"). See the Schedules section of this guide for more information.

Forward Settings

The forwarding settings are made to be very user friendly. The settings may be modified from the Smart Personal
Console, changed from your telephone extension or changed remotely from any telephone (including cell phones)
using the touch-tone key pad of any telephone.

Forward settings routes calls to a different destination. These settings can be:
¢ Unconditional — Always route calls to a specific destination.

o Busy — Route calls to a specific destination when the extension is in use or do not disturb is
selected.

o No Answer — Route calls to a specific destination when a call is not answered.

e Unavailable — Route calls to a specific destination when a phone is turned off, is not
registered with the system or has reached its call limit (as set In the IP PBX).

Provisioning Forward Settings

P STEPS:
1 Pick the setting to be provisioned — Unconditional, Busy, No Answer or Unavailable.

2 Select Enabled or Disabled. Disabled turns the forward setting off. Enabled turns the
forward setting on.

3 If the Forward setting is Enabled, you can choose to select a destination from the drop-
down list. The IPitomy IP PBX allows calls to be forwarded to a PSTN. Forward calls to a
PSTN number by entering it into the field provided. Calls can be forwarded to any
destination (or telephone number) in the drop-down list or any telephone number.

Changing a Forwarding Number from an Extension
Only unconditional forwarding can be changed from a touch-tone keypad.

o Dial *90 to disable forwarding.
e Dial *91 to enable forwarding.

e Dial *92 to set the forwarding number.
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Changing a Forwarding Number from a PC

>STEPS:
1 Browse to the Smart Personal Console page.
2 Login.
3 Select a Destination for the chosen forward type.
4

Enter the telephone number.

Changing a Forwarding Number While Away from an Extension
Only unconditional forwarding can be changed from a touch-tone keypad.

When it is necessary to modify the forwarding setting while away from the office, the IPitomy IP PBX has a
forwarding application built into the system. It is necessary to have an automated attendant menu accessible from
outside the system. The forwarding gateway is selectable as an option from the Smart Personal Console. When
away from the office, it is possible to call into the Automated Attendant, enter the digit setup to be the forwarding
gateway. Here users can turn forwarding on or off and enter a different number to forward calls to.

P STEPS:
1 Callinto the Automated Attendant menu.
Select the touch-tone digit that has been set for modifying forwarding settings.
The system will prompt for an Extension Number and Password.
The system will indicate if extension forwarding is Enabled or Disabled.

Pressing “1” toggles between Enabled and Disabled.

o g A~ WO DN

Pressing “2” allows the forwarding destination to be modified.

Advanced Settings

Network Settings

When installing a Softphone change the SIP Password in Network Settings to match the password created in the
Softphone Account Settings. The rest of these settings represent service provider permissions and identification
information. These other system (extension) defaults should not be changed.
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APPENDIX 4: IP ADDRESSES

Determining Local Network Address (on a Microsoft® Windows® Machine)

To determine the local network address on a Microsoft® Windows® machine:

D SsTEPS:

1 Go to Start and click on Run. Type “cmd” and press Enter.

2 Atthe Command Prompt type “ipconfig /all” and press Enter. Windows will display the
current connection details (Diagram 63). These connection details contain important
information used in the setup of the IPitomy IP PBX.

3 Write the following information in the IPitomy IP PBX Installation Checklist:

e |P Address
e Subnet Mask
o Default Gateway

Determining an Available IP Address

Adding the IPitomy IP PBX to an existing Local Area Network (LAN) requires knowing what IP address can be
given to the system. Every new piece of equipment added to the network must have its own IP address. Pinging
an IP address determines if an IP address is available to be used. A ping is a call to the IP address to see if it
exists. If a ping gets a response then the IP address is in use.

To ping an IP address on a Windows®-based machine already configured on the local network:

P STEPS:
1 Go to Start and click on Run. Type “cmd” and press Enter.

2 Atthe Command Prompt type “ping *[192.168.1.249]" and press Enter. This IP
Address is the IPitomy IP PBX default static IP Address. The IP Addresses you ping on
your local network will be defined by your router. For example, even though the default IP
Address for the IPitomy IP PBX is 192.168.1.249, the IP Addresses that you ping to
determine if one is available may differ. This will be determined by your gateway (router)
address.

3 If you receive a “Destination net unreachable” message like in the number
*[192.168.1.249] is an IP Address not in use and can be assigned to the IPitomy IP
PBX.

NOTE: Sample configurations are for a Windows XP © operating system and Linksys® router and are for
demonstration purposes only. This IP Address is determined by the default gateway (router) you
discovered in Determining the Local Network Address.

4 If you get a return or “Reply from *192.168.1.249”, the IP Address is in use. Continue
pinging IP addresses on “*[192.168.1.XXX]” that are greater than “*[192.168.1.249]” until
you find a “Destination net unreachable.” Make a record of this IP address in the IPitomy
IP PBX Installation Checklist to use later in the installation.
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APPENDIX 5: DHCP SETTINGS

Internet Protocol (IP) addresses are used to facilitate communication between equipment within a network. Each
piece of equipment on a network has a unique IP address. These addresses are maintained in a list on a server
(a computer that manages information traffic throughout a network). The list has both static (non-changing) and
dynamic (varying) IP addresses. Those that are static do not change and can be used by Web servers that
require a permanent connection to the Internet. Those that are dynamic are assigned as needed to allow
communication between equipment or servers on the network. Dynamic Host Configuration Protocol (DHCP) lets
Network Administrators manage an organization’s network centrally and automate the assignment of IP
addresses using the internet protocol TCP/IP. DHCP supports the management of IP addresses and internet
traffic by:

Automatically assigning an IP address to a computer if it moves to another location on the network. If DHCP didn't
exist the new IP address would have to be manually configured.

Allowing a Network Administrator to supervise and distribute IP addresses from a central point— automatically
sending a new IP address when a computer is plugged into a different place in the network.

Leasing Time for an IP Address

DHCP uses the concept of a “lease” or an amount of time that a given IP address will be valid for a computer. The
lease time can vary depending on how long a user is likely to require the Internet connection at a particular
location. DHCP is especially useful in education and other environments where network users change frequently.
In these settings, by using very short leases, DHCP can dynamically reconfigure networks in which there are
more computers than there are available IP addresses.

Determining/Viewing DHCP Settings on a Linksys® Router

P STEPS:
1 Log into the router using the router’s IP address (e.g., 192.168.1.1).
2 Enter a Username and Password at the Login page.
3 Click the Advanced Tab and DHCP.

Tips for Understanding the IP Address List
Listed below are some tips that explain the DHCP Settings:

e The starting IP address determines the first IP that will be auto assigned by the router (e.g.,
192.168.1.100).

e The number of DHCP users determines the amount of auto assigned IP addresses that can
be generated (e.g., 50).

e In a scenario with 50 users, "192.168.1.49" would be the last auto assigned IP address in the
pool.

e To setan IP address outside the DHCP pool, statically assign the system to a number
beyond the pool (e.g., 192.168.1.249).
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APPENDIX 6: ROUTER CONFIGURATION

The sample setup instructions below use a Linksys® router and are meant for demonstration purposes only.

D sTEPS:

1 Log into the router using the router’s IP address (e.g., 192.168.1.1).

2 Open a Web browser. Enter the IP address of the router (e.g., 192.168.1.1) and press
Enter.

3 Login to the router using the Username and Password. For help refer to router
documentation.

4 Navigate to Port Forwarding. For help refer to router documentation. Open ports 5060 to
5060 on the IP address for the system being installed (e.g., 192.168.1.249) for both UDP
and TCP (Name = SIP).

5 Open ports 10000 to 20000 on the IP address for the system being installed for both UDP
and TCP (Name = RTP).

6 Open ports 4569 to 4569 on the IP address for the system being installed for both UDP
and TCP (Name = IAX2).

7 Click Apply Changes to commit the changes to the database.

APPENDIX 7: NETWORK CONSOLE

The system comes with an application that allows the IP Address and other network attributes to be changed to
meet the requirements of the specific network. Using the Network Console allows you to view and change
settings without requiring an external web browser.

Accessing the Network Console
P STEPS:

1 Verify that the IP1500 is powered and that a keyboard and monitor are connected
directly to it.

2 If the monitor screen is blank go to step 4. However, if you see the Network Console,
go to step 5.

3 If you just powered up the IP1500, you will see various system housekeeping
messages scrolling on the screen. Do not press any keys at this time. Soon the
messages will stop moving and be replaced with a “login as” prompt.

Press CTRL + ALT + F7, simultaneously. If nothing happens, go to step 1.

View or make changes as needed.

Selecting Options

Options are single letters or digits within brackets. You select an option by typing the option letter/digit and then
pressing the Enter key. For example, on the Main menu, [1] indicates you can select the Network Type by typing
1 and pressing Enter. A blank option [ ] indicates that you cannot edit the value in the current context.
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Menus
e Each menu screen contains 4 sections:

e Menu Location.
e “Using” (Live) System Settings.
o Database Settings.

¢ Commands.

Menu Location

The location “bar” tells you where in the configuration system you are. For example, the Main Menu is
“IPitomy Networking — TCP/IP Settings”. Another menu is “IPitomy Networking — TCP/IP Settings —
Subnet Mask”

Using the “Live” System Settings
This section always contains the current network system information.

Database Settings

Most values in this section are IP Addresses. The values can be edited. To edit a value you first select the
corresponding option. Options here are always numbered. Edits do not modify actual network settings until you
“Save & Update”.

Command Options

To issue a command select the desired option. Which options are available vary depending on where you are
within the menu system. Some important options are:

Refresh View [R]
e When to use:

¢ Undo edits you do not wish to save.
e See the latest live network information.

e See if the database has been modified by someone else.

Default Settings [D]

Changes the values listed in the menu to factory defaults. Remember, you must save your changes to actually
update your network interface.

Save & Update [S]
Save settings and update network connections.

Disable [Z]
IP address values can be disabled with this option.
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Network Type

DHCP

DHCP may be used to simplify networking administrative tasks such as initial system configuration. With Network
Type set to DHCP, several IP Address options become unavailable. For more information about DHCP and
IP1500 networking requirements, refer to the appropriate section of this manual.

Acquiring a DHCP Lease

P STEPS:
1 Change Network Type to “DHCP”.
2 Save & Update.

Renewing DHCP Lease

P STEPS:
1 Verify Network Type is set to “DHCP”.
2 Save & Update.

Other Menus
o [W]Web Server

e [H] Host Access
e [F] Fix Database

Web Server

This menu allows you to restart the Web Server, and modify which IPs and/or domains can access the web
server. To apply changes you must restart the web server. This will not interrupt phone service. A reboot of the
PBX will also apply changes made here. The “Allow” format may be: domain name, full IP address, partial IP
address, network/netmask pair, network/nnn CIDR specification.

Changes to the Web Server access list are database independent so custom changes do not migrate from one
box to another via a database backup file.

Host Access
Limit access to special services on the PBX.

An “allow from” entry is a list of one or more host names, host addresses, patterns or wildcards that will be
matched against the client host name or address. List elements should be separated by blanks and/or commas.

Changes to the Host access list are installed immediately. They are database independent so custom changes do
not migrate from one box to another via a database backup file.

*Changes made to Web Server and Host Access settings are installed immediately. You must restart the Web
Server ([U] option, or the PBX) before Web Server access changes are used by the Web Server. The Web Server
and Host Access console menus provide all of the functionality of the System > Access Control web page.
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Fix Database

From here you can factory default your database. This will permanently change your system. Be sure this is really
what you want to do before proceeding.

Tips for Using the IPitomy IP PBX Network Console

Always read the text near the cursor before pressing keys. Otherwise you could miss an important warning
message.

If the IP1500 console has been left unattended with the Network Console Menu present on the monitor screen,
and you believe someone else may have modified network settings remotely since the last time the console was
used, be sure to select Refresh Database View before making changes or using Save & Update. This ensures
that you do not accidentally revert settings to an undesired prior state and that you are not relying on out of date
information.

While unlikely, it is possible for the actual database settings to be out of sync with the “Using” (live) network
settings. If you want to switch the actual settings to the database values, simply select Save & Update. If you want
to re-configure the network, edit the settings first. Then Save & Update.
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APPENDIX 8: SOFTWARE UPGRADE

Checking for Upgrade Availability

1. Log into the PBX

zer Mame: (pbeadrmin Lizer Mamea
Fassword, sssssns Paszsword:
Login Login
Coprgriatt & 2008 Piomy Communications, LLC. AN rights réservad, ELILL & Warranty Infoemation

2. Navigate to PBX Setup=>Services and note the firmware version. If the PBX firmware is earlier than 3.x-
xxxx then your system requires a Hard Drive upgrade before you will be able to load any 3.x firmware
onto the system. Please contact your IPitomy Sales Representative if an HD upgrade is needed;
otherwise continue with the steps laid out in this guide.

System Information

System Software Version: 3.0-1943

System Backup

1. Go to PBX Setup=>Database
2. Click Backup to create a backup of the current database
3. Find the most recent backup and click the Down action arrow to download this database to your computer

Downloading the Firmware File

1. In a web browser, navigate to http://www.ipitomy.com/pbx_files/ip1500/

2. Download the Current Release
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Loading the Firmware File

1.

Log into the PBX and navigate to PBX Setup=>Services

System Functions

Restart PBX Daemon Restart PBX

Reboot the PBX Reboot PBX

Restart All Services Restart Services
Restan Calllanager Daemon Restart CallManage:
File System

Load system update file; lﬂ_éinﬁe__l Load File

Scroll down to the File System panel
Click Browse and find the current firmware file ipitomy_pbx_<build#>-uf.tgz
Click Load File to begin the upgrade process

Depending on your starting firmware version, one of two things will occur:
1. A dialog box will pop up announcing that the PBX will reboot, click OK and wait 5 minutes. After
the 5 minutes has passed, log out of the PBX, then log back into the PBX (you should see a
message when logging in that the Database does not match and will be converted)
2. A progress bar will appear while the PBX upgrades and reboots, after which you will be returned
to the login screen.
Log into the PBX and a message will display stating the Database version does not match. Click OK and
the DB will update.
Click Apply Changes

Restoring Backups (Does not need to be done if you want to use the same DB as was previously
running on the system)

1.

Navigate to PBX Setup=>Database

Find the backup you wish to load and click the curved arrow to restore it as the active database.
Once the Database loads, Click Apply Changes.

Navigate to PBXSetup->Services and Click "Restart All Services"

For systems with Digium© Analog Cards/T1/PRI Cards or Xorcom© USB Devices

1.

If your system has any of these products installed, navigate to Providers=>Hardware Providers
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2. Scroll down to the Hardware Functions panel

3. Click Restart USB Devices & PBX Services

APPENDIX 9: TROUBLESHOOTING (FAQ)

(Q) Why does my Aastra phone freeze with 100% done written on the screen?
(A) The phone is attempting to access an unreachable network. You need to manually change the TFTP server
IP on the phone to match the PBX IP. Also make sure that PBX Network Settings IP matches your actual PBX
IP. If it does not, change it and SAVE the change. Make sure that the PBX Sip IP has been properly set:
P STEPS:
1 Change the setting in PBX Setup / SIP.
2 Click on “Apply Changes” button to commit the changes to the database
3 Restart the phone.

(Q) Why did my phone restart with an old configuration after using Auto Discovery to create a new
extension, assign and restart the phone?

(A) When you create a new extension you are taken to the Create Extensions page. After you click on the
"Create" button you must then click on "Apply Changes" before restarting the affected phones.

(Q) Why does my Aastra phone hang (or freeze) with "40% Done" written on the screen?

(A) This is a known issue with the Aastra 480i model that sometimes occurs after Factory Defaulting the phone.
You need to turn the phone off and turn it back on. Remove the power connection, wait a few seconds and
then re-connect the power.

(Q) Why won’t my time zone on my voicemail change after my system settings have been changed?

(A) You have to go to PBX>Services and click on the Restart PBX button in order for the changes to take effect.

(Q) Why can’t | delete a menu?

(A) Be sure the menu is not being used in incoming routing.

(Q) What is the default IP Address for the IP PBX?
(A) The IP Address for the PBX is 192.168.1.249

For the most recent troubleshooting FAQ’s please visit www.ipitomy.com
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GLOSSARY

The following terminologies relate to either standard Internet Protocol (IP) and/or IPitomy’s suite of products.

A

Znalogue Telephone Adapter (ATA) — Connects a telephone to a high-speed modem and facilitates VolP or
fax calls over the internet.

Automatic Call Distribution (ACD) - The IPitomy’s ACD product is an IP-based component that allows
management of calls and features Virtual Call Centers, Skills-based Routing, Multiple Queue Assignments and
Overflow/Load Balancing.

B

Backbone - Global network connections that route voice and data traffic from one major metropolitan area to
another.

Bandwidth — The transmission capacity of a given device or network.
Broadband — An internet connection that is always-on and fast.

Browser — A software application that allows users to view and navigate to information on the Web. Microsoft®
Explorer® and Mozilla Firefox® are two common browsers.

Busy Lamp Field (BLF) -This is an LED on a phone that designates the status or another phone or feature in
the PBX.

C

Caller ID - Displays the name and telephone number of a person calling.

Call Detail Record (CDR) — Information about calls collected from the IPitomy IP PBX for a specified period of
time. This report is downloadable. The report details the numbers of calls, call duration, call origination and call
destination.

Class of Service (CoS) — Class of Service defines which outbound routes a particular extension or feature has
access to for outbound dialing.

Cloud Computing - refers to applications and services offered over the Internet. These services are offered
from data centers all over the world, which collectively are referred to as the "cloud." This metaphor represents
the intangible, yet universal nature of the Internet.

CODEC (Compression-Decompression) — Defines the algorithm used to compress and decompress audio,
video, etc. The IPitomy PBX has many codecs to choose from.

D

Eigital Subscriber Line (DSL) — This service provides digital phone service over an analog line.

Direct Inward Dial (DID) — When a trunk has multiple lines, you can use a DID to route calls in the PBX to
specific destination.

Domain Name Server (DNS) — These are servers on the public internet which resolve the domain name into
an IP address. Without a valid DNS server, many of the services used by the PBX (Time, Email, etc) will
not be accessible if they use a domain name.

Do Not Disturb — Prevents notification of incoming calls.
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DTMF (Dual-tone Multi-frequency) — This is the touch-tone or audio signal a phone sends to a phone
system to get it to perform some action.

Dynamic IP- An |P address that changes and is not static.

Dynamic Host Configuration Protocol (DHCP) - This is a computer networking protocol used by hosts
(DHCP clients) to retrieve IP address assignments and other configuration information.

E

Encryption — The process of scrambling data to prevent the accurate interpretation of this data by anyone
except those for whom it is intended.

Ethernet - a family of frame-based computer networking technologies for local area networks (LANSs).

F

Firewall - A firewall is a part of a computer system or network that is designed to block unauthorized access
while permitting authorized communications. It is a device or set of devices which is configured to permit or deny
computer based application upon a set of rules and other criteria.

Forward — the action of automatically configuring a call that was intended for one party to go to another
destination.

G

Gateway — A device that interconnects networks with different, incompatible communications protocols.

H

Institute of Electrical and Electronics Engineers (IEEE) — An independent institute that develops
networking standards.

Infrastructure — Currently installed computing and networking equipment.
IP Telephony — Phone service (voice calls) carried over a network using Session Initiation Protocol.

Interactive Voice Response (IVR) - IVR is a telephony technology that can read a combination of touch tone
and voice input. It gives users the ability to access a database of information via phone. A typical IVR system has
several menus of prerecorded options that the caller can choose from. While many choices are as basic as
choosing a number, some options may require the caller to speak detailed information such as his name or
account number. This input is read by the IVR system and is used to access the appropriate information in the
database.



IPiTomy

IPitomy IP PBX Admin Guide SMARTER BUSINESS COMMUNICATIONS

Internet Protocol (IP) — A protocol used to send data over a network. These are currently set to IPv4 meaning
4 octets ranging from 0-255. The public internet takes up a majority of these addresses, but there are certain
ranges reserved for private LANs.

Reserved Private IP Address Ranges
Start End Number of Addresses
24-bit Block (/8 prefix, 1 x A) 10.0.0.0 10.255.255.255 16,777,216
20-bit Block (/12 prefix, 16 x B) 172.16.0.0 | 172.31.255.255 1,045,576
16-bit Block (/16 prefix, 256 x C) 192.168.0.0 | 192.168.255.255 65,536

Internet Service Provider (ISP) — A company that provides access to the Internet.

J

jitter - This is the deviation in or displacement of some aspect of the pulses in a high-frequency digital signal. As
the name suggests, jitter can be thought of as shaky pulses. The deviation can be in terms of amplitude, phase
timing, or the width of the signal pulse.

K

L

Local Area Network (LAN) — A group of computers and other devices that share a common communications
line. These devices most often share a server and are located within a small geographic area.

Loop Back - The term loopback is generally used to describe methods or procedures of routing electronic
signals, digital data streams, or other flows of items, from their originating facility quickly back to the same source
entity without intentional processing or modification. This is not something you want to do on a LAN.

MAC Address - A Media Access Control address (MAC address) is a unique identifier assigned to network
interfaces for communications on the physical network. http://en.wikipedia.org/wiki/MAC_address

Message Waiting Light — A light on a phone indicating that a voicemail message is waiting.

Music on Hold — Music or announcements callers listen to while on hold.

N

ﬁetwork — A group of computers or devices that share a common communication line and are typically used for
the transmission of data and voice traffic.

Network Address Translation (NAT) — Network address translation converts your LAN IP to the Public IP,
allowing traffic to go out to the internet and route back to the correct device on your LAN.

http://en.wikipedia.org/wiki/Network address_translation
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0)

ariginal Equipment Manufacturer (OEM) - This refers to a company that produces hardware to be
marketed under another company's brand name.

P

Packet — A unit of data transmitted over a network. This is a small amount of computer data sent over a network.
Any time you receive data from the Internet, it comes to your computer in the form of many little packets. Each
packet contains the address of its origin and destination, and information that connects it to the related packets
being sent.

Park — Parks a call in a reserved extension (park slot) and allows the call to be retrieved from another extension.

POE (Power over Ethernet) — A method of providing power to a network device over the network cabling,
eliminating the need for a power supply.

Port — Ports can describe two different devices.

An Internet port. This is a number that indicates what kind of protocol a server on the Internet is using.
For example, Web servers typically are listed on port 80. Web browsers use this port by default when accessing
Web pages

A hardware port. This refers to any one of the ports that are on the back of a computer where devices

can be hooked up (like a keyboard, mouse, printer, etc). Some common ports found on today's computers are
USB, Firewire, and Ethernet.

PRI (Primary Rate Interface) — ISDN service provides 23 64-Kbps B (Bearer) channels and one 64-Kbps D
(Data) channel (23 B and D). The D Channel is used for control in signaling information.

Private Branch Exchange (PBX) — An in-house telephone system that connects extensions and the Public
Switched Telephone Network.

Public Switched Telephone Network (PSTN) — This is the global circuit-switched telephone network. It is
similar to the Internet. However, on the Internet packets of data are sent and received using Internet protocol over
a network.

Q

auality of Service (QoS) - The ability to provide different priority to different applications, users, or data flows,
or to guarantee a certain level of performance to a data flow.

R

Redundant Array of Independent Disks (RAID) — This is a method of storing data on multiple hard disks.
When disks are arranged in a RAID configuration, the computer sees them all as one large disk. However, they
operate much more efficiently than a single hard drive. Since the data is spread out over multiple disks, the
reading and writing operations can take place on multiple disks at once. This can speed up hard drive access time
significantly. Multiple hard drives may not improve hard disk performance as much as multiple processors may
enhance the CPU performance, but it is based on a similar logic.

Real-Time Protocol (RTP) - a standardized packet format for delivering audio and video over IP networks.

Router — A networking device that connects multiple networks together, such as a local network and the Internet.

S

Server — Any computer in a network that provides users access to files, printing, communications, etc.

Server Time — this is the time set on the server where the phone or device is located. The server time for
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IPitomy’s IP PBX system is synched to time.nist.gov server time.

Session Initiation Protocol (SIP) — A signaling protocol that establishes data sessions. For example when
making a call from one extension to another on a VolP phone system SIP sets up the call and creates the
connection between the two extensions.

Smart Personal Console (SPC) — This user-friendly Web page gives a person the ability to set basic phone
features (mailbox settings, phone key settings, call forwarding, etc) from anywhere. Additionally, the user can
check their voicemail and call logs from the SPC.

Stateful Packet Inspection (SPI) — A stateful inspection is a firewall architecture that works at the network
layer. Unlike static packet filtering, which examines a packet based on the information in its header, a stateful
inspection tracks each connection traversing all interfaces of the firewall and makes sure they are valid.

Static IP — an IP address that does not change.

Subnet Mask — A subnet mask is a number that defines a range of IP Addresses that can be used in a network.
Subnet masks are used to designate subnetworks, or subnets, which are typically local networks LANs that are
connected to the Internet. Systems within the same subnet can communicate directly with each other, while
systems on different subnets must communicate through a router. Therefore, subnetworks can be used to
partition multiple networks and limit the traffic between them.

Switch — A network device that connects network segments. These come in POE and non-POE varieties.

T

?1 — A dedicated digital voice circuit that has 24 channels. This point-to-point circuit delivers 1.544 Mbps of
bandwidth.

TFTP (Trivial File Transfer Protocol) — a simple protocol to transfer files. IPitomy uses this method in
regards to phone firmware and configuration files. http://en.wikipedia.ora/wiki/Trivial File Transfer Protocol

Time to Live (TTL) — This refers to an aspect of the Internet Protocol. TTL is used when a "ping," or a request
for a response, is sent to another computer, such as a server. The TTL represents the number of hops, or servers
in different locations, the request can travel to before returning a failed attempt message.

Transfer — Sends a call to another extension.
Trunk — A communications channel between two points.

Transmission Control Protocol (TCP) — Packets sent via this method are verified end to end.

U

Upload - While downloading is receiving a file from another computer, uploading is the exact opposite. It is
sending a file from your computer to another system. It is possible to upload and download at the same time, but
it may cause slower transfer speeds, especially if you have a low bandwidth connection. Because most files are
located on Internet servers, people generally do a lot more downloading than uploading.

Uniform Resource Locator (URL) - A URL is the address of a specific Web site or file on the Internet. It
cannot have spaces or certain other characters and uses forward slashes to denote different directories. Some
examples of URLs are http://www.cnet.com/, http://web.mit.edu/, and ftp://info.apple.com/.

Uninterruptible Power Supply (UPS) — A devise that maintains continual electrical power.

User Datagram Protocol (UDP) - Packets sent via this method are fire and forget.

\'4

Virtual Private Network (VPN) — a computer network that uses a public telecommunication infrastructure,
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such as the Internet, to provide remote offices or individual users with secure access to their organization's
network.

Voice Over Internet Protocol (VolP) — The routing of voice traffic over the internet. VolP is basically a
telephone connection over the Internet. The data is sent digitally, using the Internet Protocol (IP) instead of analog
telephone lines.

w

Wide Area Network (WAN) — A computer network that crosses geographic boundaries like cities, states or
countries.

Wireless Local Area Network (WLAN) — A link between two or more computers in a network without wires.
Wireless LANs use radio waves to communicate between computers in a limited area.
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Notes:



